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Preface

Thank you for purchasing the WINCAPSII. It is designed for efficient program development and
verification of the DENSO robot on your PC connected to the robot controller (NetwoRC).

WINCAPSII also makes it possible to verify robot programs and data at a remote location via
telephone line.

On your PC, WINCAPSII allows you to simulate robot motions, variables, 1/Os or manage program
files in units of project, helping you easily develop and manage programs.

Before using WINCAPSII, read this manual carefully to safely get the maximum benefit from your
WINCAPSII system.

Version compatibility between WINCAPSII and robot controller system software

WINCAPSII is compatible with the same or earlier versions of the robot controller system
software.

For example, WINCAPSII version 2.2 is compatible with robot controller system software
versions 2.0, 2.1, and 2.2, but not compatible with version 2.3.

Notes (1) If your Robot Controller is newer than WINCAPSII in software version, updates
the WINCAPSII version using the DENSO Robot NetwoRC CD packaged
together with the robot set.

(2) WINCAPSII version is printed on the label of the WINCAPSII CD-ROM.

(3) Robot controller OS version is printed on the "SETPRM LIST" label affixed to
the top of the controller. It can also be checked on the Version screen called up
by pressing [F6 Set]—[F6 Maint.]—[F2 Version] from the top screen of the
teach pendant.

Important

To ensure operator safety, be sure to read the precautions and instructions in "SAFETY
PRECAUTIONS" pages 1 through 10.




Notice to user

Notice to user

DENSO WAVE INCORPORATED grants you a non-exclusive, non-transferable license to use
WINCAPSII ("Software").

1

. COPYRIGHT

(1) The Software is protected by copyright laws and international copyright treaties, as well as
other intellectual property laws and treaties.

(2) All title and copyrights in and to the Software, the accompanying printed materials, and any
copies of the Software are owned by DENSO WAVE INCORPORATED.

. GRANT OF LICENSE

(1) You may use one copy of the Software on a single computer at one time.

(2) You may either make one copy of the Software solely for backup or archival purposes, or install
the Software on a single computer provided you keep the original solely for backup or archival
purposes.

. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS

(1) You shall not rent, lease, sell, sublicense, assign, or otherwise transfer the Software.

(2) You shall not reverse engineer, decompile, disassemble, merge, modify or translate the
Software.

. LIMITED WARRANTY

(1) If the Software disk is defective or the accompanying documentation is defective (e.g.,
omissions), the entire and exclusive liability and remedy shall be limited to either the repair or
replacement of the Software. This warranty is limited to two month period following your receipt
of the Software.

(2) In no event shall DENSO WAVE INCORPORATED be liable for any consequential, incidental
or special damages, including any lost profits or lost savings, even if a DENSO WAVE
INCORPORATED representative has been advised of the possibility of such damages, or for
any claim by any third party.



Components of WINCAPSII

Components of WINCAPSII

The WINCAPSII package consists of the following.

Software

User's Manuals

WINCAPSII CD-ROM
(Product Version)

Note: There are three types of
WINCAPSII versions as listed

below.

WINCAPSII GUIDE (this book)

Note: The CD-ROM contains this
book in the PDF file format.

WINCAPSII License Certificate

DENSO
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WINCARST castom e
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WINCAPSII Versions

Versions

Features

Appearance

WINCAPSII Product

Version

This is optional WINCAPSII sold in a

single software package.

WINCAPS IT

‘ e Veri2.3-010 Rz

for Windows 95/98/7/1

WINCAPSII Light Version

This version comes with an optional

mini-pendant.

(1) This is WINCAPSII version
designed for the mini-pendant.

(2) The "continuous monitoring" and
"print" features are not available.

DENSO .
wiNeaps I ight
‘ 0V Ver 2.3-010 r2

WINCAPSII Trial Version

(NetwoRC CD)

This version comes with the robot set.
(1) Any program other than "PRO1"

cannot be edited.

(2) Entering a user ID upgrades the
trial version to the product version.

(3) This is used to upgrade existing

WINCAPSII versions.

DENSO Robot
NetwoRC CDVer 2.3




Updating WINCAPSII and Required operating environments

Updating WINCAPSII

To use the newer version of the robot controller system than that of the current WINCAPSII in your PC,
you need to update the WINCAPSII using the following procedure.

Updating procedure

(1) Uninstall the current WINCAPSII.
(2) Install newer version of WINCAPSII using the latest WINCAPSII CD-ROM.

NOTE: If your user ID has been entered before uninstallation, installing any of the WINCAPSII product
version, light version, and trial version updates the current WINCAPSII to the product version. If you
have two or more versions of CD-ROMSs, use the latest one.

Required operating environments

The following operating environments are required for running WINCAPSII smoothly.

Operating Environments for the PC Teaching System Software

CPU Pentium or higher capacity

(O] Windows 95 or upper version (See Note 1.)

Memory 32 MB or more (64 MB recommended)

Hard disk A free area of 80 MB or more is required at installation.
Monitor resolution 640 x 480 or higher

Note1  WINCAPS cannot run properly on earlier versions of Windows 95.

The version of Windows 95 can be checked with [Control Panel —
System - Information]. If A, B or C is not displayed (no symbol) at
the end of the version information (4.00, 95B), update your
Windows 95 with the Windows 95 Service Pack 1 that is available
from the Microsoft's web site.




Notes for the first use of WINCAPSII

Notes for the first use of WINCAPSII

1. Release restrictions on WINCAPSII functions

Without entry of User ID, WINCAPSII does not operate except “PRO1”, which is designed to operate

for the trial purpose. On activation of WINCAPS I, the license information screen appears. Enter User
ID printed in the license card.

2. Store the license card with care

The User ID printed in the license card is your purchased product number. The User ID is needed
when you receive after-sales service. Keep the license card with care.

Language restriction

The same language should be used in WINCAPSII and robot controller.

The use of different languages may cause the following problems because of the difference in
character code when WINCAPSII receives data from the robot controller or opens a project:

-“Programs” or “string variables” may become garbled. Also, editing or storing a garbled program or
string variable may corrupt data in some cases.

-The use of a project name or file name that contains non-alphanumeric characters may prevent
WINCAPSII from opening a project.



How the documentation set is organized

How the documentation set is organized

The documentation set consists of the following books. If you are unfamiliar with this robot and option(s),
please read all books and understand them fully before operating your robot and option(s).

GENERAL INFORMATION ABOUT ROBOT - this book -

Provides the packing list of the robot and outlines of the robot system, robot unit, and robot
controller.

INSTALLATION & MAINTENANCE GUIDE

Provides instructions for installing the robot components and customizing your robot, and
maintenance & inspection procedures.

STARTUP HANDBOOK

Introduces you to the DENSO robot system and guides you through connecting the robot unit
and controller with each other, running the robot with the teach pendant, and making and
verifying a program. This manual is a comprehensive guide to starting up your robot system.

SETTING-UP MANUAL

Describes how to set up or teach your robot with the teach pendant or mini-pendant.
For the panel designer functions, refer to the Panel Designer User's Manual (SUPPLEMENT).

WINCAPSII GUIDE - this book -

Provides instructions on how to use the teaching system WINCAPSII which runs on the PC
connected to the robot controller for developing and managing programs.

PROGRAMMER'S MANUAL I, Program Design and Commands

Describes the PAC programming language, program development, and command
specifications in PAC. This manual consists of two parts; Part 1 provides the basic programming
knowledge, and Part 2, details of individual commands.

PROGRAMMER'S MANUAL 11, PAC Library
Describes the program libraries that come with WINCAPSII as standard.

CONTROLLER MANUAL

Provides the specifications, installation and maintenance of the controller. It also describes
interfacing with external devices, system- and user-input/output signals, and I/O circuits.

ERROR CODE TABLES

List error codes that will appear on the teach pendant, mini-pendant, or PC screen if an error
occurs in the robot series or WINCAPSII. These tables provide detailed description and
recovery ways.

OPTIONS MANUAL

Describes the specifications, installation, and use of optional devices.

For the extension board "conveyer tracking board," refer to the OPTIONS MANUAL
(SUPPLEMENT).

vi



How this book is organized

How this book is organized

This book is just one part of the documentation set. It consists of SAFETY PRECAUTIONS, ten chapters,
appendices, and index

SAFETY PRECAUTIONS

Defines safety terms and related symbols and provides precautions to be observed. Be sure to read this
section before operating your robot.

Chapter 1 Outline of Personal Computer Teaching System

Describes the configuration of the personal computer teaching system and its features.

Chapter 2 Setting Personal Computer Teaching System

Describes how to make connections and setting of the personal computer teaching system.

Chapter 3 Starting Teaching System and Knowing Each Manager

Describes the procedures for starting and terminating the personal computer teaching system and
outlines the functions of each Manager.

Chapter 4 System Manager

Describes the functions and operation of the system manager that constitutes the nucleus of WINCAPSII
software to be used for the personal computer teaching system.

Chapter S Operating PAC Program Manager

Describes PAC Program Manager of WINCAPSII software functions.

Chapter 6 Operating Variable Manager

Describes Variable Manager of WINCAPSII software functions.

Chapter 7 Operating DIO Manager

Describes DIO Manager of WINCAPSII software functions.

Chapter 8 Operating Arm Manager

Describes Arm Manager of WINCAPSII software functions.

Chapter 9 Operating Vision Manager

Describes Vision Manager of WINCAPSII software functions.

Chapter 10 Operating Log Manager

Describes Log Manager of WINCAPSII software functions.

Vii






SAFETY PRECAUTIONS

SAFETY PRECAUTIONS

Be sure to observe all of the following safety precautions.

Strict observance of these warning and caution indications are a MUST for preventing accidents, which
could result in bodily injury and substantial property damage. Make sure you fully understand all
definitions of these terms and related symbols given below, before you proceed to the text itself.

A WARNING Alerts you to those conditions, which could result

in serious bodily injury or death if the instructions
are not followed correctly.

A CAUTION Alerts you to those conditions, which could result

in minor bodily injury or substantial property
damage if the instructions are not followed
correctly.

Terminology and Definitions

Maximum space: Refers to the space which can be swept by the moving parts of the robot as defined by
the manufacturer, plus the space which can be swept by the end-effector and the workpiece. (Quoted
from the ISO 10218-1:2006.)

Restricted space: Refers to the portion of the maximum space restricted by limiting devices (i.e.,
mechanical stops) that establish limits which will not be exceeded. (Quoted from the ISO 10218-1:2006.)

Motion space: Refers to the portion of the restricted space to which a robot is restricted by software
motion limits. The maximum distance that the robot, end-effector, and workpiece can travel after the
software motion limits are set defines the boundaries of the motion space of the robot. (The "motion
space" is DENSO WAVE-proprietary terminology.)

Operating space: Refers to the portion of the restricted space that is actually used while performing all
motions commanded by the task program. (Quoted from the ISO 10218-1:2006.)

Task program: Refers to a set of instructions for motion and auxiliary functions that define the specific
intended task of the robot system. (Quoted from the ISO 10218-1:2006.)



1. Introduction

2. Warning Labels

(Example: Location of labels)

This section provides safety precautions to be observed for the

robot system.

The installation shall be made by qualified personal and should
confirm to all national and local codes.

The robot unit and controller have warning labels. These labels
alert the user to the danger of the areas on which they are
pasted. Be sure to observe the instructions printed on those

labels.

Warning label

Instructions printed on the label

/AWARNING

Label (1)

Risk of injury.
Never enter the restricted space.

<Except HM>

AWARNING

T—LETER

Moving robot can cause serious injury.
Durch Roboterbewegungen konnen
Verletzungen verursacht werden!
2H(ARM) S5} Feo|
EENEET Part No. 410985-406%

<HM>

For UL-Listed robot units only

Risk of injury.

This label alerts the user that pressing
the brake release switch could drop the
arm.

A WARN I} NG
e
‘ Ly Z;sg;%\gis%\gis:mwsmw
Label (2)
Risk of electrical shock.
AWARNING
Rk of et hoct. Never open the controller cover when
0o o e it e i oo || tNE POWE IS O,
disconnecting cable.
Never touch the inside of the controller
Label (3) ) .
for at least 3 minutes even after turning
the power off and disconnecting the
power cable.
Risk of injury.
/AWARNING J ry
glxlskn:t’(‘\:‘mn power when someone s inside safety fence. Be Su re to perform IOCkOUUtagOUt
Lockout and tagout power before servicing. before Starting Servicing
Label (4)

Turning the power ON when a person is
inside the safety fence may move the
arm, causing injuries.




SAFETY PRECAUTIONS

3. Installation Precautions

3.1 Insuring the proper
installation environment

B For standard type and The standard and cleanroom type have not been designed to
cleanroom type withstand explosions, dust-proof, nor is it splash-proof.
Therefore, it should not be installed in any environment where:

(1) there are flammable gases or liquids,

(2) there are any shavings from metal processing or other
conductive material flying about,

(3) there are any acidic, alkaline or other corrosive material,
(4) thereis a mist,

(5) there are any large-sized inverters, high output/high
frequency transmitters, large contactors, welders, or other
sources of electrical noise.

® For dust- & splash-proof The dust- & splash-proof type has an IP54-equivalent structure,
type but it has not been designed to withstand explosions. (The
HM/HS-G-W and the wrist of the VM/VS-G-W are an

IP65-equivalent dust- and splash-proof structure.)

Note that the robot controller is not a dust- or splash-proof
structure. Therefore, when using the robot controller in an
environment exposed to mist, put it in an optional protective box.

The dust- & splash-proof type should not be installed in any
environment where:

(1) there are any flammable gases or liquids,
(2) there are any acidic, alkaline or other corrosive material,

(3) there are any large-sized inverters, high output/high
frequency transmitters, large contactors, welders, or other
sources of electrical noise,

(4) it may likely be submerged in fluid,

(5) there are any grinding or machining chips or shavings,

(6) any machining oil not specified in this manual is in use, or
Note: Yushiron Oil No. 4C (non-soluble) is specified.

(7) there is sulfuric cutting or grinding oil mist.

3.2 Service space The robot and peripheral equipment should be installed so that
sufficient service space is maintained for safe teaching,
maintenance, and inspection.



3.3 Control devices
outside the robot's
restricted space

3.4 Positioning of gauges

3.5 Protection of electrical
wiring and
hydraulic/pneumatic
piping

3.6 Grounding resistance

3.7 Positioning of
emergency stop
switches

3.8 Positioning of
operating status
indicators

The robot controller, teach pendant and mini-pendant should be
installed outside the robot's restricted space and in a place
where you can observe all of the robot's movements and operate
the robot easily.

Pressure gauges, oil pressure gauges and other gauges should
be installed in an easy-to-check location.

If there is any possibility of the electrical wiring or
hydraulic/pneumatic piping being damaged, protect them with a
cover or similar item.

The grounding resistance of the robot power supply should not
be more than 100Q2.

Emergency stop switches should be provided in a position where
they can be reached easily should it be necessary to stop the
robot immediately.

(1) The emergency stop switches should be red.

(2) Emergency stop switches should be designed so that they
will not be released after pressed, automatically or
mistakenly by any other person.

(3) Emergency stop switches should be separate from the
power switch.

Operating status indicators should be positioned in such a way
where workers can easily see whether the robot is on a
temporary halt or on an emergency or abnormal stop.

Note: The UL-Listed robot units have motor ON lamps on their
robot arms.



SAFETY PRECAUTIONS

3.9 Setting-up a safety
fence

3.10 Setting the robot's
motion space

A safety fence should be set up so that no one can easily enter
the robot's restricted space.

(1)

The fence should be constructed so that it cannot be easily
moved or removed.

The fence should be constructed so that it cannot be easily
damaged or deformed through external force.

Establish the exit/entrance to the fence. Construct the fence
so that no one can easily get past it by climbing over the
fence.

The fence should be constructed to ensure that it is not
possible for hands or any other parts of the body to get
through it.

Take any one of the following protections for the entrance/
exit of the fence:

1) Place a door, rope or chain across the entrance/exit of
the fence, and fit it with an interlock that ensures the
emergency stop device operates automatically if it is
opened or removed.

2) Post a warning notice at the entrance/exit of the fence
stating "In operation--Entry forbidden" or "Work in
progress--Do not operate" and ensure that workers
follow these instructions at all times.

When making a test run, before setting up the fence,
place an overseer in a position outside the robot’s
restricted space and one in which he/she can see all of
the robot's movements. The overseer should prevent
workers from entering the robot's restricted space and
be devoted solely to that task.

The area required for the robot to work is called the robot's
operating space.

If the robot’s motion space is greater than the operating space, it
is recommended that you set a smaller motion space to prevent
the robot from interfering or disrupting other equipment.

Refer to the INSTALLATION & MAINTENANCE GUIDE, Chapter

2.



3.11 No robot modification
allowed

3.12 Cleaning of tools

3.13 Lighting

3.14 Protection from objects
thrown by the
end-effector

3.15 Affixing the warning
label

Never modify the robot unit, robot controller, teach pendant or
other devices.

If your robot uses welding guns, paint spray nozzles, or other
end-effectors requiring cleaning, it is recommended that the
cleaning process be carried out automatically.

Sufficient illumination should be assured for safe robot
operation.

If there is any risk of workers being injured in the event that the
object being held by the end-effector is dropped or thrown by the
end-effector, consider the size, weight, temperature and
chemical nature of the object and take appropriate safeguards to
ensure safety.

Place the warning label packaged
with the robot on the exit/entrance

of the safety fence or in a position AWARN | NG

where it is easy to see. TROELF

[ REBERAICAS %,
Risk of injury.
Do not enter safety fence area.
Unfallgefahr!
Nicht den Sicherheitsbereich des|
Roboters betreten.
25| P27} AU,
O 25 X|of Lo S0I7bx| & 2,

AREER,
[P REHNZEBIPHEN




SAFETY PRECAUTIONS

4,

41

Precautions
while Robot is
Running

Creation of working
regulations and
assuring worker

adherence

A

Warning

Touching the robot while it is in
operation can lead to serious
injury. Please ensure the fol-
lowing conditions are
maintained and that the
cautions listed from Section
4.1 and onwards are followed
when any work is being
performed.

AAWARNING
A

Al

|
[ Part No. 410985-411%]
FROBASGY . WHHREHACASE,
Risk of njury. Do not enter restricted space.
Unfallgefahr! Nicht die Sperrzone betreten.
359 2207151, 7K A 9 ol S 2 A

ARIERR. FEENTHRHGEA .

1) Do not enter the robot's restricted space when the robot
is in operation or when the motor power is on.

2) As a precaution against malfunction, ensure that an
emergency stop device is activated to cut the power to
the robot motor upon entry into the robot's restricted
space.

3) Whenitis necessary to enter the robot's restricted space
to perform teaching or maintenance work while the robot
is running, ensure that the steps described in Section 4.3
"Ensuring safety of workers performing jobs within the
robot's restricted space" are taken.

When entering the robot’s restricted space to perform teaching

or

maintenance inspections, set "working regulations" for the

following items and ensure workers adhere to them.

(1)
(2)
)

(4)
®)

(6)

Operating procedures required to run the robot.
Robot speed when performing teaching.

Signaling methods to be used when more than one worker is
to perform work.

Steps that must be taken by the worker in the event of a
malfunction, according to the contents of the malfunction.

The necessary steps for checking release and safety of the
malfunction status, in order to restart the robot after robot
movement has been stopped due to activation of the
emergency stop device

Apart from the above, any steps below necessary to prevent
danger from unexpected robot movement or malfunction of
the robot.

1) Display of the control panel (See Section 4.2 on the next
page.)

2) Assuring the safety of workers performing jobs within the
robot's restricted space (See Section 4.3 on the next
page.)

3) Maintaining worker position and stance
Position and stance that enables the worker to confirm

normal robot operation and to take immediate refuge if a
malfunction occurs.




4.2 Display of operation
panel

4.3 Ensuring safety of
workers performing
jobs within the robot's
restricted space

4.4 Inspections before
commencing work
such as teaching

4) Implementation of measures for noise prevention
5) Signaling methods for workers of related equipment
6) Types of malfunctions and how to distinguish them

Please ensure "working regulations" are appropriate to the robot
type, the place of installation and to the content of the work.

Be sure to consult the opinions of related workers, engineers at
the equipment manufacturer and that of a labor safety consultant
when creating these "working regulations”.

To prevent anyone other than the worker from accessing the start
switch or the changeover switch by accident during operation,
display something to indicate it is in operation on the operation
panel or teach pendant. Take any other steps as appropriate,
such as locking the cover.

When performing jobs within the robot’s restricted space, take
any of the following steps to ensure that robot operation can be
stopped immediately upon a malfunction.

(1) Ensure an overseer is placed in a position outside the
robot’s restricted space and one in which he/she can see all
robot movements, and that he/she is devoted solely to that
task.

@ An emergency stop device should be activated
immediately upon a malfunction.

@ Do not permit anyone other than the worker engaged for
that job to enter the robot’s restricted space.

(2) Ensure a worker within the robot's restricted space carries
the portable emergency stop switch so he/she can press it
(the emergency button on the teach pendant) immediately if
it should be necessary to do so.

Before starting work such as teaching, inspect the following
items, carry out any repairs immediately upon detection of a
malfunction and perform any other necessary measures.

(1) Check for any damage to the sheath or cover of the external
wiring or to the external devices.

(2) Check that the robot is functioning normally or not (any
unusual noise or vibration during operation).

—
w
~

Check the functioning of the emergency stop device.

c

Check there is no leakage of air or oil from any pipes.

—
($)]
~

Check there are no obstructive objects in or near the robot’s
restricted space.



SAFETY PRECAUTIONS

4.5 Release of residual air Before disassembling or replacing pneumatic parts, first release
pressure any residual air pressure in the drive cylinder.

4.6 Precautions for test Whenever possible, have the worker stay outside of the robot's
runs restricted space when performing test runs.

4.7 Precautions for (1) Atstart-up
automatic operation Before the robot is to be started up, first check the following

items as well as setting the signals to be used and perform
signaling practice with all related workers.

1) Check that there is no one inside the robot’s restricted
space.

2) Check that the teach pendant and tools are in their
designated places.

3) Check that no lamps indicating a malfunction on the
robot or related equipment are lit.

(2) Check that the display lamp indicating automatic operation
is lit during automatic operation.

(3) Steps to be taken when a malfunction occurs

Should a malfunction occur with the robot or related
equipment and it is necessary to enter the robot's restricted
space to perform emergency maintenance, stop the robot’s
operation by activating the emergency stop device. Take any
necessary steps such as placing a display on the starter
switch to indicate work is in progress to prevent anyone from
accessing the robot.

4.8 Precautions in repairs (1) Do not perform repairs outside of the designated range.

(2) Under no circumstances should the interlock mechanism be
removed.

(3) When opening the robot controller's cover for battery
replacement or any other reasons, always turn the robot
controller power off and disconnect the power cable.

(4) Use only spare tools specified in this manual.



5. Daily and Periodical
Inspections

6. Management of
Floppy Disks

7. Safety Codes

(1) Be sure to perform daily and periodical inspections. Before
starting jobs, always check that there is no problem with the
robot and related equipment. If any problems are found,
take any necessary measures to correct them.

(2) When carrying out periodical inspections or any repairs,
maintain records and keep them for at least 3 years.

(1) Carefully handle and store the "Initial settings" floppy disks
packaged with the robot, which store special data
exclusively prepared for your robot.

(2) After finishing teaching or making any changes, always save
the programs and data onto floppy disks.

Making back-ups will help you recover if data stored in the
robot controller is lost due to the expired life of the back-up
battery.

(3) Write the names of each of the floppy disks used for storing
task programs to prevent incorrect disks from loading into
the robot controller.

(4) Store the floppy disks where they will not be exposed to dust,
humidity and magnetic field, which could corrupt the disks or
data stored on them.

The safety standards relating to robot systems are listed below.

As well as observing the safety precautions given in this manual,
ensure compliance with all local and national safety and
electrical codes for the installation and operation of the robot
system.

Standards

Title

ANSI/RIA R15.06-1999

Industrial Robots and Robot Systems--Safety Requirements

ANSI/UL1740: 1998

Safety for Robots and Robotic Equipment

CAN/CSA Z434-03

Industrial Robots and Robot Systems--General Safety Requirements

1ISO10218-1: 2006

Robots for industrial environments--Safety requirements--Part 1: Robot

NFPA 79: 2002

Electrical Standard for Industrial Machinery

8. Battery Recycling

DENSO Robot uses lithium batteries.

Discard batteries according to your local and national recycling
law.

EU

£
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Chapter 1 Outline of Personal Computer Teaching System

1.1 Features of Personal Computer Teaching
System

The personal computer teaching system is designed to make program
development and verification efficient by connecting a personal computer to the
robot controller.

It is possible to use this system to verify the robot program and/or data from a
remote point using the telephone line.

The WINCAPSII software, when installed on a personal computer, provides
advanced functions that include robot motion simulation, variables and I/O in the
software, and program file management of each project. These features are
most efficiently exercised in the development and/or control of programs.

Note: For information regarding the specifications of the necessary
personal computer and for an outline of the personal computer
teaching system software function, refer to “General Information
about WINCAPSII Personal Computer Teaching System Software”
in the OPTIONS MANUAL.

1.2 System Configuration

The following three methods are available for connecting the robot controller to
the personal computer:

(1) RS232C connection
(2) Ethernet connection
(3) Modem connection

Each of these connection methods is explained below.
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1.2.1 RS232C Connection

This connection method uses an RS232C standard serial communication port.

Figure 1-1 shows the position of the RS232C communication port on the robot
controller.

Use the cross cable that conforms to the specifications described in
“Communication Cable” of the OPTIONS MANUAL.

o
®|® ® ®
Ole

F o]
00 ~
Qlfos|[aBee
® 38 ogogo
® ®
o
®le
®
® @
Y

RS232C
Communication port

Fig. 1-1 RS232C Communication Port on Robot Controller
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Figure 1-2 shows the configuration of the personal computer teaching system

connected with RS232C.

Personal computer

RS232C cable

Power cable

Robot controller Between
the main body

Printer cable

T

® ° g
o WNr—

Printer

Teach pendant

CD—ROM

Fig. 1-2 Configuration of Personal Computer Teaching System Connected with RS232C




1.2.2 Ethernet Connection

This connection method uses an Ethernet communication network.

To effect this connection, ensure that the personal computer is compatible with
Ethernet and can be connected to the network.

The RC5 robot controller requires an optional Ethernet board to be mounted.

Ethernet

Fig. 1-3 Location of Ethernet Board

Figure 1-4 shows the configuration of a personal computer teaching system
connected with Ethernet. Determine the connection to the network by consulting
with the network administrator.

Notes: (1) For direct connection between the robot controller and a
computer via Ethernet, use a cross cable. For connection
using a hub, use a straight cable.

(2) Multiple personal computers may be connected to the
network, but they cannot establish communication with the
robot controller simultaneously.
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1. Example 1 - Cross cable

Ethernet cable
(Cross cable)

Personal
computer

Robot controller

Printer cable

Between
the main body

%h

Printer

Power cable

Example 2 - Straight cable

Personal Hub
computer -
Sholvir
Straight cable
communication Straight cable
N communication
Robot
controller
4

T

co0 B

oo & olo
R P ——
~7

Between
the main body

Power cable

Fig. 1-4 Configuration of Personal Computer Teaching System Connected with Ethernet
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1.2.3 Modem Connection

This subsection describes how to connect the robot with a remote personal
computer through the telephone by connecting a modem to the RS232C
communication port of the robot controller.

This connection method requires a serial communication port obtained by
connecting a modem to the personal computer.

Figure 1-5 shows the RS232C communication port of the robot controller to
which the modem is connected.

Refer to “Communication Cable” in the OPTIONS MANUAL regarding the
communication cable for connection with a modem. Select the cable that meets
the specifications of the modem to be used.

Modular wall

]

Power cable

Between

Robot controller the main body

RS232C

Fig. 1-5 Connection of the Robot Controller and Modem
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Figure 1-6 shows the configuration of the personal computer teaching system

connected with a modem.

Telephone

Network

Modular wall

Power cable

RS232C

RS232C

Modular wall

Personal

computer

Between

\ the main body

Fig. 1-6 Configuration of Personal Computer Teaching System Connected with a Modem
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1.3 Security

For data control security reasons, the personal computer teaching system
divides users into two levels to limit operation and information that can be can

accessed.
Higher order users are identified via password to allow access to higher

operation and information.

1.3.1 User Level

Table 1-1 indicates user levels.

Table 1-1 User Level

User level Description

Operator Not allowed to modify contents. No password is required.

May modify contents except system critical items. Password is
Programmer required for access. For initial access enter an optional
password. This will be automatically registered as the password.

Note: The range of accessible information varies with the user level. If
necessary information is not printed by printing operation, select
Re-Login from the Tools menu of the System Manager to change
the user level and proceed with printing again. For information
regarding Re-Login, refer to “4.3.3 Re-Log In”.
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. ________________________________________________________________________________________________________________|

1.3.2 Password

The user will be prompted to enter a password in the following cases:

e When starting WINCAPSII

e Immediately upon selecting Set in each Manager

o Immediately upon selecting Print in each Manager
Once correctly entered, the password will not be requested before the session is
over.

When a password is required, the Password window as shown in Fig. 1-7 will
appear. Select the user level from the popup menu and enter the password
correctly as required. Press OK to proceed.

When using the system for the first time, enter an optional password. It will be
automatically registered.

Note: A distinction is made between upper and lower case letters in the
password.

User]n - Operator =

Fassword;

Cancel

Fig. 1-7 Password

To change the user level during processing, select Re-Login from the Tools
menu of the System Manager, change the user level and enter the password
again.

ll:l |:||:E:

Set Communication

[Ehange Basawond
Re-Login

Bead FDi Image
Werite FOV Iriage

Fig. 1-8 Re-Login
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@ Pazsword

Password:

Ok Cancel |

Fig. 1-9 Password

Note: The user level is referred to when opening dialogue boxes.
To change the user level when the dialogue box has already been
opened by Set or Print command, close the dialogue box once, and
reopen it. The new user level will then be enabled.
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Chapter 2 Setting Personal Computer Teaching System

2.1 Installing WINCAPSII Software

Install the WINCAPSII software on the personal computer to use the personal
computer teaching system.

Note (1):

Note (2):

Note (3):

If the WINCAPSII software is already installed on the computer,
first uninstall the existing WINCAPSII software and then
reinstall it. For uninstall procedure, refer to “2.1.2 Uninstall”.
Always install or uninstall the software after quitting all the
applications currently running. Shared components in operation
cannot be installed or uninstalled. If a shared component that
WINCAPSII is to use is being used by another application, the
install/uninstall process may fail.

During installation of WINCAPSII, the message "Error has
occurred during file copying” may appear depending upon the
PC environments. This is because any other application is using
the file to which WINCAPSII is attempting to overwrite. Ignore
the message and continue installation.
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2.1.1 Installation Procedures
Install the WINCAPS Il according to the following procedure.

} STEP 1 I Terminate all the currently running applications.

Insert the WINCAPS Il CD-ROM in a CD-ROM drive of your personal

} STEP 2 computer.

Denso NetwoRC screen appears. Select “Install WINCAPS II” from the
menu.
If the screen does not appear, proceed to the STEP 3.

Note: f you install the WINCAPS Il from the floppy disks, proceed to
the STEP 3.

Click Start at Windows 95 and then click Run. Type the WINCAPS I

} STEP 3 installer name in the Open box and click OK.
WINCAFS /I Setup

#3 WINCAPS Il Setup

@ Welcome to the WINCAPS || installation program.
g

Setup cannot ingtall system filez or update shared fles if they are in uze.
Before procesding, we recommend that vou close any applications you may
be running.

Exit Setup

Drive E is for CD-ROM (Example)

Note: When loading software from floppy disks, insert DISK-1 into a
floppy disk drive and then select Setup.exe file.
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Click on OK in the WINCAPSII Setup window to start the WINCAPSII
} STEP 4 Setup program.

Installshield Wizard

Welcome to the InstallShield Wizard for
WINCAPS2 DENSO

* The InztallShield® \Wizard will instal WINCAPS2 DEMSO
an your computer. To continue, click Mest.

Cancel

} STEP 5 The directory where WINCAPSII will be installed is indicated at
Directory.

If OK, click on ?ﬂ button to start setup. Proceed to STEP 13.

To change the directory (not recommended), click on Change
Directory.

Installshield Wizard

Choose Destination Location

Select folder where Setup will install files.

'

&

Setup will instal WINCAPSZ DEMSO in the following folder.

Toinstall to thiz folder, click Mext. Toinstall to a different folder, click Browse and select
another folder.

Destination Folder

C:\Program Files\WIMCAPSZ DEMSON Browese. ..

< Back Cancel |
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» STEP 6

2-4

Enter a desired directory for installation. Click on OK to start
Installation.

Hereafter, proceed with your operation interactively according to the
messages displayed on the screen.

Choose Folder, [‘S_<|

Please choose the installation folder,
Path;:
| CriProgram Files\WINCAPS2 DENSO |

Directoties:

[ Outlook Express A
[ Techsmith
[ Uninstall Infarmatian
[C7) wehb Publish
I} THCAPS2 DENSO
[ Windows Media Player
[ Windows NT
[ WindowsUpdate
{7 wero

[ Ok l [ Cancel
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} STEP 7 Installation starts and the progress is indicated via a bar graph.

InstallShield Wizard X]

Setup Status

WINCAPSZ DEMS0D Setup iz performing the requested operations.

Installing:  Program Files. .

C:AProgram Files\WwWINCAPS 2 DEMSDAR obat TypeHC-4555--arm. mdb

— 2%

When installation is completed, the following message will appear on
} STEP 8 the screen. Click on OK.

InstallShield Wizard

InstallShield Wizard Complete

Setup has finshed installing WINCAPS2 DEMSO on your
campter.

} STEP 9 I \TV?E?KPvgi?gi;vesngrséady for use.
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2.1.2 Uninstall

Note: Always quit all the applications currently running before you install
or uninstall software. Shared components, if they are running,
cannot be installed or uninstalled. If a shared component that
WINCAPSII is to use is being used by another application, the

install/uninstall process may fail.

» STEP1 |
» STEP 2

2-6

Click on Start at Windows 95 and select and open Control Panel from

the Settings menu.

Double click on Add/Remove Programs in the Control Panel window.

=] E3

B9 Control Panel
File Edit “iew Help

|[_i7| Cantral Parel e S
Acceszsibiliby Aidd Mew EﬂddfﬂemoveE Date/Time Dizplay Find Fast

Options Hardwars | Progams

@ D 3 8 H B

K.epboard bail and Far  bicrosoft kdail b odermns blouze fuiltirnedia s

Fostatfice

n 2 @ = :

4| | b
|21 object(z) W




» STEP 3

Chapter 2 Setting Personal Computer Teaching System

The dialogue box for Add/Remove Programs Properties appears on
the screen. Click on Install/Uninstall tab and select WINCAPSII.

Add/ARemove Programs Properties [ 2] |

Install/Uninztall IWindnws SEtupl Startup Digk I

Toingtall a new program from a floppy disk or CO-ROM
drive, click Inztall

Irgtall... I

The following software can be automatically removed by
YWindows Toremowve a program or to modify itz inztalled
componentz, select it from the ligt and click
Add/Remove.

Microzaft Office 37, Profeszsional Edition ;l
Microzaft Wisual C++ 5.0
Microzaft Wizual SourceSafe Va0
PacketCD Reader Driver

Faint Shop Pro 5.01 Evaluation
Shagltd? w4.3

Wizual Bazic 5.0 Enterprize Edition

Add/Bemove... |

0k, Cancel Sl |

) STEP 4 I Click on Add/Remove .... .

» STEP S

Click on Yes in the Application Removal dialogue box. (All non-shared
components are deleted.)

Confirm File Deletion

Do wou want to completely remove the selected application and all of its components?

Cancel
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» STEP 6

» STEP 7

» STEP 8

Uninstall begins.

If the Shared Component window appears in the middle of the screen,
click on Remove None. (Shared components are not deleted.)

Installshield Wizard

Setup Status

WINCAPSZ DEMS0D Setup iz performing the requested operations.

Uninztalling: Program Files. .

C:%Program Files\WwWINCAPSZ DEMSOAR obat Type\HC-4555-arm. mdb

D

Upon completion of uninstall, a dialogue box for confirming
completion of processing will appear on the screen. Click on OK.

InstallShield Wizard

Maintenance Complete

InztallS hield Wizard has finished performing maintenance
operations on wWINCAPS2 DENSO.

Upon completion of uninstall, restart Windows 95.

Note: Files created by WINCAPSII (such as *.pac, *.ini, etc.) are not

deleted by uninstall operation. Delete files manually as
needed.
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2.2 How to Connect Personal Computer and
Controller

This section describes each of the three types of connections between the
personal computer and the controller.

Note: Always turn both the personal computer and the controller OFF
before proceeding with connection work. Otherwise the equipment
may be damaged.

2.2.1 RS232C

This subsection describes RS232C connection. Use the COM2 port on the robot
controller for communication with the personal computer.

For connection between the computer and other peripheral equipment, refer to
respective instruction manuals.

2.2.1.1 Connecting Cable

} STEP 1 Connect an RS232C communication cross-cable to the robot
controller. Insert it securely in the controller and tighten the screws.

Connection of Robot Controller and
RS232C Communication Cable
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» STEP 2

2-10

Connect the other end of the RS232C communication cross-cable to
the communication port on the personal computer. Insert it securely
in the computer and tighten the screws.

I

Connection of Personal Computer and
RS232C Communication Cable



Chapter 2 Setting Personal Computer Teaching System

2.2.1.2  Setting Robot Controller

Set up the robot controller to use the RS232C port for the personal computer
teaching system. Make this setting using the teaching pendant.

Press F6 Set on the teaching pendant basic screen.
» STEP 1 | |

™ ™ ¢ g @ w eess0 | Joint WoTel] 1%
F6 HF

@ SHORT
CuT
Set |

Arm | Yision I/0 | OpePanel

® A ‘ Program

The Settings (Main) window will appear on the screen.

y d o @ w oeesw | downe woeTo|[ 1

Settings (Main)

S el el 2

Load! Log. FD. Mem Info Set Com. Maint.
[F11 [F21 [F31] [F4] LF5] LF6]
Options. Save! SaveFile
LF/] [F8] [F91]
Cancel: Close this window o
@ A‘ Load! | Log. | FD. | Mem Info| Set Com.| Maint. |
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Press F4 Set Com.
} STEP 2 The Communications Setting Menu appears on the screen.

Mo @ @ w608 | Joint o T ol 12

Mkl

Communications Setting Menu

# i 2

L | & ‘ L £

Permit. SeriallF  Modem Aiddress  Gateway
[F11 LF2] LF3] [F4]1 LF5]

2

HiSpeed!

LF7]

Cancel: Close this window @Eﬁwﬁﬁ
® A ‘ Permit. | SerialIF| Hodem Address | Gateway
} STEP 3 Press F2 Serial IF.
The Set RS-232C window appears on the screen.

(r)

Select COM2 and press F5 Change.
» STEP 4
@ QJ @ @ @ YM 60830 Joint WOT el W

19269 bps None 8 bit | 1 bit CR

38409 bps None 8 bit | 1 bit CR

19209 bps None 8 bit | 1 bit CR
19209 bps None 8 bit | 1 bit CR

Cancel 0K

F5: Change the selection. OK: Exit with saving 1

® Pk ‘ Change.

| | Default.

The Select Transmission Rate window appears on the screen.

2-12



Chapter 2 Setting Personal Computer Teaching System

Select the transmission rate and press OK.
» STEP 5 -

Q« @ Nl @ wm_ -cessp Joint N9T0||7

9609 bps

19200 bps

("

(o

(™ 38400 bps
(™ 57600 bps
("

115200 bps

Cancel ‘ OK |

it

CR

it

CR

it

CR

it

CR

OK

Select the transmission rate you want.

.&‘

SHORT
CUT

The screen returns to the Set RS-232C window.

} STEP 6 Check the display contents and press OK.

The set transfer rate becomes valid.

() Y o @ w -eesad Tolirs

wete|l[ 1z

19209 bps None 8 bit | 1 bit CR
19268 bps None 8 bit | 1 bit CR
19209 bps None 8 bit | 1 bit CR
19209 bps None 8 bit | 1 bit CR
Cancel | 0K |
F5: Change the selection. OK: Exit with saving 1
| | Default.| Change.

..f_\‘

The screen returns to the Communications Setting Menu window.
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Press F1 Permit. in the Communications Setting Menu window.
» STEP 7

Y @ 0w ees | Joint woto|l[ 1

F1
NI
Communications Setting Menu

2| = @] =«

£

Permit. SeriallF  Modem Aiddress  Gateway
[F11 LF2] LF3] [F4]1 LF5]

2

HiSpeed!

LF/7]

Cancel: Close this window @Eﬁwﬁﬁ

Address | Gateway

® A‘ Permit. | SerialIF| Modem

The Communication Permission Settings window appears on the screen.

y d o @ w oeesw | downe woeTo|[ 1

Cd

Communication Permission Settings

Read/write

Disable
Disable

Read/write

Read/write

OK

Cancel

F5: Change the selection. OK: Exit with saving 1
* - A

} STEP 8 Select COM2 and press F5 Change.
The Change Permission Settings window appears on the screen.

(=)

Change.
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Select the necessary permission settings.
»STEP 9
Y @ 0w ees Joint WoTo|[ 12

(" Disable
("~ Read only
(@ Read/write
Cancel ‘ OK |
0K
Select communication permission you need. GG
° 4 |

The meanings of the permission settings are as follows:
- Disable: Communication port is not used.
- Read only: Personal computer is enabled to read the robot controller
data. Itis not allowed to send data to the robot controller.
- Read/Write: Data exchange is allowed between the personal computer
and robot controller.

When creating a program, select Read/Write.
When supervising only variables or 1/0O values by automatic operation of a
ready program, select Read only.

Upon making a selection, press OK.
The screen returns to the Communication Permission Settings window.

Note: You cannot select Read/Write Enabled for both RS232C and
Ethernet simultaneously.
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Check the display contents and press OK.

} STEP 1 O The permission setting is enabled.
g;z @ (11 @ ¥S —6354D Xy N9T0|| 1%

Communication Permission Settings

Read/write
Read/write
Disable
Disable

Read/write

Disable

Cancel \ OK \

F5: Change the selection. OK: Exit with saving I

* .| I

The screen returns to the Communications Setting Menu window.

M d @ owoeww | s wetel[ 1w

Change.

Communications Setting Menu

<| o| g| «

£

Permit. SeriallF Modem Address Gateway
[F1] [F2] [F3] [F4] [F5]

4]

HiSpeed!

[F71]

Cancel: Close this window ﬁfﬁwﬁ}

Address | Gateway

@ A‘ Permit. | SerialIF| Modem

} STEP 1 1 ?EZS;S%Tanycfelttjvrvr:gi;a the basic screen.
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2.2.1.3  Setting Personal Computer

Set the personal computer to enable the installed WINCAPSII software to
communicate with the robot controller. Make this setting at your computer.

Start the System Manager from Programs by clicking on Start at
} STEP 1 Windows 95.
The System Manager starts up and the System Manager window appears
on the screen.

Note: For the method of starting System Manager, refer to “3.1
Starting Personal Computer Teaching System”.

} STEP 2 Click on Set communication button @ .
The ROBOTalk Manager starts up and the ROBOTalk Manager window
appears on the screen.
If a password has not been input, the Password dialog box will appear on the

screen. Enter the password. For the method of entering a password, refer to
“1.3.2 Password”.

¥ IRA-0000 - System Manager M= E |

File Toolz *Window Help

29| 4@ |

| Systern Manager | Standing by

Setting communication

Click on the ROBOTalk tab.
} STEP 3 The ROBOTalk Manager window will change as follows:

% ROBOTalk Manager

ROBOTalk | RS282C | Tolephone |  Ethemst | Comm.log |

—Communication Dewice
' BEZ32C ~ Telephone " Ethernet

~Optional Settings

[
Timegut ~— 4000 | msec.
1
Fetry, — 1 _ 5l times
1
Communication  ~ _ Rl times
Fetry:
o] 8 Cancel | Stop | Update
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Select RS232C(R) in the Communication Device column.
} STEP 4 Set the data as shown below in the Optional Settings column.
Timeout : 4000 msec
Retry :5times
Communication retry : 5 times

Click on RS232C tab.
} STEP 5 The ROBOTalk Manager window will change as follows:
% ROBOTalk Manager

ROBOTak | iB$233C | Teleghone |  Ethemet | Comnlog |

COkd FPort: |COR1
Baud Bate: 113200
Farity Bit: [N - Mo parity
Data Bit Length: |8
Stop Bit Length: |1

RN N[N KN

Harmal | =

)8 Cancel | Stop | Update

Select a communication port to use on the personal computer in the COM
Port column. Select it according to the specifications of the personal
computer.
For the Baud Rate column, select the same speed as is set for the robot
controller.

} STEP 6 I 'cl':rlwi:chC))rl‘B8¥élk Manager window closes.

This completes the communication settings for the personal computer.
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2.2.1.4 Connecting to the Robot Controller

If RS232C is selected as the communication device in the preceding item 2.2.1.3

“Setting Personal Computer”, the Setting communication button @ for the
system manager will appear as shown below:

¥ IRA-0000 - System Manager - |I=]
File Tools “indow Help

wET 9,

| Systern Manager | Standing by

Fig. 2-1 Setting communication Button (RC232C)

When the respective managers are started from the system manager button and
set for connection, corner marks _| will appear on each manager button. For
information on how to connect each manager, read the descriptions on the
operation of each manager in chapters 5 through 10.
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2.2.2 Telephone Line

A telephone line needs to be set up for the personal computer and robot
controller for telephone communication.

2.2.2.1 Connecting Modem

To make connection via a telephone line, a modem must be installed.

To do this, use Modems on the Control Panel in Windows.

For the connection of a personal computer and modem, refer to the respective
instruction manual as it varies depending on the hardware.
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2.2.2.2  Setting Robot Controller

Press F6 Set on the basic screen of the teach pendant.

} STEP 1 The Settings (Main) window will appear on the screen.
_Fe ) M9 = 0w oeessn | Joit woTel 1%

1=

Settings (Main)

ol 8| s||e]| 2

Loa. FD. Mem Info Set Com. HMaint.
[F2] [F3] [F4]1 CF5] LF&]
Options. Save! SaveFile
[F7] [F&] CFa]
Cancel: Close this window ﬁfﬁwﬁ}
@ A‘ Load! | Log. | FO. | Mem Info| Set Com.| Maint. ‘

Press F4 Set Com.
} STEP 2 The Communications Setting Menu window appears on the screen.

Mo @ @ w608 | Joint o T ol 12

Mkl

Communications Setting Menu

# i 2
L @ £ L £
Permit. SeriallF  Modem Aiddress  Gateway
[F11 LF2] LF3] [F4]1 LF5]
2
HiSpeed!
LF7]
Cancel: Close this window @Eﬁwﬁﬁ
® A | Permit. | SeriallF| HModem Address | Gateway
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Press F3 Modem.
} STEP 3 The Set Modem window appears on the screen.

@ @M Y o 8w -ees3 Joint HOT0|| 12

@ Select the modem port to be initialized

(& COM?

(" COM3

(" COM4

Cancel | OK |

[OK] : initialize i)

* . A I

Select the communication port of the controller to which the modem is
} STEP 4 connected.
Select COM2 and press OK.

The following system message appears.

Mg @ @ -6esn Joint W0 T o] 1%

Set Modem

System Message

Will initialize the modem connected to COMZ!

Cancel | 0K |

Cancel " OK

SHORT
CUT,

} STEP 5 Check the system message and press OK.

_®
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2.2.2.3 Setting Personal Computer

} STEP 1 Click on Setting communication button @I of the System Manager.
The ROBOTalk Manager starts and the ROBOTalk Manager window
appears on the screen.

If a password is not yet input, the Password dialog box appears. In this case,
input the password. For the method of entering a password, refer to “1.3.2
Password”.

Double-click on the Telephone tab.
} STEP 2 The ROBOTalk Manager window will change as follows:

% ROBOTalk Manager

ROBOTak |  RS2RC | Telephone | Ethernst | Commlog |

2

A
- Optional zetting——mM—— |
koderm: j
Location: |Default Location :J

TEL Murmber: |
[ Automatic Answer

ceibioder || SetDigl | onHook ||

.........................................................................................

} STEP 3 I Enter each item by referring to the descriptions in Table 2-1 and click
on OK.

Table 2-1 Telephone Optional Setting

Items Description
Modem Modem used for remote connection
Location Information of current location (Information on the
dialing party)
TEL Number Telephone number of the other party (called party)
Automatic Answer Call receiving side will be checked.
Set Modem Makes detailed modem settings.
Set Dial Modifies or adds location information.
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2.2.2.4

2-24

Connecting to Robot Controller

Upon selecting the telephone line for the communication device as a result of the
setting operation in the preceding item “2.2.2.3 Setting the Personal Computer,
the Setting communication button @lof the System Manager will appear as
shown below:

¥ IRA-0000 - System Manager M= E
File Tool: ‘“Window Help

o | 5|98 @2

|5ystem Manager |Standing by

Fig. 2-2 Setting communication Button (Telephone)

When the respective managers are started from the system manager button and
set for connection, corner marks _| will appear on each manager button. For
information on how to connect each manager, read the descriptions on the
operation of each manager in chapters 5 through 10.
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2.2.3 Ethernet

Setting is required to enable communication between the personal computer
and the robot controller by connecting them via Ethernet.

2.2.3.1 Connecting Cable

The personal computer and the robot controller need to be connected via an
Ethernet network. For information regarding this connection, refer to “1.2.2
Ethernet Connection”.

2-25



2.2.3.2 Setting Robot Controller

Set the robot controller to use the Ethernet port for the personal computer
teaching system. Make this setting using the teach pendant.

Specify the permission setting.

In the present stage, you cannot set the IP address (your IP address) and gate
address (gateway IP address).

Press F6 Set on the basic screen of the teach pendant.
» STEP 1 |

™ Mg o @ v e | oint Ho Tl 12
Fé6 [T

e

Set ‘

@ A‘ Prograin Arim | ¥ision 1/0 ‘ OpePanel

The Settings (Main) window appears on the screen.

Mg o @ v e | oint Ho Tl 12

i)

Seltings (Main)

o| 2| 8| s||<| <

Load! Log. FD. Mem Info Set Com. HMHaint.
[F1] [F2] [F3] [F41 [F5] CF6]

@@‘@

Options. Save! SaveFile
CF71] CF8] CFa]
Cancel : Close this window @wﬂ
@ A‘ Load! | Log. | FD. | Mem Info| Set Com.| Maint. ‘
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Press F4 Set Com.
} STEP 2 The Communications Setting Menu window appears on the screen.

M Y @ @ sesa | Joint Wo o] 1%

Commurications Setting Henu

o o i
L | = ‘ £ A

Permit . SeriallF  Modem fddress  Gateway

[F11 [F21] [F3] LF4] LF5]

4]

HiSpeed!

[F7]

Cancel: Close this window ﬁfﬁmﬁﬂ
@ A ‘ Permit. | SerialIF| Modem Address | Gateway
Press F1 Permit.

} STEP 3 The Communication Permission Settings window appears on the screen.

iy g @ @ w e | Joint woTof 12

Cd

Communication Permission Settings

Read/write
Disable
Disable
Disable

Read/write

OK

Cancel

SHORT

F5: Change the selection. OK: Exit with saving 1

° & —

Select Ethernet and press F5 Change.
} STEP 4 The Change Permission Settings window appears on the screen.

(=)

Change.
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» STEP S

2-28

Select Read/Write.

(") W 5 @ w -ses3p Joint WoTo|[ 12

Cd

Communication Permission Settings

Change Permission Settings

(" Disable

("~ Read only

(@ Read/write

Cancel ‘ OK |
K

g = g = SHORT
Select communication permission you need. 1

° 4 S

The meanings of the permission settings are as follows:

When using Ethernet, select Read/Write.

¢ Disable: Communication port is not used.

e Read only: Personal computer is enabled to read the robot controller
data. Itis not allowed to send data to the robot controller.

o Read/Write: Data exchange is allowed between the personal computer
and robot controller.

Upon making section, press OK.
The screen returns to the Communication Permission Settings window.

Note: You cannot select Read/Write Enabled for both RS232C and
Ethernet simultaneously.




» STEP 6

Chapter 2 Setting Personal Computer Teaching System

Check the display contents and press OK.
The permission setting becomes valid.

(") W 5 @ w -ses3p Joint WoTo|[ 12

Communication Permission Settings

Read/write
Disable
Disable
Disable

Read/write

T eieie

OK

Cancel

F5: Change the selection. OK: Exit with saving 1

° & —

The screen returns to the Communications Setting Menu window.

M d @ owoeww | s wetel[ 1w

Change.

Communications Setting Menu

/ 5 o
= G ‘ - £
Permit. SeriallF Modem Address Gateway
[F1] [F2] [F3] [F4] [F5]
4]
HiSpeed!
[F71]
Cancel: Close this window ﬁfﬁwﬁ}
@ A‘ Permit. | SerialIF| Modem Address | Gateway
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Press F4 Set Address.
} STEP 7 The Set Controller IP Address window appears.

M @ @ eesa it HoTo|[ 1z

Set Controller IP Address

‘ IP address JA68. @ 2

Perm Subnet mask 255 .25656 255 . @

Cancel

OK: Finishes this setting, Cancel: Cancels new entry 1
9 Fiy | | Change.
Press F5 Change and enter a required address.
} STEP 8 In the example here, IP Address is set to 192.168.0.1 and Subnet Mask to
255.255.255.0.

(=)

MY @ 0w s | dotnt woto|[ 1w

Set Controller IP Address

‘ IP address J68. @. CLR| B
Perm  Subnet mask 255 .255 255, 7 | 8 [ 9
[F1
4 5 6

;f Cancel |

L 1 2 3
HiSpeed!
e o | omncEL | oK

OK: Take in new entry. Cancel: Discard new entry )

® -~ | |

Press Cancel twice.
} STEP 9 I The display returns to the basic screen.
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2.2.3.3  Setting Personal Computer

} STEP 1 Click on the Setting communication button @I of the System Manager.
The ROBOTalk Manager starts and the ROBOTalk Manager window
appears on the screen.

If a password is not yet input, the Password dialog box appears on the
screen. In such a case, enter the password. For information regarding how
to enter a password, refer to “1.3.2 Password”.

} STEP 2 Click on the Ethernet tab.

% ROBOTalk Manager
ROBOTak |  RS23C | Telephone | ‘Etherneti | Commlog

~COptional Setting

Contraller P |192.153.|11

Connection Port: [4112

Local Port: |0

ok, Cancel Stop Update
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» STEP 3

2-32

Enter data in Controller IP, Connection Port, and Local Port at Optional
Setting and then click on OK.

Controller IP is the IP address of the party at the destination. Match it to the
desired party for connection. (For example, an IP address such as
192.168.0.1).

Communication Port is the local port number of the opposite party at
destination. Match it to the desired party for connection. (For example,
4112).

Local Port is the port number for own use. In principle it should be over 1024
and may be freely set if it does not infringe on others within the same
network.

Note: The following relationships have to be established for the
Ethernet connection: Own Connection Port = Local Port of
the other party.

Own Local Port = Connection Port of the other party

If connection is limited to the ROBOTalk Manager and robot
controller, the local port will be automatically replaced with
an appropriate value by setting zero (0) in the Local Port on
the ROBOTalk Manager side.

Table 2-2 Ethernet Optional Setting Option

Items Description
Controller IP IP address or host name of the opposite party
Connection Port Fixed at 4112
Local Port Fixed at 0
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2.2.3.4 Setting Network Environment

To effect connection by EtherNet, it is necessary to set up Windows. The
network environment setting procedures will be described here preconditioned
on the fact that the network card (adapter) is installed and that the Internet
protocol (RCP/IP) is effective.

First, check that the local area connection is effective.
Next, set up an IP address for the TCP/IP property.
Select Settings and Control Panel in this order from the START of Windows.

} STEP 1 The Control Panel window will appear on the screen.

£ Control Panel

Fle Edt Vew Favortes Took Help

Bt O 3 Do i T

Accessibiity  Add Hardware
Options

@) Hebp 2nd Stppert

} STEP 2 On the above screen, click the icon "Network Connections."
The Local Area Connection icon appears as shown below.

If "Disabled" is displayed with the icon, move the pointer to the icon, click the
right mouse button, and then select "Enable."

" Network Connections

Fle Edt View Favortes Tools Advanced Help ax

@k - @ (T e [oraes [

......... 4| LANor High-Speed Internet
Network Tasks iy

-
* Local Area Connection

Cisabled, Firevvallad
T A Broadeom 440 10/100 Integr...
v == v

[8] Create anew
connection

| % Set up o home or smol

Place the pointer on the "Local Area Connection Properties” icon, click the
} STEP 3 right mouse button and select "Property.”

The Local Area Connection Properties appears.

-+ Local Area Connection Properties

d|

Connect uzing:
B8 Broadcom 440x 104100 Inteqrated Ce

This connection uzes the following items;

QQDS Packet Scheduler ~
= AEGIS Protocal [IEEE 802.1%] +3.1.0.1

Install...

Description

Transmigzion Control Protocol/internet Frotocol. The default
wide area network protocol that provides communication
acioss diverse interconnected networks.

Show icon in notification area when connected
Matify me when thiz connection has limited ar no connectivity

[ 0K ] [ Cancel
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» STEP 4

» STEP S

2-34

In the Local Area Connection Properties window, select the General tab.

In the "This connection uses the following item:" area, press the Properties
button with the Internet Protocol [TCP/IP] selected. The Internet Protocol
(TCP/IP) Properties window appears.

Select the General tab and click the "Use the following IP address:".
Then enter the IP address and the Subnet mask.

For the actual values of the IP address and subnet address, inquire to the
network administrator in charge of the pertinent network.

If the network is local (for example, an environment for connecting the
personal computer and the robot controller only), the IP address can be set
as desired. Therefore, the IP address will be tentatively set here to
192.168.0.1 and the subnet address to 255.255.255.0.

Click on OK and the IP address setting is completed.

Note (1): When making connection to a wide area network (for

example an in-house network), always inquire to the
network administrator before setting the IP address and
subnet mask.
If an IP address used for the local area network is
connected to the wide area network (for example the
in-house network) without first invalidating it, confusion
may be occur in the connected network.

Note (2): No redundant IP addresses are allowed within the same
network. When making a connection to a widely shared
network, care should be taken not to allow an IP address
to be redundant with another terminal. The following are
examples of IP addresses that have the least probability
of redundancy with another terminal:

192.168.0.2 to 192.168.0.xxx (xxx represent 003 to 999.)

Internet Protocol (TCPIP) Properties

General

*r'ou can get [P zettings assigned automatically if pour nebwork supports
this capability. Othenwise, you need to ask your network. administrator for
the appropriate [P zettings.

) Obtain an IP address automatically
%) Use the following P address:
IP addiess: 192 188, 0|2 |

Subnet mask: ||z55 285 . 255

Diefault gateway:

(%) Usze the following DNS server addrdsses:
Prefered DMS server: [

&lternate DMS server:

L 0K ][ Cancel ]

This section must be the same as
that specified in the controller.

This value must not be the same as
that specified in the controller.
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2.2.3.5 Connecting to Robot Controller

If Ethernet is selected for the communication device according to “2.2.3.3 Setting
Personal Computer” and “2.2.3.4 Setting the Network environment” thus far
described, the Setting communication button @I of the System Manager will be
displayed as shown below:

¥ IRA-0000 - System Manager [ _ 5] x|
Fil= Toolz ‘Window Help

o |5 9|8 | @)

|System Manager |Standing by

Fig. 2-3 Setting Communication Button Display (Ethernet)

When the respective managers are started from the system manager button and
set for connection, corner marks _| appear on each manager button. For
information regarding how to connect each manager, read the descriptions on
the operation of each manager in chapters 5 through 10.
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Starting Teaching
System and Knowing
Each Manager

This chapter describes the procedures for starting
and terminating the personal computer teaching
system and outlines the functions of each
Manager.






Chapter 3 Starting Teaching System and Knowing Each Manager

3.1 Starting Personal Computer Teaching

System

Let’s start and run the WINCAPS Il on your personal computer in order to input,
edit, and verify the robot operation programs.

Starting the System Manager

DENSO application software WINCAPS Il for personal computer teaching
system consists of the following function modules.

» STEP 1

PAC Program Manager

Variable Manager

DIO Manager

Arm Manager

Vision Manager

Log Manager

Communication Setting Manager

All these function modules are controlled by the System Manager. That is, all the
functions of WINCAPS |l should be called from the System Manager before they
are implemented.

To use the personal computer teaching system, start the System Manager first.

Click Start at Windows 95. Point to Programs, and then click System
Manager in the WINCAPS Il folder.

i SyztemM anager |

@ Connect with the controller?

Corrunication Device : R5232C
Optional Settings : COM1, 38400bpz, M - Mo Parity, 3, 1
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» STEP 2

» STEP 3

» STEP 4

» STEP S

3-2

The WINCAPS Il Information window appears. Read the information and
click OK.

License key Information
Pleaze enter your licenze key.

Licenze Fey | Add |

Licenze key Bemove |

Cancel

Note: If you click the check box “Omit this message” at the lower
left of the screen, the above window will not appear from the
next startup operation.

The License Information window does not appear until you enter your license
key. Enter User ID printed in the license card and click OK.

Note: For detail on entering the license key, refer to 4.5.1 License
Key. Once you enter your license key, this window will not
appear from the next startup operation.

When starting the System Manger after initial installation of WINCAPS I,
create a program bank.

Note: When the dialog box “Create Program Bank” appears, specify
the files to be used in the program bank according to the
procedure described in “5.7.2.3 Updating Program Bank”.

You need to create a project when activating the WINCAPS Il for the first
time after installation, because no system project has been defined.

Note: If a dialog box “Create New Project” appears, create a project
for the robot to be connected by referring to “4.2.1. New
Project”.
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» STEP 6 |

» STEP 7

» STEP 8

When the WINCAPS Il is activated the second time and after, the dialog box
"Open Project” appears. Select a desired project. The default is the
previously used project.

The Password window appears. Select the user level from the pop-up menu,
enter the password if necessary, and then click OK.

@ Pazsword |
User|0- Operatar j
Eassword:

Note: For the password, refer to “1.3.2 Password”.

The dialog box appears with the message “Connect with the controller? ”.
Click No.
e - |

@ Connect with the controller?

Communication Device : R5232C
Optional Settings : COM1, 38400bps, N - Mo Parity, 8, 1

The System Manager is activated and the System Manager window
appears. The icon buttons are used to activate the modules classified by the
function.
To use each of these function modules, click the required module icon or
select the required function from the command menu in the System Manager
window.

¥ IRA-0000 - System Manager !EI

File Toolz *Window Help

2B 28 @)

| Systern Manager | Standing by

<)
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3.2 Terminating Personal Computer Teaching
System

To terminate the personal computer teaching system, you need to terminate the
programs of both personal computer and Robot Controller.

3.2.1 Terminating Personal Computer

Clicking the close box at the upper right of the System Manager window will
} STEP 1 terminate all the software for WINCAPS Il running on your personal
computer.

¥ IRA-0D00 - System Manager M= E |

File Tools “Window Help

Mew Project...
Open Project... Ctrl+0
Save Project Chrl+5

Save Project Az Chil+d
Tranzfer Project...  Chl+T

Froject information

} STEP 2 I Terminate the Windows 95 and turn off the personal computer, if necessary.

3.2.2 Terminating Robot Controller Connected with Personal
Computer

} STEP 1 Turn off the power switch.

Power switch of
the Robot Controller




Chapter 3 Starting Teaching System and Knowing Each Manager

3.3 Function Outline of Each Manager

The application software for the personal computer teaching system consists of
the various Managers classified by their functions. The following table lists the

function outline of each Manager.

Manager

Functions

Reference

System Manager:

Totally controls the
personal computer
teaching system.

Starts each Manager.
2. System project management
® Creates a new project.
® Opens an existing project.
® Saves a project.
® Transfers a project.
® Terminates the personal computer teaching system.

3. Sets the communication devices and their operating
conditions.

Changes password.

Enters the license key.

41.2
413,42

4.3.1

43.2
434,435
4.5.1

PAC Program
Manager:

Totally supports the
program

development using
the robot language.

4
5. Reads data from or records data onto the floppy disk.
6
1

File operations
® Creates a new program project.
Opens an existing program project.
Saves a program project.

)
)
® Sets the parameters used for the project.
® Receives/transfers the program data.
® Prints program data.
® Creates an executable program.
® Terminates PAC Program Manager.
2. Program editing
® Edits program.
® Searches and replaces character-string in program.
® Jumps to another line.
3. Program Management
® Creates a program and adds it to the project.
® Saves a program file with another name.
® Adds an existing program to the project.
® Removes a program from the project.
® Imports and exports a program.
® Changes the order of displayed programs.
4. Makes various settings for PAC Program Manager.
5. Uses the program bank.

* An existing program can be registered or used as a part.

6. Command builder
* Supports proper inputs of commands and arguments in
program editing.

5.2

5.3

54

5.6
5.6.2

56.3
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Manager Functions Reference

Variable Manager: 1. Monitor the variables. 6.4
Backs up or 2. Operates the variables data. 6.1.3
\rg?gg?;sé tl:]sed by 3. Prints the variables table. 6.2.6
the Robot Controller. | 4. Backs up data in the variables table. 6.2.4

5. Creates a macro definition file for variables. 6.2.7

6. Transfers the variables table between personal computer | 6.2.5
and the Controller.

7. Sends messages via RS232C. 6.5.2

DIO Manager: 1. Monitors the I/O status. 74.3
Monitors the 1/0 2. Changes the I/O status according to dummy input. 74.4
S O ata | 3. Prints the 1/O table. 7.26

4. Backs up the I/O table data. 7.2.3

5. Creates the macro definition file for assigning I/O data. 7.2.7

6. Transfers the I/O table between the personal computer 7.2.5
and the controller.

Arm Manager: 1. Monitors the current position of robot arm. 8.4
Monitors the current | 2. Views the work number and the tool number. 8.5
\r,\?g&t ﬁﬂmﬁgfgﬁg’ 3. Gets the current position into pose data. 6.4.4
tool number. 4. Simulates robot movements. 8.6.2

5. Sets the parameters related with the robot arm. 8.6.1

6. Defines the tool coordinate system. 8.6.1

7. Defines the work coordinate system. 8.6.1

8. Defines the area. 8.6.1

9. Object tree 8.6.3
* Defines the object drawn in the robot display.

10. Converts pose data. 8.6.4
* Type conversion among P, J, T type data
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Manager Functions Reference
Vision Manager: 1. Opens the image data. 9.2.7

Supports creation of | 2. Connects with the Robot Controller. 9.3.1

\lgzlgnlapnrgggagrg USING | 3. Creates a macro definition file for vision. 9.4.2
4. Displays the camera image. 9.4.6
5. Edits the window. 9.4.3
6. Edits the search model. 9.4.4
7. Executes the camera CAL. 9.4.5
8. Uses the image analysis tool. 9.4.6

LOG Manager: 1. Browses log data. 10.1

Gets the log (robot ® Error log

%qgrsgr%%rrg?ord) ® Operation log

computer and ® Control log

manages the log o

data. ® Communication log
2. Creates new log file. 10.21
3. Receives the log data from the controller. 10.2.5
4. Prints the log. 10.2.6
5. Searches and replaces the character strings. 10.3.7
6. Control log 10.4.3

(Records the control log so that the operation can be
replayed using the Arm Manager.)

7. Displays the version of each robot controller part. 10.6.1
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System Manager

This chapter describes the function and operation
of the System Manager, which constitutes the
nucleus of the WINCAPSII software used in the
personal computer teaching system.






Chapter 4 System Manager

4.1 Outline of System Manager

4.1.1 OQOutline of Functions

WINCAPSII application software for the personal computer teaching system
consists of various managers with their own respective functions, as stated

below:

e System Manager: Overall control (including communication setting)
e PAC Program Manager: Program editing control

¢ Variable Manager Variable information control

¢ DIO Manager: I/0 information control

e Arm Manager: Robot action information control

e Vision Manager: Vision information control

e Log Manager Log information control

The System Manager makes controls the overall data files controlled by other
managers, as a system project. It also controls communication setting and
password setting.

Respective managers can be used by calling them from the System Manager.
To start the System Manager, select the System Manager program with the Start
key of Windows. When started, the main screen of WINCAPSII and the System
Manager window appear on the screen.

For starting procedure details, refer to Chapter 3 “3.3.1 Starting System
Manager” in this manual.

¥ IRA-0000 - System Manager !EIE

File Toolz “Window Help

1|6 |9 |@| ]

|5y5tem Manager |5tar‘uj{r\'|g by

Displays object of system/ )
manager operation Displays the content of Status bar
system manager operation

Fig. 4-1 WINCAPSII Main Screen
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4.1.2 Tool Bar

¥ IRA-0000 - System Manager M= E3
Tool bar File Toolz ‘wWindow Help

= e i., Communication
PAC Program __ | '{ﬂh E set button
Manager button , S

7

|5~,f5te;ﬁ Maﬂgéler |5ta;\;di;g I:n,r\ \

\
Variable Manager button / \ Log Manager button
DIO Manager Vision Manager
button Arm Manager button
button

Fig. 4-2 Tool Bar

PAC Program Manager Button £

Click on this button to start the PAC Program Manager.

For descriptions on the operating procedures of the PAC Program Manager,
refer to Chapter 5 “Operating PAC Program Manager” and Chapter 3 “3.5
Entering and Editing Programs” in this manual.

When the PAC Program Manager is connected to the Robot Controller, the
button icon changes to ﬁifl .

Variable Manager Button

Click on this button to start the Variable Manager.

For Variable Manager operating procedures, refer to Chapter 6 “Operating
Variable Manager” and Chapter 3 “3.14.1 Starting Variable Manager” in this
manual.

When Variable Manager is connected to the Robot Controller, the button icon

display changes to .

DIO Manager Button |

Click on this button to start DIO Manager.

For the procedures for operating DIO Manager, refer to Chapter 7 “Operating
DIO Manager” and Chapter 3 “3.13.1 Starting DIO Manager” in this manual.
When the DIO Manager is connected to the Robot Controller, the button icon

changes to 4] .

Arm Manager Button &

Click this button to start the Arm Manager.

For the procedures for operating Arm Manager, refer to Chapter 8 “Operating
Arm Manager.”

When the Arm Manager is connected to the Robot Controller, the button icon

changes to @I
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Vision Manager Button &|

Click on this button to start the Vision Manager.

For Vision Manager operating procedures, refer to Chapter 9 “Operating Vision
Manager” in this manual.

When the Vision Manager is connected to the Robot Controller, the button icon
display changes to @I _

Log Manager Button

Click on this button to start the Log Manager.

For Log Manager operating procedures, refer to Chapter 10 “Operating Log
Manager” in this manual.

When the Log Manager is connected to the Robot Controller, the button icon
display changes to .

Set Communication Button €|

Click this button to set communication.

To set Communication, refer to Chapter 4 “4.3.1 Set Communication” and
Chapter 2 “2.2 How to Connect Personal Computer and Controller” in this
manual

“Set Communication” button display changes for each selected communication
device:

!"‘ When not in connection

;| Connected via RS232C
Connected by telephone line via modem

t" Connected by TCP/IP via Ethernet
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4.1.3 System Project Management

When developing a program using WINCAPSII, in addition to the program data,
a number of data such as variables and parameters that accompany the
operation of the program have to be processed.

With WINCAPSII, the System Manager manages programs and the related
groups of data, in terms of a system project. This management information is
stored in the system project file (SPJ file). The system project file controls all
information needed for operating a unit of the robot.

4.1.3.1 WINCAPSII-Generated Files

Fig. 4-3 shows the relationship among the files, which are generated and
managed by their respective WINCAPSII managers, for the purpose of data
storage.

Files other than the program bank file are placed in the project folder,
immediately after a system project is newly created. The program bank file is
placed in the folder named ProgramFiles\Wincaps2, if the default exists where
WINCAPSII application is installed.

For example, if a project named IRA-0000, which appears initially by default is
generated, this project is generated in the folder named ProgramFiles\Wincaps2 by
default. Files other than the program bank files are placed in the project folder
named IRA-0000. Fig. 4-4 shows the position of files generated and managed
by WINCAPSII.

Note: Each Manager has a current folder. These Managers output their
respective control files to their current folders.
Immediately after newly creating a system project, all the Managers
use the same current folder.
When respective Managers newly create files, the current folder will
not be changed, unless the folder is changed.
If the current folder is changed, a reference path for the input file
will be required using #INCLUDE statement and other file input
commands.

4-4



Chapter 4 System Manager

setting)

System Manager
(including
communication

System project file
(including communication setting)

i I N I A A

Program Variable DIO Arm Vision Log
Manager Manager Manager Manager Manager Manager
Variable DIO file Arm file Vision file Log file
file
var_tab
* BNK *.PPJ h
Model
Program  Program Micro *MbL data file
bank file  project file o arm_cnf com_chf
definition file h I E
Arm configuration Confi .
macro definition file onfiguration macro
definition file
* LNK * PAC|| Program file
dio_tab | Micro
Make file Definition file X
h vis_tab
.h
RIC || | diate fil Macro
*, ntermediate file . inition fi
dio_cnf definition file
.h
vis_chf | Configuration macro
Configuration macro h definition file
definition file
* MAP * NIC
Cross Execution *.bmp
reference file format file
Bit map file

Fig. 4-3 Files Generated and Managed by WINCAPSII



e Desktop

[:l Program files

("] Wincaps 2

*BNKI Program bank file

(1 1ra-0000

System project file
(including communication setting)

— |. Loc | Log file

— | ..vis | Vision file

L |.vpoL|| Model data file

— | arm | Arm file
— |«.pio | DIO file

— |.var | Variable file

— |«.ppJ | Program project file

[ [*PAC || Program file
*h || Macro definition file

Fig. 4-4 Position of Files to Be Generated and Managed by WINCAPSII
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__________________________________________________________________________________________________________|

4.1.3.2 File Management by System Manager

The System Manager manages the relation of data files generated by other
groups of Managers. The system project file (*.spj) generated by the System
Manager has data files which are referenced by each Manager.

When starting each Manager, the System Manager specifies the reference data
files for the started Manager. Therefore each Manager can use the groups of
programs or variables that differ by project, without confusion.

The Set Communication is a function incidental to the System Manager and,
therefore, it does not have its own data file. The Set Communication information
is included in the system project file.

The system project file has an extension code “.SPJ".
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4.1.4 Menu List

The System Manager command menu has the following tree structure:

File
New Project
Open Project
Save Project
Save Project As
Transfer Project
Project information
Exit

Tools
Set Communication
Change Password-------- (Programmer Level)
Re-Login
Read FD Images
Write FD Images

Window
PAC Manager
Variable Manager
DIO Manager
Arm Manager
Vision Manager
LOG Manager

Help
License Key
System Extension
About System Manager

Fig. 4-5 System Manager Menu Tree
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4.2 File Menu

The System Manager FILE menu contains commands for controlling the project,
besides the command for exiting the System Manager.

¥ |IRA-0000 - System Manager !El

File Tool: “Window Help

MHews Project...
Open Project... Chrl+0
Save Project Chrl+5

Save Project &z... Chilsh
Tranzfer Project...  Chrl+T

Project infarmation

E xit

Fig. 4-6 File Menu

Note: The New Project and Open Project menu commands are invalid
when any of PAC, DIO Arm, Vision and LOG Managers is
connected.

4.2.1 New Project

This command is used for creating a new system project.

After selecting this command, the Create New Project dialog box appears on the
screen. Input default data, after changing it as may be needed, and click on OK.
If Cancel is clicked, the command closes the box without creating a project.

# Create New Project

Bobot Series ; [[EEEE OK

Type:|HM-40704D

Configuration : |Standard

Cancel

b
Ex-Joint: |Disenahble Mew Folder

Stroke|200mm j

Ll

)
dail

Dietails

Project Name:[\vM-40700
Eolder Marme |C\PROGRAM FILESWWINCAPSZ, |
Output-Code:|verl 5

N K]

Facility Type:|0 - Standard

Fig. 4-7 Create New Project Dialog Box
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¢ Robot Series: Select a desired robot series.

e Type: Select a robot type from "Robot Series."

¢ Environment: Select environment according to the selected robot.

¢ Additional Axis: Select whether there is an additional axis.

o Stroke: Displayed for each robot type as required. Select this
item according to the selected robot.

¢ Project Name: Enter the project name.

e Folder: Describes a folder for storing the project. You can select

a folder path by clicking the Folder button.

¢ Output Code: Sets a version of the execution program to be created
according to the version of the connected controller.

e Facility Type: Select a facility type. A program library necessary for the
type selected here is automatically added to the PAC
program manager. If Standard is selected, nothing will be

added.

¢ New Folder: After clicking, the New Folder Window appears. The new
folder can be created by entering the folder name.

Mew Folder

Tywpe a new folder name.

Cancel |

c:%FProgram Fileswincapsz,

Fig. 4-8 New Folder Window

e Details: After clicking, the Details window appears. Specify, in
this WINDOW box, the default data reference files of the
respective Managers. The default data is created in the
process of Create New Project. Set the respective
reference files using “...” Clicking on Initialize returns the
specified reference file to the default setting. It is usually
not necessary to change the detail setting.

#F Details Ed
~Default File Mame
PAC Manager: o \Program FilesWINCAPS2\EEEfpacm | .
“ariakle ManagerlC:'\Pquram FilesWWwWINCAPS2\EBBR-war.md J
Dio ManagerlC:'\Pquram FilesWWWINCAPS2EEE-cio.md _I

Arm Manager: |C:'\Pru:u::|ram FilesWWwWINCAPS2EBS-amm.m _I
Yision Manager:lC:\Pquram FilesWWINCAPS2\065-vis.md _I
LOG Manager:lC:\Pquram FilesWWWINCAPS2EES-00.md _I

oK Cancel | itislize |

Fig. 4-9 Details Window

4-10



Chapter 4 System Manager

4.2.2 Open Project

This command opens the existing projects.
When this command is specified, the Open project window appears.

Open Project
Laak in: |EJ Hs-e =l ﬁl 5
HS-E.spi

File name: H5-E Open I
Files of twpe: ISF'.J Filef*. zpi] j Cancel |
Z

Fig. 4-10 Open Project Window

The files that contain the project management information have the extension
file name “.spj”. Select a file having the “.spj” extension for the project name.
Click on the Move up one holder level button or the folder in the display box,
and you can change the path.

When you click on a file having an “.spj” extension, the file name is entered in the
File name box. Click on Open to opens the project.

To close the dialogue box without opening the project, click on Cancel.

4.2.3 Save Project

This command saves the currently opened project information.

4.2.4 Save Project As

This command stores the currently opened project as another one. All files used
for the current project are copied to the new project.

Note: Do not select “Floppy (A:)” as place saved in.
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4.2.5 Transfer Project

This command transmits the system project data. In the Robot Controller, this

command is used for backing up the data.
Data may be transmitted in a batch, or may be transmitted in parts by selecting

each Manager data from the transmission table.

Note: To transmit data selectively under the control of a manager other
than the System Manager, you can use the Transmit command in
the File menu of each respective Manager.

%2 Batch Transfer of All Data EE

— Transfer Tahle -
Al program data <FAC Transmit >
Al wariable data <variable hMan: < Beceive
v All DIO data <D0 kManager>
Allarm data <arm Manager>

Cancel

¥ Al wision data, <\ision kManager
v &l log data(Feceie Onki<Log |

Select Al

Fig. 4-11 All Data Batch Transfer Window

4.2.6 Project Information
Displays the set robot type or the project information for each Manager.

Project information

ﬁ Robot Type : VM-6083D
Froperty | Walue |
fectem project [5PJ] D CAWINCAPS 2APROJECT YW-608308M-B0830 <pj
PP file CNWINCAPS 2APROJECT M-6023048M-60830 . ppj
YR file CAWINCAPS 2APROJECT Y -B0830 8160830 war
DIO file CAWINCAPS 2APROJELCT WW-B02304 1-60830. dio
ARM file CAWINCAPS 2APROJECT WW-60830%1-60830 . arm
WIS file CNWINCAPS 2APROJECT WM-6023041-60830. vis
LOG file CWINCAPS 2APROJELCT W-60230% 1-60830 log
Close |

Fig. 4-11-1 Project Information Dialog Box

4.2.7 Exit

This command terminates the WINCAPSII application software.
The functional managers opened from the System Manager are simultaneously

terminated.
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4.3 Tools Menu
2 1RA-0000 - Systom Managor IS |

File | Toolz “Window Help
F Set Commurication
f

Change Password
| Syst Re-Lagin

Bead FO' Image
Wirite FO Image

Fig. 4-12 Tools Menu

4.3.1 Set Communication

When you select “Set Communication” in the Tools menu, the ROBOTalk
Manager dialog appears.

Click on the set communication button @I to display the ROBOTalk Manager
dialog.

The ROBOTalk Manager dialog box is used to set the communication device
and communicating conditions, and to perform service processing of the
communication protocol for the robot. This dialog box is also used to monitor the
communication state and save the communication log.

4-13



% ROBOTalk Manager E3

Rl]lil]TalkT Ri23C T Telephone T Ethernet T Coirron. Lag )

— Communication Dewvice
" BESZ32C " Telephone " Ethernet

— Optional Settings

|
Timeout ~— J | 4000] msec
|
Retnye — & | E|times
|
Comrmunication  — &7 | 5| times
Fietr:

Stop | Update

oK |

Fig. 4-13 ROBOTalk Manager Window

Clicking on the ROBOTalk tab enables you to make settings, as described in the
following section downward.

When all the settings have been completed, click on OK.

When you lick on Cancel, the ROBOTalk Manager dialogue box is closed
without any change of set values.

Press Stop in such cases where you want to interrupt transmission from the
personal computer, no response is returned from the other party, or you want to
stop the ongoing transmission.

Update is a button for confirming the contents until now. Clicking on OK closes
the Communication Manager. Use Update to check the set data without closing
the Communication Manager.

Note: The OK and UPDATE (A) buttons are invalid when one of the PAC,
Variable, DIO, Arm, Vision or LOG Managers is in connection or the
user level is set to “0-Operator”.
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[1] ROBOTalk

Click on ROBOTalk tab in the ROBOTalk Manager window, and the screen
shown in Fig. 4-14 appears.

% ROBOTalk Manager E3

™

Rl]Bl]TalkT RI23C T Telephone T Ethernet T Eu:;n\}n'n.Log

— Communication Dewvice
v BEZ3EC " Telephone " Ethernet

~ Optional Setftings

|

Timegut ~— | 4000| meec.
|

Retne: — & | E|times

S [ Sltmes

Communication
Fetny:

atop | Update

oK |

Fig. 4-14 ROBOTalk

Communication Device

Select a communication device to use for communication with the Robot
Controller by clicking on a desired device.

The Set Communication button icon @I in the System Manager changes to the
communication device selected here.

RS232C is selected.

Telephone line is selected.

(" Ethernet is selected.

Setting Option

Timeout: Sets the waiting time, for error judgment when no
response is received from the Robot Controller.
Default: 4000 msec.

Retry: Sets the number of retries, when a timeout error is
generated in communication.
Default: 5 times

Communication retry:  Sets the number of retries when an error is generated in
communication.
Default: 5 times
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[2] RS232C
Click on RS232C tab of the ROBOTalk Manager window to display the screen
shown in Fig. 4-15.

Set the required data on this screen to enable connection between the personal
computer and the Robot Controller directly with the RS232C cable.
“% ROBOTalk Manager
ROBOTak | 52330 Teleghone |  Ethemnet | Comm Log |
3
~Optional Setting ———————————— 1
COM Port: | COM! =
Baud Rate: |19200 =
Earty Bit: | - Mo parity _:j
Cata Bit Length: |8 j
Stop Bit Length: |1 :j
Ik Cancel i atop i Update
Fig. 4-15 RS232C
COM Port
Select the communication port to be used on the personal computer. When you
click on the arrow j the options appear in a pull-down menu.
Baud Rate
Select the baud (communication) rate. When you click on the arrow j the
options appear in a pull-down menu.
Note: The faster the communication speed, the more frequently the
communication error tends to occur.
Parity Bit
Select the parity check bit. Click on the arrowjto display the options in a
pull-down menu.
Data Bit Length
Select the data bit length for communication. Click on the arrow j to display the
options in a pull-down menu.
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Stop Bit Length

Select the stop bit length. Click on the arrowj to display the options in a
pull-down menu.

Normal

Set all RS232C related items to normal settings.
Communication port : COM1

Baud rate 119200
Parity bit : N-No parity
Data bit length '8

Stop bit length 1

[3] Telephone

Click on Telephone tab in ROBOTalk Manager dialogue box to display the
screen shown in Fig. 4-16.

Set the required data on this screen to enable connection between the personal
computer and Robot Controller using a telephone line.

% ROBOT alk Manager E3

ROBOTak |  R5232C | Telephone |  Ethernet | CommLog

=

S

—Optional Setting

todern: IStandard 19200 bps Modem j

Location: INEW Location j

TEL Mumber [5554221]
[T Automatic Answer

SetModem | SetDial | onmoor |

0] | Cancel | atop | Update

Fig. 4-16 Telephone Tab

Modem

The above dialog box shows the currently selected modem. Click on the arrow
j to display the options in a pull-down menu.

By clicking on Modem icon in the control panel, you can select a registered
modem.

For how to use the Modem in the control panel, refer to the instruction manual for
Windows 95.

Location

Select the location where the personal computer is used. Clicking on the arrow
j to display the options in a pull-down menu.
You can select a registered location by the following dial settings:
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TEL Number

Enter the telephone number of the other party to which you intend to connect.
Only enter the numerical characters. Hyphen, bracket, or the other signs are not
usable for entry of telephone number.

Automatic Answer

If you put a checkmark in Automatic Answer check box, the personal computer
automatically answer the calls.

Set Modem

This column shows the property of the selected modem.
For details on modem property setting, refer to the instruction manual for
Windows 95.

Set Dial

This column displays the dial property.
For details on dial property setting, refer to the instruction manual for Windows
95.

ONHOOK

Press the ONHOOK button to disconnect the telephone connection.

Note: Connection with a telephone line is possible only when the modem
is installed. For details on modem installation, refer to Chapter 2
“2.2.2 Telephone Line” in this manual.
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[4] Ethernet

Click on Ethernet tab on the ROBOTalk Manager dialogue box to display the
screen shown in Fig. 4-17.

Set the required data on this screen to enable connection between the personal
computer and Robot Controller using Ethernet.

‘@ ROBOTalk Manager

ROBOTak | RS22C | Telphwne | [Ethernet! | Comm Log

sy

- Optional Setting

Cantraller IP; ;192.153.0.1

Connection Part; ;41 12
Local Fort: iU

Ok Cancel Stop Update

Fig. 4-17 Ethernet

Controller IP

Enter the IP address or the host name of the opposite station.

Connection Port
Enter the port number of the opposite station. Always set this number to 4112.

Local Port

Enter the port number of the personal computer.
Always set this number to 0 (zero).
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[S] Communication Log

Click on Comm. Log tab on the ROBOTalk Manager dialogue box to display the
screen shown in Fig. 4-18.

The communication log function is used for checking the communication state.
Use this function for checking the line condition, should you have a
communication error.

& ROBOTalk Manager

ROBOTak |  E$232C |  Telephone | Ethemet |Comm, Log

Total Mumber of Traasmined Packes:
Tatal Mumber of Received Packets:
Murnber of ransmited MAKs: [ 1

Mumber of Received Maks: [

Mumber of Received MNAKS (Standhby]): E
Murnber of Timeout Occurrences: [ 1

(0] Cancel Stop Update

Fig. 4-18 Communication Log

Total Number of Transmitted Packets: Total number of packets transmitted by

WINCAPSII

Total Number of Received Packets: Total number of packets received by
WINCAPSII

Number of Transmitted NAKs: Number of NAKs (error packets)
transmitted by WINCAPSII

Number of Received NAKSs: Number of NAKs (error packets)

received by WINCAPSII

Number of Received NAKs (Standby): Number of NAKs (error packets)
received by WINCAPSII except the
errors caused in response to the
transmitted packets

Number of Timeout Occurrences: Number of timeouts except the timeout
errors caused in response to the
packets transmitted by WINCAPSII

Note: If timeout occurs for reasons other than connection failure, extend
the timeout duration as noted in Chapter 4 “Setting Option” .
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__________________________________________________________________________________________________________|

4.3.2 Changing Password (Programmer Level)

To change the password, select Change Password from the Tools menu. The
Changing password window appears.

@, Changing password

QserChangedtD:h - Programmer j

2 PEI.SSWEIFdfi

Blew Paaawnrd:i

ey e Passwnrd:i

K. Cancel

Fig. 4-19 Changing Password Window

At User Changed to, select the user level whose password is to be changed.
At Old Password, enter the previous password.

At New Password, enter a new password.

At Verify New Password, re-enter the new password for verification.

After correctly entering all the items, click on OK.

To cancel change of password, click on Cancel.
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4.3.3 Re-LogIn

Use this function when changing the user level.

Select Re-Login from the Tools menu in the System Manager.
} STEP 1 The password window appears on the screen.

¥ IRA-0000 - Spstem Manager !E[

File | Toolz Window Help
P Set Commurication
e
Change Pazswaord
5 INTETEY)

Head FO' Image
Wirte FO' Image

} STEP 2 Select the user level from the popup menu.

&, Password

CE. Cancel

Input the password correctly and click on OK.
} STEP 3 The user level has been changed.

. Pazsword

Userl1 - Pragrammer j

et

Fassword:

] Cancel |

Note: If you press Cancel without entering password, you will be
requested to enter the password when you specify the data setting,
printing, or communication commands.
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4.3.4 Reading FD Images

Data may be exchanged by using a floppy disk as the media between the Robot
Controller, instead of data transmission using communication.
When reading data from a floppy disk, read the FD images.

Select Read FD Image from the Tools menu.
} STEP 1 The dialogue appears requesting you to end the System Manager.
Click on Yes.

i .SystemM anager <]

[Drata will be merged with the project by ending the System Manager. End the Svstem Manager?
If hio, execute FD reading and recpen the project.
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} STEP 2 Click on Next.

' FDTool ver 1.1.3

Feading data from &:4MetwoRCh.

Will cieate new folder for new project to be constructed. In the caze of
merging, data will be merged to exigting project.

£~ Creating new syztem project

i_F kerging to exishng project

|
1| |2 \Program Filesti HCAPS24RA-00004 RA-0000 spi o
. E . -
Hank Memt> Cancel
Creating new system project: A folder and a system project file are

newly created. The read data is
merged in that project.

Merging to existing project: The read date is merged in the existing
project.

Reference: Select an existing system project.

Back: Return to the initialize the screen.

Next: Proceed to the read a data object
select screen.

Cancel: End

Select a data object and click on Next.

} STEP 3 Select the data attached with a check mark as the object.

" FDTool ver 1.1.3

Select object data by manager. All the data managed by selected

manager will become object.
Select all |

- Object data

All program data <PAC Manager»
[ 1 Al variable data <% aniable Manager:
[ Al DO data <DI0 M anager:

1Al A data <A kanagern:

[ ] Al vizion data <Vision Manager:

| 1Al Log data <Log Manager:.

 <Back e Cancl
Select All: Select all object data for reading.
Back: Return to the system project select screen.
Next: Read from the floppy disk.

Cancel: End
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» STEP 4

The following message appears requesting you to insert the floppy
disk. Insert the floppy disk containing the read data into the floppy
drive and click on OK.

+ FDTOOL

If the floppy disk has different data from the object being read, a message
appears prompting you to change disks. Replace with the correct disk and
click on OK. Clicking on Cancel returns the display to the object data select
screen.

: .FDTOOL E|

& Insert - #71 disk. Mrang disk is inserted.]
i Cancel |

If the floppy disk is neither inserted nor formatted, an error message
appears. Insert the correct disk and click on OK.

: FDTOOL

& Either digk iz not inserted or formatted. Insert the disk.

Cancel |

When the correct disk is inserted, the object data is read. Reading progress
is indicated with a bar graph.

W FDTool ver 1.1.3

All program data reading

A iMetwoRCWUITOESEC FAC

AERENENENENNNERENEN

cBack Hewts Cancel
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» STEP S

When the data is read normally, an indication to that effect appears.
Click on Complete.

W FOTool ver 1.1.3

Fead dats from &:YMetwoR Ch,

file C:%Program Filez\wincaps2h Ra-0000% Ba-0000.spj
and, each data updated.

<Back [ Complete Care]

4.3.5 Write FD Images

» STEP 1

4-26

Data can be exchanged by using a floppy disk as the media between the
personal computer and the Robot Controller, instead of data transmission using
communication.

When recording data to a floppy disk, write the FD images.

Select Write FD Image from the Tools menu.

A dialogue appears requesting you to save the project. Click on Yes.
Save the data using the same method as selecting Save Project
command in the File menu.

i .SystemM anager E

@ To create FO data from the project being edited, you must save the project. Do pou want to save now?

Note: Always save the project data. If FD image is written without
saving the project data, the present state may not be written.
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» STEP 2

» STEP 3

Click on Next.

' FDTool ver 1.1.3

Fead data fram AWM etwnR

atid, each data updated.

<Hank |

file CAPROGRAR FILESWWINCAPS 241114 RA-0001 4 Ra-0001 . p|

Earize] I

Reference:
Back:
Next:
Cancel:

Select an optional system project.
Return to the initial screen.

Proceed to the write object data select screen.

End

Select the object data and click on Next.

Select data by attaching a check mark for the write object.

" FDTool ver 1.1.3

manager will become object.

- Object data
W2 program data <PAC Manager»
[ 1 Al variable data <% aniable Manager:
[ Al DO data <DI0 M anager:

1Al A data <A kanagern:

[ ] Al vizion data <Vision Manager:

| 1Al Log data <Log Manager:.

Select object data by manager. All the data managed by selected

Select all |

Cancel

Select All:
Back:
Next:
Cancel:

Select all object data for writing.

Return to the select screen of the system project.

Write to a floppy disk.
End
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» STEP 4

4-28

The following message appears requesting you to insert formatted

floppy disk. Insert a formatted floppy disk into the floppy drive and
click on OK.

v .FDTOOL
/"; inzert formatted disk.
1 Disk No. will be
[#1].

If the inserted floppy disk already has data on it, the system asks if itis OK to
delete it.

Clicking on Yes deletes the file on the floppy disk.
Clicking on No returns the display to the object data select screen.

+ FDTOOL

@ [01-2-139182604] Time stamp data already exists. OF. to delete?

If the floppy disk is neither inserted nor formatted, an error message
appears. Insert the correct disk and click on OK.

: FDTOOL :

& Either dizk iz not inzerted or formatted. Inzert the dizk.

Cancel | |

When the correct disk is inserted, the object data is read. Reading progress
is indicated with a bar graph.

W FDTool ver 1.1.3

All program data writing

ITFCMF.DAT

Bk ezt Cancsl




» STEP S

Chapter 4 System Manager

When data is written normally, an indication to that effect appears.
Click on Complete.

' FDTool ver 1.1.3

Wirabe data bo bW ehuoR Ch
Wwirite data time stamp becomes [07-2-139182604).

<Back |
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4.4 Window Menu

¥ |RA-0000 - System Manager !EI
File Tools | wWindow Help
[ BALC Manager
i
Sg%i. E Y ariable Manager
Ii DI0 Manager
w Arm M anager

Wizion b anager
LOG kanager

Fig. 4-20 Window Menu

4.4.1 PAC Manager

Start the PAC Program Manager.

The PAC Program Manager may be started by clicking on the PAC Program
Manager button ﬁiﬁl .

For details on the PAC Program Manager, read Chapter 5, “Operating PAC
Program Manager” and Chapter 3, subsection 3.5 “Entering and Editing
Program”, of this instruction manual.

When PAC Program Manager is connected to the Robot Controller, the button
icon display changes to i_@l .

4.4.2 Variable Manager

Start the Variable Manager.

The Variable Manager may be started by clicking on Variable Manager button
:

For details on the Variable Manager, refer to Chapter 6 “Operating Variable
Manager”. For operating procedures, refer to Chapter 3 “3.14.1 Starting Variable
Manager” in this manual.

While Variable Manager is connected to the Robot Controller, the button icon

display changes to .

4.4.3 DIO Manager

4-30

Start the DIO Manager.

The DIO Manager may be started by clicking on DIO Manager button gl .

For details on the DIO Manager, refer to Chapter 7 “Operating DIO Manager”.
For operating procedures, refer to Chapter 3 “3.13.1 Starting DIO Manager” in
this manual.

While DIO Manager is connected to the Robot Controller, the button icon display

changes to gl .
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4.4.4 Arm Manager

Start the Arm Manager.

The Arm Manager may be started by clicking on Arm Manager button ﬁl .

For details on the Arm Manager, refer to Chapter 8 “Operating Arm Manager”.
While the Arm Manager is connected to the Robot Controller, the button icon

display changes to @ .

4.4.5 Vision Manager

Start Vision Manager.

Vision Manager may be started by clicking on Vision Manager button @l .

For details on the Vision Manager, refer to Chapter 9 “Operating Vision
Manager”.

While Vision Manager is connected to the Robot Controller, the button icon
display changes to @l .

4.4.6 LOG Manager

Start LOG Manager.

LOG Manager may be started by clicking on the LOG Manager button .

For details on the LOG Manager, refer to Chapter 10 “Operating LOG Manager”.
While LOG Manager is connected to the Robot Controller, the button icon
display changes to .
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4.5 Help Menu

The Help menu provides useful information on how to use WINCAPSII.

¥ H5-E - System Manaeer M=l E3

File  Toolz  Window | Help

o License Information
A E]

avstem Extension
| Systern Manager | Stal About System Manager

Fig. 4-21 Help Menu

L
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4.5.1 License Key

Register the license key of your WINCAPS II. This registration allows you to use
all the WINCAPS Il functions.

Enter the User ID printed in the license card and click Add.

» STEP 1

Please enter pour icenze key,

Lieree o I xxxxxxxxxxxxxxx Add
Licenze key Bemove |

Ok I Cancel |

Confirm that the entered User ID is displayed in the license key list and
} STEP 2 then click OK.

Fleaze enter your licenze ken.

Licensze Fey |

Bemove |

Licenze key

0k Cancel
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4.5.2 System Extension

Even in WINCAPSII Version 1.9 or later, you may resist or delete optional
functions that the robot controller will use.

When WINCAPSII and the controller are in connection, select the “System
Extension” of the Help Menu. The System Extension screen appears.

System Extension
Fleaze enter 1D Mumber and click [Add] or [Remoyve] buthan.

10 Murnber : | Add |
System Extenzion 134737320 Bemove |
Cloze |

After inputting the specified ID Number, resist or delete the optional function by
pressing the “Add” or “Remove” button.

Examples of optional functions

Optional function ID No. Reference manual
Tip compliance control | 6519 | PROGRAMMER'S MANUAL Chapter 3
Supervisory task 1111 SETTING-UP MANUAL Chapter 3

4.5.3 About System Manager

Displays the version information of WINCAPSII on the screen.
Use this for verifying the WINCAPSII version for maintenance and other.

E About Yersion |

@ WNCAPS ||
' System Manager

YWersion 1.7.0-015

Warning: Thiz product iz protected by Japan Copyright Law and
International Agreement. Reproduction of whale or part of this
product ar digtribution of copies withaut written consent
cohstitutes violation of copyright.

Suztem Info...

Fig. 4-23 About System Manager
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Chapter 5
.

Operating PAC
Program Manager

This chapter describes how the PAC Program
Manager, within WINCAPSII software, functions
and is used by the personal computer teaching
system.







Chapter 5 Operating PAC Program Manager

5.1 Outline of PAC Program Manager

5.1.1 OQOutline of Functions

The PAC Program Manager is a comprehensive support tool for developing
structured robot language for the PAC program. In addition to general functions
of the text editor, the Program Manager enables you to create programs with
ease, using the PAC language command builder, program bank and other tools.
The PAC Program Manager starts when the System Manager % | button is
clicked on or from the Window menu.

Upon starting the PAC Program Manager, the PAC Manager window appears on
the screen.

Note: In RC7 Version 2.2 or later, a tree pane showing how the folders are
organized is newly added in the PAC Manager screen. Depending
upon the system version, the project configuration varies as shown
below.

RC5 PAC Manager window

17 C:A\WINCAPSIIABINYYS-0014¥5-001_ppj - PAC Manager

File Edit Program Actions Tools Help

leﬁlEl@llﬂl'ﬁ'l ICurrent j El @l

Tool bar

Mo |File [Modifiec | Program [Tiile
0| PROT000 pac 3/2/2000 £:40:58 PM PRO1000 <Tle>
1|PRO100T pac 3/2/2000 4:41:24 PM PRO1001 <Tile>
2IPROT00Z pac . :3/2/2000 44138 PM PRO1002 <Tille>
3
PAC V13D -
STRAN V132
[CABTNCAPETT B\ VE-00 ARD 1002 pac]
| |
\ \

File name registered

g Program name
to the project

Program name: Displays the program name registered to the project.

Program title: Displays the title information registered with TITLE statement in
the program.

Fig. 5-1 (1) PAC Manager Window
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RC7 PAC Manager window

21 C:\PROGRAM FILESYWINCAPS 2 DENSO0AWP-6242F\WP-6242F-P_ppj - PAC Manager

File Edit Folder Program Actions Tools Help

Dlﬁ’vlﬂl@l @l??l ICurrent 'l ﬁl @l

=68 VP-624IF Mo [File |Modified  [Program Title
=00 group_1 B 1|ArchMovepas 1171704103 ArchMaove ArchMove st
- eOand 9 2|MotionComp.pac | 1171704105 MotionCamp (Obtains the £
L SR 5 3|SetCycloidpac | 11/17/04 1057 SetCycloid cycroid oper
=00 sub 2 B 4|ResetCycloid.pac | 11717/0410: ResetCycloid Resets of cy
Ssub 21
LT sub_z 2
{:] group_2

w0 group_3 Program List pane

»
Compiling ... :I

PAC VZ2.2.00 4|

&

Tree pane: Displays how the folders are organized. The root of the tree

bears a project name.
Program List pane: Lists the programs contained in the selected folder.

Fig. 5-1 (2) PAC Manager Window

Note: [RC7 Ver. 2.2 or later]
Folder feature and Panel Designer

(1) The folder feature enables hierarchical management of user programs with
a directory structure. You can organize your programs into a set of
hierarchically structured folders by function or by type. This makes the
configuration of programs easy to understand and allows you to handle
programs on a folder basis, facilitating the use of existing programs for
development of other programs. For details, refer to the SETTING-UP
MANUAL, Section 3.2.5, "Folder Feature."

(2) WINCAPSII includes the Panel Designer, software for creating teach
pendant operating panel screen software. For details about the Panel
Designer, refer to the user's manual of "Teach Pendant Operating Panel
Editor, Panel Designer" separately issued.
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5.1.2 Tool Bar

NEW PROGRAM Button &

Newly registers the program to the project

ADD PROGRAM Button 2|

Adds an existing program to the project.

SAVE PROJECT Button H

Saves the state of all programs and projects currently being edited.

CREATE EXECUTION PROGRAM Button &

Creates a program in the executable format from the program registered to the
project.

SYNTAX CHECK button &

Checks the syntax of the selected program.

TRANSMIT Button =/

Transmits data between the Robot Controller and the personal computer.

SELECT ACTION OBJECT List [coren 3]

Selects the action object. The following are the action object types:

Current:  Action object for action in the currently selected program.

Project: Action object for action in all of the current programs.

Group: Action object for action in the current group program.

This function is designed for execution with all action object actions that have
selected items, other than CONNECT and STOP in the action menu.

Note: For the group setting, refer to Chapter 5 “5.2.5.4 Group” in this
manual.

STOP Button ]

Stops the creation of the execution program.

HELP Button </
Displays the descriptions of commands (COMMAND HELP).
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5.1.3 Basic Usage

The following illustrates the basic flow of the PAC Program Manager.
Figure 5-2 shows the monitoring program operation flow.
Figure 5-3 shows the program creation design flow.

Select a program that
you want to monitor.

Start monitor

l

Refer to “SELECT ACTION OBJECT List".

Refer to “5.6.4 Program Monitor”.

Fig. 5-2 PAC Program Manager Basic Usage (Monitor)
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Refer to “5.4.1 New”.

Add new program To renew a project, read “5.2.1
“New Project”.

\ 4

Program input Refer to “5.6.3 Command Builder”.

\4

A\ 4

Creating execution Refer to “5.2.8 Make Exec. Program”.
format file

l

Number of
errors =0

Transmit program Refer to “5.2.6 Transmit Project”.

y

For operation of the teach pendant,
Program start read “3.4 Auto Mode” in the SETTING-UP
MANUAL.

No

Fig. 5-3 PAC Program Manager Basic Usage (Design)
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5.1.4 File Management

Figure 5-4 illustrates the types of files that can be managed with the PAC
Program Manager. Descriptions of each file are given below:

Program
Manager

*-LNK

Program bank Make file Program project
file file

* PAC

Program file

+ RIC Intermediate

AN

* MAP * NIC | Execution

format file

Cross
reference file

Fig. 5-4 Files Managed with PAC Program Manager
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5.1.4.1 Program Project File (*.PPJ)

Program Project refers to a group of programs used simultaneously.

Only one program project can be opened at a time.

The Program project file saves the program source file reference information,
included in the program project.

The program project file extension is “.PPJ”.

The System Manager controls which program project to use with the currently
selected system project. The System Manager specifies which program project
file to use when it starts the program manager.

When the program project is changed with PAC Program Manager, data
concerning the System Manager program project file is automatically changed.

5.1.4.2 Program Source File (*.PAC)

Program Source File refers to the file used to save individual programs sources.
One program source file for each program source.

The file extension is “.PAC”.

One program source file may be registered to multiple program projects. In this
case, changing a program source file from a program project will affect other
projects.

5.1.4.3 Intermediate File (*.RIC)

A file that accommodates intermediate code is automatically generated when
converting a program to an executable.
The file extension is “.RIC”.

5.1.4.4 Program Bank File (*.BNK)

Saves the library programs to be used by the program bank.
One program bank file saves all the programs to be used in one library.
The file extension is “.BNK”.
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5.1.4.5 Executable File (*.NIC)

Accommodates format program data execution.
The file extension is “.NIC”.

5.1.4.6 Cross Reference File (*.MAP)

A file that accommodates cross reference is automatically generated when
converting a program into an executable.
The file extension is “.MAP”.

5.1.4.7 Make File (*.LNK)

A file that accommodates link information is automatically generated when
converting a program into an executable.
The file extension is “.LNK”.
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5.1.5 Menu List (PAC Program Manager)

The PAC Program Manager command menu has the following tree structure:

File
New Project (Programmer Level) *
Open Project (Programmer Level) *
Save Project
Save Project As (Programmer Level) *
Set Project
Transmit Project (Programmer Level)
Print
Make Exec. Program
Make Macro Definition File
Close

Edit
Undo
Cut
Copy
Paste
Delete
Select All
Search
Replace
Jump line No

Folder [RC7 Ver. 2.2 or later]
New
Rename
Release
Delete
Import

Program

New

Save

Save As

Add

Release

Check

Import

Export

Rearrange
File Name
File Date
Program Name

Use/No use [RC7 Ver. 2.2 or later]

Actions
Show
Hide
Stop

Tools
Options
Program Bank
Command Builder
Program Monitor
Panel Designer [RC7 Ver. 2.2 or later]

Help
About PAC Manager

Fig. 5-5 PAC Program Manager Menu Tree

* Displayed only when the display option file extension menu is checked. To set
the display option, first login again at Programmer level, then select Tool,
Options, and View and check the option file extension menu.
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5.2

5.2.1

5.2.2

5.2.3

5.2.4

5-10

File Menu (PAC Program Manager)

PAC Program Manager File menu is shown below:

1" C:AWINCAPS2Y\PROJECTARA-O0

|Eile Edit FProgram Actions Tool: H

Mew Project

Open Project..

Save Project

Sawve Project Asz...

Set Project...

Tranzfer Project... Chrl+T

Frint.... Ctrl+F

tdake Exec. Program

Make Macro Defintion File

LCloze

Fig. 5-6 File Menu

New Project (Programmer Level)

Create a new program project and simultaneously save it to the new program
project file.

Open Project (Programmer Level)

Select and open the program project file.

Save Project

Save the program project information currently under editing to the program
project by overwriting.
Clicking on the SAVE PROJECT button H| provides the same function.

Save Project As (Programmer Level)

Save the program project information currently under editing to the new program
project file. Optionally, name the new program project file to avoid redundancy.
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5.2.5 Set Project (Programmer Level)

Creates project settings.

Upon selecting Set Project from FILE menu, the Set Project dialog box appears.
Click on OK to register the change content. To erase the change content, click
on Cancel.

5.2.5.1 Document

Click the Document tab to enter the document name used when creating the
project.

& Set Project |

§nn“-“t§T Frogram TlnterpreterT Group TReIated File |

Title: |Palletizing

This project file was created by the FAC Wizard automatically. |-
todify the program name, wariable name, DID definition table or the
algorithrm if wou need.

[How to execute]

0. Editthe prograrm if vou need.

1. Create the excutahle file.

2. Transport all files.

3. Teach P50 1o PS5 using Pendant.

k. | Cancel

Fig. 5-7 Document Tab (Set Project) Dialog
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__________________________________________________________________________________________________________|
5.2.5.2 Program

Click the Program tab to set the variable parameters to be used by the project.
For details on the parameters, refer to “Appendix” in the PROGRAMMER'S

MANUAL 1.

& Set Project |

Cocument T EPrngra-ET InterpreterT Group T Related File |

Froperty =et Yalue
* 5
Approximate values comparing & 1000
Deletion of frace code

Deletion of cycle time calculation
Deletion of arrangement range c
Deletion of errar interrupt process

Language mode
* 1

—_ g O = O

Ik Cancel

Fig. 5-8 Program Tab (Set Project) Dialog

Note: The asterisks (*) under the property are the parameters of which
settings are prohibited because of the programmer level selected
when you log in to the WINCAPS II.
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5.2.5.3 Interpreter

Click the Interpreter tab to set the parameters to be used by the project
execution program.

Set the variable parameters to be used by the project. For details on the
parameters, refer to “Appendix” in Owner’'s Manual (Programming).

]|

Dl:uc:umentT Program TéllterpreterT Group TReIated File‘

& Set Project

Froperty =et Yalue
* 128
* 2hb
* 1
* 32
Continue/Festoration (0:No 1:Cor 1
Automatic position restoration 1
oafety stant mode(0:Enable 1:51o 0
Tirme far CheclkiTCi(=) B0

Ik Cancel

Fig. 5-9 Interpreter Tab (Set Project) Dialog

5.2.5.4 Group

Click the Group tab to group the programs.
After setting the groups, all the programs registered to the groups can be
handled as action objects.

&, Set Project [ x|
Docurnent T Prograrm T InterpreterT Group: I Related File |

| Group Name |Member
LGroup 0>
<Group 13
<Group 2
LGroup 3
<Group 4>
<Group 5>
<Group B>
LGroup 73

=
o

bt e Y g SN R T Y S Rl e

CIE Cancel

Fig. 5-10 Group Tab (Set Project) Dialog
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Set up the groups using the following procedures:
Register the group name.
> STEP 1 Input an optional group name.

Input the group members.

> STEP 2 Input the program names to be registered to the group.
Input a semi-colon at the end of each program name.
(Example) PRO1; PRO2; PRO3;

5.2.5.5 Related File

Click the Related File tab to register the include files of own creation or related
files, created with other application software here.

Registered files may be opened by double clicking. This automatically starts the
created application.

&, 5et Project E

Document T Program T InterpreterT Group Related |=i|||;

Related Eiles List:

Eelease

= |z
| M | ol
= o

Cgjzi
¥ Open using Special Text Editor

I, Cancel |

Fig. 5-11 Related File Tab (Set Project) Dialog Box

Add button: Adds a created file to the project.

Release button: Releases, from the project, files selected from the
Related File List.

New button: Creates a new file and starts the dedicated editor.

Open button: Opens the file selected from the Related File List. The

file may be opened by double-clicking.
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Chapter 5 Operating PAC Program Manager

If you put a checkmark at Open with Special Text Editor, the dedicated text
editor is used. If the application software used to create the file is not defined, the
file is opened with the normal editor.

F4 C:\Program Files\WINCAPS 24 RA-0000%nonamel txt [E[n] E3
EI| & || ﬁl

fidef ine Hode 1
Hdef ine Type 3

315 |CAPS |NTIM [N o

Fig. 5-12 Operation with Dedicated Editor

: Saves the file currently being edited.

= D

: Cuts out selected range data. Cut data can be used with the Paste
command.
The same operation can be accomplished with [Ctri]+[X].

i

: Copies selected range data. The copied data can be used with the Paste
command.
The same operation can be accomplished with [Ctrl]+[C].

: Pastes cut or memorized data by copying to a specified location.
The same operation can be accomplished with [Ctrl]+[V].

®
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5.2.6 Transmit Project

Program data may be transmitted or received only when the Robot Controller is
in connected communication state.

When the Transfer dialog box appears, select the data to be transmitted and
click on Transmit or Receive to send or receive data.

The same result can be achieved by clicking on the Transmit button _%?| .

~Local - ~Remaote
<Frogram Tahkle> Transmit> | | F Ve
«|nterpreter Tahle» . <Interpreter Table

< Fecerne
<Cross-reference Tt Executable
<Execution Frogram
AutoExec Lhlige VISTBL32
prog AUTOEXEC
pro select Al PRIO1T
I dio_tab.h TSFRO_500
lwar_tak.h T=sFRO_Z50
TSPRO_750 hd

Fig. 5-13 Transmit Dialog Box

Cautions: If maps or executable files are sent while Program List and
Select Variable Type screens are displayed, they will not be
loaded. Before sending projects, close Program List and
Select Variable Type screens.

™ & T 0 vsesmo | Joint WoTol 1z ™ & T 0 vsesme | doint HoTol 1z
Program List [No. of programs: 21
Dir:\ Select Yariable Type

P P
mPRO1 prol.pac Yes Yes Disabl A @ | A
[ PRO2 pro2..pac Yes Yes Disabl Integer. Float. Vector.  Pos.
[F11 [F2]1 [F31 [F4]1

& £

YarsUsed
Back | Next | Search | UpFolder| Display.| Config. ritey
Cancel: Close this window 1) Cancel: Close this window 1)

L ] A| NewProg.| Delete Copy | Yar. | Edit. | flux. | L ] A| Integer.| Float. Yector. Pos. | Joint.

5.2.6.1 Program/Interpreter Table

¢ Program table
Shows the project setting data described in “5.2.5.2 Program”.
o Interpreter table
Shows the project setting data described in “5.2.5.3 Interpreter”.
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5.2.6.2 Map/Executable Program

e Map File
This file is needed when you refer to the variables or the other data used in the
executable program.
The map file is referred to when the program is executed. Therefore, treat the
file in pair with the executable program.

¢ Executable Program
Program in the executable format created from the programs registered in the
project.

5.2.6.3 Program Source

e Source File
PAC program (*.PAC) needed for creating an executable program.
Your personal computer (remote side) displays all the PAC programs currently
stored in the Robot Controller, while the Controller (local side) displays all the
PAC programs registered in the project.

e Header File
This file is referred to by the PAC program (*.PAC). Specify the header file
name with the “4INCLUDE” statement in the program.
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5.2.7 Print

Prints the program list and the parameter table of the PAC Program Manager.

5.2.7.1  Print Object

The Print Manager dialog box appears on the screen. Select the Print Object tab.
Select the item to be printed and click on Print to print the specified data.

R Print Manager

Print DhjEEtT Option ]

Frinter in Canon LEBP-740 LIFS4

—Print Object |
{Flrl:“;“‘larrl} ................................................................................................... S E | E Ct A”

<Interpreters
<Project»
AutoExec
prod
prol

Frimnt Cancel == Set

Fig. 5-14 Print Object Tab (Print Manager) Dialog Box

e Select All: Selects all objects for printing at one time.

e Set: The printer data setting dialog appears. In this dialog, set the
required printing conditions.

e Preview: Enables viewing the printing state before actual printing.

e Cancel: Closes the dialog box without printing.

e Print: Prints the selected object.

Supplement: If you wish to print only the specified page, see preview

and click on the print button | £ .

Note: Preview is not usable if several objects are selected for printing.
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B2 <Program: M= E

3

FOC Mzmager LITE TR

“<Fingiomi* ; o filz oo - * poc_elb’

Tmzcrip Val e Maem [ -
o alirps | rmdla Tl P _prd_T 1
i oluspe F soishls 0 [P _i_Snch 1
0 alipps Drmohla s [P _i0_CEL 1
o ofuspe Waoichla 30 [P _H0_wES 1
0 alipps Fraickla 0 P _pir_FOS 1
i oluppe ] soichla | 0n P _pa_tuT [

m Tof1 3 I M I Ean-::ell %I’Iﬂﬁll Elusel Eafd Tatz

Fig. 5-15 Preview Window

4] »] : Moves the cursor to the top/end of the page.
il Ll . Moves the cursor to the preceding/following page.
@l . Selects the display size (Reduced/Standard/Expanded)

@l . Sets the printing conditions.
You can specify the printing range (in pages) of the object file.

Print

Frinter: Systemn Pnnter [Canan LEP-740 0K
LIPS 4) m
r Print Range i Cancel ;

Bat

' EIEages : Copies: I'I

| Erem: {1 To 41 I .

' ; - i . W Collate Copies

Fig. 5-16 Print Widow
B3| 2] : Exports the object file.

Outputs destination after converting to a specified file format.

Export

Format: Drestination;

Crictal Freports [EPT | | Disk file |

Ok i Cancel ;

Fig. 5-17 Export Window
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5.2.7.2  Option
Selecting the Option tab displays print options.

Frit Object | Option |

.....................

[ Frint Continuously
v Frint Line Mo,

Print Cancel Prewiew Set

Fig. 5-18 Option Tab (Print Manager) Dialog

¢ Print Continuously : When this box is checked, several programs are
continuously printed without change of page.

¢ Print Line No. : When this box is checked, the line numbers are also
printed.
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5.2.8 Make Exec. Program

Translates a program file, contained in the project, into an executable format.
Consecutively displays the state of execution to the message display.

The contents of errors generated during translation are displayed in the
message pane. Double-clicking on the error line in the message pane jumps the

display to the location of the error.
The same function is available by clicking on the Make Exec. Program button

=l

i C:\Program Files\WwWIMCAPS 241RA-0000%RA-0000.ppj - PAC Manager

Fil=  Edit Program Actions Tool: Help k
=] = =1 e B W=
Mo Filename Modification | Prograrm name State |Line No. | Cycle| Title

1) NG Tatalateg 31 5,/99 B:40; | AuloExec 0

1|proZ.pac 3899 2:30: pro? prog

2[prol.pac 318/99 2:33: prol prol

¥

FAC Y110 -
SLINE W11
[CAProgram FilesyWINCAPIATRA-000 T RA-D000.nic)

Message Pane
Fig. 5-19 Message Pane

Note: [RC7 Ver. 2.2 or later]

If a project contains an operating panel file, WINCAPSII automatically compiles
the operating panel file after translating it into an executable format. The
compilation result appears in the message pane in the same way as in earlier
version.

5.2.9 Make Macro Definition File

5.2.10 Close

This button allows you to create the header file that defines the parameter
numbers.

You can refer to the parameter values from the program using the defined macro
names.

e Macro definition file for interpreter: itp_cnf.h

¢ PAC definition file: pac_cnf.h

Ends the PAC Program Manager and closes the PAC Manager window.
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5.3 Edit Menu (PAC Program Manager)

This Edit menu functions as a standard editing menu, adopted from application
software for Windows 95. The editing object consists of character strings,
handled in the program editing window.

|£dit Program  Actons Too

Hnde ey
Cut Chrl+
Copy Ctrl+C
Paste Chrl+
Delete Drel
Select All

Search ... Ctrl+F
Replace... Ctrl+H

Jurnp line Ho.... Chrl+d

Fig. 5-20 Edit Menu

5.3.1 Undo
Cancels the previous operation and restored the initial state.

5.3.2 Cut
Cuts out selected range data. The cut data can be used with the PASTE
command.

5.3.3 Copy

Temporarily memorizes selected range data. The temporarily memorized data
can be used with the PASTE command.

5.3.4 Paste

Pastes the cut data or temporarily memorized data, by copying to a specified
location.

5.3.5 Delete

Deletes selected range data. The cut data cannot be used with the PASTE
command.

5.3.6 Select All

Selects all the data currently displayed in the active window.
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5.3.7 Search

When you select Search from the Edit menu, the Search dialog box appears on
the screen.

Specify the necessary items and click on Find Next. The specified character
string is then searched for.

The found character string is displayed in reverse video.

To close the dialog, click on Cancel.

i Search
Eind ‘What: [tove ~| | Find Mext
Object Search IWhDIe vl Cancel
" Eroject

& Current Program

" Selected Bange [ Match Cage

Fig. 5-21 Search Dialog Box

¢ Find What : Enter a character string that you want to search.

e Search : Specify the searching direction. If you select Whole, the
search is carried out downward to the bottom end and then
continued from the top of the data downward.

¢ Object : Select the searching range from whole project, current
program and selected range.
e Match Case . If this box is checked, a search is carried out with distinction

between upper and lower cases.
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5.3.8 Replace

This function replaces the specified character string with a separately specified
character string.

When the Replace dialog box appears, specify the necessary items and click on
Find Next. The found character string is displayed in reverse video.

Click on Replace, and the found character string is replaced.

If you click on Replace All, all the occurrences of the selected character string
will be replaced.

& Beplace
Eind What: [Mave ~| | Findhext |
Replace With: I j Cancel |
Object Search IWhDIe "I |
" Project Belace
& Current Frogram Feplace glll
i~ Selected Bange M jileiie s

Fig. 5-22 Replace Dialog Box

¢ Find What . Enter a character string to be searched.
¢ Replace with : Enter a character string to be replaced with.
e Search . Specify the searching direction. If you select Whole, the

search is carried out downward to the bottom end and
then continued from the top of the data downward.

¢ Object . Select the searching range from whole project, current
program and selected range.
e Match Cases . If this box is checked, the search is carried out with

distinction between upper and lower cases.

5.3.9 Jump To

Displays a specified line of a specified program.

When the Jumping Line No. dialog box appears on the screen, specify all
necessary items and click on GOTO. The specified program is displayed and the
cursor is set to the head of the specified line.

E Jumping Line No.
! Frogram MName: ;AutDExec _:;
Line Mo ;'I[Il
GOTO Cancel

Fig. 5-23 Jumping Line Number Dialog Box

e Program Name: When clicked on, the program file names appear in a
pulldown menu for selection.
e Line Number:  Input to specify a line number.
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5.4

5.4.1

5.4.2

5.4.3

5.4.4

5.4.5

Chapter 5 Operating PAC Program Manager

Folder menu [RC7 Ver. 2.2 or later]

The Folder menu is newly added as a special menu for handling the organization
of folders.

Right-clicking in the tree pane also displays the same Folder menu.

1" C:APROGRAM FILES\WINCAPS2 DENSO\WP-6242F\VP-6242F-P_ppj - PAC Manager

File  Edit | Folder Program Actions Toolz Help

0| | [coree =] 2]
Bename
Aeloase Mo |File |Modified  |Program Title
De-lete 6 1[ArchMove.pac T1A70410:2 Archhove Archhowe se
— g 2|k il A 107 MotionComp Obtains the <
P it iy  3|se] Folder menu 4105 SetCycloid cyoroid oper
Bl sub 8y  4|ReselCydodpac 11717704 107 ResetCycloid Resets of cy

Folder menu

New
This command creates a new folder under the selected folder.
There are the following restrictions on the creation of a new folder.
(1) Folder name: This must start with an alphanumeric character. The
length is a maximum of 16 characters.
(2) Depth of levels:  Up to 4, counting from the root of the project
(3) Number of folders: Up to 256
Rename
This command changes the name of the selected folder.
Release
This command erases the selected folder from the program list together with its
subordinate objects.
Note: This command erases only data from the project registry. Files remain
intact.
Delete
This command deletes the selected folder from the program list together with its
subordinate objects. It also deletes files.
Import

This command brings (imports) a folder under the selected one together with its
subordinate objects to add all of them into the program list.

Note: If importing a folder causes the number of levels to exceed four counting
from the project's root, the excess will be trimmed.
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5.5 Program Menu

Manages the program files.

Fromam Adfions  Todls
= % - - File Edit Folder | Program Actions Tools  Help
] Chrl+r 0l=
i =|Hl<
5 Chl+5
Save  Cuks CoveaE  owess. :
Save bs. Add Ciled hiove.pac ny
Beleaze & . 11/
Add Chil+0 Delete onComp.pac_|T1/
Cycloid pac 1174
Releaze Check etCycloid pac 117
Import Cirl+l
EhECk‘ Export Chil+E
: _ R »
|rmpart Citel+| | eAenee 7
Use/M L
Export Cirl+E e
Cotpiling ...
Rearrange »
[RC5 Ver. 1.9* or earlier] [RC7 Ver. 2.2 or later]

Fig. 5-24 Program Menu

5.5.1 New
Creates a new program file and adds it to the project.
A new file is added to the end of the PAC Program Manager file name list and the
Edit window automatically opens.
The same function is available by clicking on the new program button El .
Note: In RC7 Version 2.2 or later, a header file can be also created.

5.5.2 Save
Saves the selected program file.
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5.5.3 Save As

Chapter 5 Operating PAC Program Manager

Saves a program file with a new file name.
When the Save Project As dialog box appears, specify the path, program name
and click on Save to save the program.

Save Project As
Save in; i’Eﬂ Ira-0000

autoexec. pac

File name: || Save I
Save as ype: IF'AE progranl®. pac] j Cancel |

Fig. 5-25 Save Project As Dialog Box

Note:

To newly save the program, save the current content to a program
source file under a separate name. Update the program project
reference information so that is references the new program source file.
If retaining the program project reference information, as it was and
creating a file under a separate name, use Export. For details, refer to
Chapter 5 "5.5.9 Export" in this manual.

Note:

Full file path [RC7 Ver. 2.2 or later]

The folder feature added allows a program name to appear with a full
path. The program monitor and transfer screens, for example, display the
[folder name. program name]. However, the PAC Manager program list
pane displays program names only since it displays files in a selected
folder.
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5.5.4

3.5.5

5.5.6

5.5.7

5-28

Add
This function adds the existing program to the current project.
When the Adding program dialog box appears, specify the path, program name
and click on Open.
The same function is available by clicking on the add program button El .
When specifying several programs simultaneously, click on the files while
pressing the shift key or the control key.
Note: In RC7 Version 2.2 or later, selecting a root folder enables this function.
Adding program
Look in: ;Eﬂ Ira-0000
autoexec. pac
File name: || Open I
Files of bype: IP.J!'-.I: program(®. pac) j Cancel |
Fig. 5-26 Add Program Dialog Box
Note: When sharing one program among several program projects, use
the Add Program function. If the program is changed but you do not
want to affect other projects, use Import. For details, refer to
Chapter 5 “5.5.8 Import” in this manual.
Release

Releases the currently selected program file in the program project.

The program file remains as it is, but it is no longer contained in the project.
Reference information for the program is deleted from the program project
reference information.

Note: A project must have at least one program. It is not possible to
release all the programs.

Delete [RC7 Ver. 2.2 or later]

This command deletes the selected file from the program list and also deletes
the file itself.

Syntax Check

This button allows you to check the syntax of the selected program. If an error is
found, the message pane displays the error. Double-clicking the Error Line
makes the cursor jump to the corresponding error position.



5.5.8 Import

5.5.9 Export

Chapter 5 Operating PAC Program Manager

Registers a specified file name to the program project after copying it to the
folder in which the project is contained.
If imported, the program is not shared with other program projects.

Note: In RC7 Version 2.2 or later, a header file and operation panel file can be
also specified.

Note: When sharing one program among several program projects, use
the Add Program function. For details, refer to Chapter 5 “5.4.4
Add” in this manual. In this case, note that change of the shared
program in a project will affect the other projects.

Saves a selected program as a new program source file, under a specified file
name.

Note: In RC7 Version 2.2 or later, a header file and operation panel file can be
also specified.

Note: With export, program project reference information remains
unchanged and a separate file is created. When updating to refer to
a new program source file, use Save As. Refer to Chapter 5 “5.4.3
Save As” in this manual.

5.5.10 Rearrange

Changes the display order of program files in the file type.

This command provides the following choices--file name, file date, and program
name.

In the program list pane, files appear starting from PAC program files to header
files.

Actiohz Tool: Help

M ew Chrl+r
Save Ckil+5
Save s

Add Chrl+0
Releaze

Irpoit Ctrl+l
Expart Crl+E

File M ame
File [ ate
Program Marme

Fig. 5-27 Rearrange
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5.5.10.1 File Name

Rearranges the program files in order of file name; the file names are listed
according to the ASCII code.

5.5.10.2 File Date

Rearranges the program files in order of date; recently updated or created files
come to the top.

5.5.10.3 Program Name

Rearranges the program files in order of program name; the program names are
listed according to the ASCII code.

Note: When Rearrange is executed, the date check option is temporarily
turned OFF. This means all the source programs will be compiled

again when Compiling is executed. For details, refer to Chapter 5
“5.7.1.2 Make” in this manual.
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5.6 Actions Menu (PAC Program Manager)

5.6.1 Show

5.6.2 Hide

5.6.3 Stop

The Actions menu has the following commands. The tool bar of Program
Manager has the buttons that correspond to these commands and have the
same effect.

gctions Too
S by
Hide

Shop
Dlﬁ-lEl@l El'ﬁ'l ICurrent/, j ﬁ

Fig. 5-28 Action Menu and Buttons

Displays the edit window of the program selected from the Select action object
list.

The edit window also appears when you double-click on the program file name in
the list.

Closes the active edit window of the program selected from the Select action
object list.

The edit window is also closed when you click on the close box in the Edit
window.

Stops program creation specified by Make Exec. Program in the File menu.
When stopped in the middle, the message pane shows “Interrupted”.
The stop button €] has the same function as the Stop command.
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5.7 Tools Menu (PAC Program Manager)

5.7.1 Options

Used to set the operating conditions of PAC Program Manager.
After selecting Options from the Tools menu, the Options dialog box appears on
the screen.

Note: Items that can be edited differ by user level. For restrictions by user
level, refer to Chapter 1 “1.3 Security”. To change the access level
in the middle of program editing, refer to Chapter 4 “4.3.3 Re-Log
In” in this manual.
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5.7.1.1

Editor
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¥ Options |
_Editor | Make] Cowpiler | Display |
—Faont ~Tak
Eont Marme: IFiXEdSFS j Tak Interals: | 5
Size: |1 z "l
— Optian Switch
Calar W Program Jump
Fgregrgund: IEHE[CR j v Autormatic Cuick
Hirit
Background: IWhite j Automatic
v = .
Compiling
Ok Cancel
Fig. 5-30 Editor Tab (Options Dialog Box)
e Font Name: Specifies the font to use for text editing. Clicking on the
arrow =| displays the list of selection items.
o Size: Specifies the font size. Clicking on the arrow j displays

e Foreground:

e Background:

e Tab Intervals:

e Program Jump:

e Automatic Quick Hint:

e Automatic Compile:

the list of selection items.

Specifies the color of the foreground. Clicking on the
arrow =| displays the list of selection items.

Specifies the color of the background. Clicking on the
arrow =|displays the list of selection items.

Specifies the distance (in millimeters) from one tab
position to the next.

If you execute Search by Key in the File menu with this
option set at valid by specifying the program name or
label name, the specified program name or label name
is displayed.

With this option switch ON, a quick hint appears to help
your text input.

With this option switch ON, the Program Manager

automatically checks the syntax after the program is
stored.
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<Program name>

&) O[] &
"tTITLE “<{Title}" "*TITLE "'PRO1™
PROGRAM PROS PROGRAM PRO1
caLL [ITH TAKEARH
GOSUB =*LAST HMOUE P, P[pHome], 3=58
EHD SPEED 188

CALL dioWaitAndSet{ioParts, ioPartsnck)
*LAST: CALL pro2
RETURH SELECT CASE I[iPartsId]
CHSE -1

CALL dinSetAandWait{ioErrQR, ioErrqgl

CHEE 1
GOSUB *PlacePartshA bl
1| | o Ll_l
[3line [CAPS [NTIM s [1line [CADS [T S s 2
Execute Search by Key PRO1 Edit Window Appears

<Label name>

)

"fTITLE "{Title>" "TTITLE '{Title>"

PROGRAM PROS PROGRAM PROS
GALL PRD1 GALL PRO1
GOSUE GOSUB *LAST
END END
*LNST: =LnSTH
RETURH RETURH
[
[47ime [CATS [WTIM [1m5 4 [T line [CADE [ 111 [THs P
Execute Search by Key Shift to “*LAST.”

Fig. 5-31 Program Jump

T} C:\Program Files\WINCAPS 2\IRA-0000\prol .pac M= E3

'¢TITLE “prot”
#include “dio_tab.h*
#include "var tab.h"
FROGRAM proi

DEFART [CEFART <nterpolation method» [«Pass start displacements [«Depart lengthe [ <Wotion option» [LHNEXT]]

END

Quick hint

5 line | CAPS [ MM NS G

Fig. 5-32 Automatic Quick Hint
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5.7.1.2

Make
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Click the Make tab to set the conditions for execution program.

¥ Options

Editor | Make

—Execution Filenarme

| Compiler | Displayl

[CaINCAPS 2\ PROJECTYRA-DDODY RA-DD00 hic

— Option Switch

[ 52000
W Inspect Date Mame Tahle: | 2000
=T

~Takle Size
=ymbal Table: | 32000

Eearrangement | 15384
Takle:

0] | Cancel

Fig. 5-33 Make Tab (Options Dialog Box)

e Execution Filename: Specifies a file name when renaming the execution file.

¢ Date Inspection:

e Symbol Table:

e Name Table:

¢ Rearrange Table:

By default, a program project file name having the
extension “nic” is specified. If you do not wish to overwrite
this file or wish to unify all the projects in an executable file
name, change this value.

If this switch is checked, only the changed programs are
converted into execution form by depression of Make
Exec. Program, shortening the program creation time.
Sets the size of working range for storing information on
symbols.

Sets the size of working range for registering information
on names such as label name. This range is used to
register information on all names handled by the program
files included in the executable file.

Sets the size of working range for determining the
absolute addresses.
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If execution file is not specified

(default)
ira-0000.ppj — ira-0000.nic
If execution file is specified
ira-0000.ppj —) Speciied flls

Fig. 5-34 Option for Renaming an Executable File




5.7.1.3

Compiler

Chapter 5 Operating PAC Program Manager

Click the Compiler tab to Make settings for creating an execution program.

¥F Options

Editor | Make | Compiler | Display |

]|

— Dption Switch — Tahle Size
Block Takle: [ 100
Line Tahkle: IW
¥ Explicit Type Declaration 10 Tahle: |—5[|
¥ Inspect Constant Bange Dim Tahkle: IW
~ Dutput Code e et I@
0

140-Verl 4 | Name Table: | 500

0] | Cancel

Fig. 5-35 Compiler Tab (Options Dialog Box)

¢ Explicit Type Declaration: Error will occur unless local variables are

explicitly declared with a specification statement
or postfix. If this option is found invalid, without
explicit descriptions, it will be regarded as a
single accuracy variable.

¢ Inspect Constant Range: Checks the range of an argument with the

e Qutput Code:

¢ Block Table:

e Line Table:

¢ |O Table:

e Dim Table:

e Free Chain:

e Name Table:

statement described as constant when creating

the execution program.
Sets the software version of the robot controller. Depending
upon the version, the output codes of the execution program
will differ. If the version specified here is different from the
actual software version of the connected controller, an error will
occur at the time of communication.
Sets the size of working range for storing the nested state of
loops and conditional statement, etc.
Sets the size of working range for registering line information.
The numerical value of this table is equal to the number of all
the lines that can be compiled. The same value is equal to the
nest level allowed for compiling.
Sets the size of working range for registering information on 10
variables. The numerical value of this table is equal to the
number of defined IO variables.
Sets the size of working range for registering information on
array variables. The numerical value of this table is equal to the
number of array variables that can be defined.
Sets the size of working range for registering information
address link. This is the range used for solving label addresses,
jumping address of branch and loop commands, and global
variables.
Sets the size of working range for registering information
concerning label and other names. This is the range used for
registering information on reserved words and user-defined
labels, etc.
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5.7.1.4 Display (Programmer Level)
Makes the SHOW/HIDE settings of display options.

¥ Options |

Editurl I-.-Iakel Corupilet Displayl

e Cancel

Fig. 5-36 Display Tab (Options Dialog Box)

e File Expansion Menu: Used to extend FILE (F) menu of the PAC Program
Manager. For details, refer to Section 5.1.5, “Menu
List” in this chapter.

¢ Batch Transfer of PAC Programs:
This option allows you to select all the PAC programs
so that the project can be transferred at a time. To
transfer the programs one by one, set this check box
empty.

5.7.2 Program Bank

5.7.2.1 Outline of Functions

This is the function for registering or using a program as an individual part to
share a created program with other robot applications.

When you select Program Bank from the Tools menu, the Program bank dialog
box appears on the screen.
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Input character string of desired input

£% Program Bank -C:\WINCAPSIMBINAPacE ank1921 bnk

=& B& 8l R a2 &
} Program title
Eindwhat || 3 | I Name of program
IConventionaI langu vl Program Info |Argument Info | Documentl ngraml maker
as ;.,::|_|::| [- | N ond sol State the date
:foﬁn ange dram L8 =nd load setting // State the E-mail
nelApra Made by [DEMNSO wWiavE INCORPORATED W | address
ndDepa Date: // State the program name
ndink E-mail |- to be concatenated
nolJt Link Motdulo: =1l State the file name input
”gg”ﬁl AT DS || | to the program
rePuPos Include File:|cpacman.h> State the program name
—[|natC Call Program: N to be called in the
Select the program name ndTrang = N\ program
registered to the class ==

Fig. 5-37 Program Information - Program Bank Dialog Box

| Opens the registered program bank.

§| Saves a new library to the program bank. (Programmer Level)
ﬂ Adds a library to the project. (Programmer Level)

fl Registers a library to the program bank. (Programmer Level)
H Saves the current program bank. (Programmer Level)

ﬂ Deletes a registered program. (Programmer Level)

@l Registers a new class to the program bank. (Programmer Level)
@ Changes the registered class name. (Programmer Level)

@ Gets another program bank. (Programmer level)
|Conventional langu¥| Selects the class. For details on library program, refer to Part 2
“Command Reference” in the PROGRAMMER'S MANUAL.

&5 Program Bank -C:\WINCAPSIINBINVPacBank1921.bnk M=l E

=8 B@lalR a2 &l
Shows the
Find “What - s il
| [ [ Goeee argument type
Shows the argument name = H Program Info | A zamen 00 | Document | Prheram | used in the
in the selected program a ) Propery Argumeny[ault Valus selected
aspChange End load mass (q) 1 U program
ndAfin
ndhgra End load center of granity positio| 1 {
ndDepa End load center of grawvity positio | 1 N
nolink End load center of gravity positio] 1 \
nelJf —
i Shows the
naOnkl default
ng$gpos argument value
n .
ndTrang - in the selected
= program

Fig. 5-38 Argument Information - Program Bank Dialog Box
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5-40

Displays the
descriptions of the
selected program.
Writing enabled.

&5 Program Bank -C:AWINCAPSIIABIN\PacBank1921_bnk

=& @& al R »lE 3

Eind ‘what: |

ICDnventiDnaI Ianguj

LD

espChange

ncdAfin
nodApra
ndDepa
ndlnk
nd Jf
ndCnk
ndCnkal
ndPutFPos
ndTC

ndTrang =l

j SEErEh I

| Programl

Program Infol Argument Info

[Function]
End load setting

Format]
aspACLD (<End load mass>, <End load center

[Explanation]

This statement provides the equivalent func
Set the internal load acceleration for prog
set with this internal load acceleration.

FManmn dalf2osb2oel

K1 |

Fig. 5-39 Document — Program Bank Dialog Box

Shows the selected program. Writing enabled.

&5 Program Bank -C:AWINCAPSIIAEIN\PacB ank1921_bnk

z|&| BLlal R &% &

Eind ‘What: |

ICDnventiDnal Ianguj
aspACLD
aspChange
ndafin
ndApra
ndDepa
ndinb

ndJf
ndOnh
ndOnhl
ndPutPos
ndTC

ndTrang =l

Program Inful Arqument Info | Dogmert

"f*TITLE "End load Settind"

"*AUTHOR ""DEWZD WAUE IHCORPORATED™

"*ARG 1, "End load mass {g)", 1, 8"

'*ARE 2, "End load center of gravity positi
"?ARG 2, "End load center of gravity positi
'*ARE 4, "End load center of gravity positi
HINCLUDE {pacman.h>

ttpragma optimize{'ac", on)

PROGRAM aspACLD{myPl%, myX6%, my¥Yes, my26s)
LETENMU cnf3PD, 18, myPl

I FTERI nefORR W E

| | )

Fig. 5-40 Program — Program Bank Dialog Box




5.7.2.2

Chapter 5 Operating PAC Program Manager

Basic Usage

[1] Adding Libraries to a Project

» STEP1 |
» STEP2 |
» STEP 3

[2] Registering a Program to Program Bank

» STEP1 |
» STEP2 |
» STEP 3 |

Select a class.

Select a program.

Click on the & button.

STEP 3

&5 Program Bank -C:A\WINCAPSIIABINAPacB ~ak1921.bnk

STEP 2

2

STEP 1 Eindwhat ||

\lttmventional lang

aspChange
ndAdin

ndAgara

ndDepa

ndink

nelJf

ndCnl

ndOnkl

ndPutPos

ndTC

ndTrang =l

j Search I

Program Info |Argument Infa | Documeml Programl

Program Title |End load setting

Made by | DENS 0 WAVE INCORFORATED

Date

E-mail

Link Module

Include File <pacman.h>

Call Prograrm

Select a class.

Click on the £ button.

Select a program to be registered.
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Click on Register.

» STEP 4

STEP 2 STEP 1
%
Fined What /|/ ENEEEE |

ICDnventiun Ianguj Program Info IArgument Info | Document | Program|

=10 ]

aspACLD B
aspChange Program Tile[Enc Inad s=ting [
nclafin " Register Program <]
ndlink
ndlJ — Copy from
nclOnkb l—;l
ndOnbl Erogram W
nodPutFns .

1o,
ndTrang Iltleip )/ ‘
ndvcom
nefv o / ',
iz

_ [ Copyta
] %\Jameﬂ?unvemonal language ‘ )

Figaister I Cance| |

STEP 3 STEP 4

[3] Deleting Program Registered to Program Bank

> STEP 1 I Select a program to be deleted.
> STEP 2 I Click on the ﬁl button.
> STEP 3 Click on Yes.

STEP 2
& =10] x|
=| & 2L al R alwl
Fing What: | | |
Conventional langu x| Program Indo |Arg'umenl Info | Document | Program|
ndFutFas = :
ndTrang Fragram Title [oro1
ridveom
nchvch
ndvis
M @ [0 you want to delete prol?
nchhfv'SE
ndvput Na |
neivrst
nev/'zet e
ndv Type Qallkrugram:
\
/l \\
STEP 1
STEP 3
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5.7.2.3 Updating Program Bank

You can freely customize the program bank by adding or deleting programs.
However, the number of libraries, which is supplied to each version as a
standard, increases each time you upgrade the software version.

When you update WINCAPSII to a newer version, you need to import program
bank related contents customized in the old version into the newer one.
WINCAPSII Version 1.9 or later allows you to do it easily by providing the Auto
and Manual importing facilities.

If you use either of those facilities, WINCAPSII will unconditionally import class
libraries added or customized in the old version into the current program bank.

[1] Auto importing facility

» STEP 1

> STEP 2

When you open the program bank at the first time after updating WINCAPSII, the
Auto importing facility is executed. Even if you do not update the program bank
at this time, you can freely update it by the Manual importing facility.

If an old library is detected, the following massage appears.
When you want to update it, select the “Yes” button.

i .PacManager [ <]

The old library [C:APROGRAM FILE SYWW/IMCAPS 24PacB ank1728.bnk) was detected. Do pou want to merge with the
cuirent library 7

If the importing facility finds a class library that has the same name as
one already stored in the current program bank but has different
contents, then the following message appears, prompting you to
confirm overwriting.

If you want to use the old library, select the “Yes” button.

i .PacManager E

@ The contents of ClearSreManitor are different. Do you want to replace it ?

Tes
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[2] Manual importing facility

The manual importing facility is executed by clicking the “Merge Program Bank”
button.

> STEP 1 Click the & button on the tool bar of the program bank.

¢% Prorram Bank —G:¥PROGRAM FILES¥WING APS2¥PacBank1910.bnk

=|&| P al vl o B

“Merge Program Bank” button.

> STEP 2 The “Open Program Bank” screen appears/

Select the program bank that you want to merge.

Dpen Program Bank
Ll:u:ukjn:la Bin j | | EFl E
Cormpiler [ |Ipdate
Hs-e [FEPacE ank1 9012 brk
IR&M-DUMP PacBank1916.brk
Rabastar PacBank1317.brk
RaobotType PacBank1318.brk
S ample PacBank1921.brk
File name:  |PacBiank19012 bk Open |
Files of type: IF'rn:-gram Bank(® brik] =] Cancel |
o

If the importing facility finds a class library that has the same name as
> STEP 3 one already stored in the current program bank but has different

contents, then the following message appears, prompting you to
confirm overwriting.
If you want to use the old library, select the “Yes” button.

i+ _PacManager

@ The contents of ClearSrebdonitor are different. Do you want to replace it 7
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5.7.3 Command Builder

5.7.3.1 Outline of Functions

Select a class.

Select a command name

registered in the class

Assists correct input of commands and arguments, when making and/or editing
a program.

When you select the Command Builder from the Tools menu, the Command
Builder dialog box appears on the screen.

Enter an argument value used
in the selected program.

Argument name of the selected command

A Command Builder

ey \ele 1] g

Froperty setvalue
‘ariahble name 1
Arithmetic expression M +1

Fig. 5-41 Command Builder Dialog Box

£¢] Shows the previous class.
¥ Shows the next class.
ﬂCopies the set value of the selected argument to the clipboard.

@ Pastes the clipboard data at the Set Value.

]| Executes the program related by a LINK command in the USER PROGRAM
class.
Executes the program related by a respective command in the other class.
If no related program is found, clicking is invalid.

[/ Pastes the command selected in the class to the program being edited
& Displays the help data for command reference.
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5.7.3.2  Basic Usage

This section describes the method of editing program using the command
builder. The following is an example program line:

MOVE P, P1, S =50 MOVE PTP TO P1 AT 50% INSIDE SPEED

Move the cursor to a desired input position in the Program Edit

> STEP 1 | wniew

Open the command builder and select the Robot control statement

> STEP 2 I from the class selection list.

Select the MOVE command from the command list.
» STEP3 |
» STEP 4

Enter the argument values of the selected MOVE command as follows:

/' Command Builder

Faobot contral stath ilﬂ Elg EI_I @

eEe F’rn:upeny oetvalue
TLE%FQTUPT Interpolation method =
JDECEL Fose @0 P
JSFEED Fose @0 P2
M botion option 100
RESETAREA, MNE=T

ROTATE

ROTATEH

=SETAREA

CoEFEM ll

Click on the ﬂ] button.
> STEP 5 The command is entered in the cursor-located position of the program being
edited. (Enter comments from the keyboard.)

MOVE P, P1, S =50

5-46




Chapter 5 Operating PAC Program Manager

5.7.4 Program Monitor

5.7.4.1 Outline
This command monitors the execution progress of programs. As shown below,
the running step is displayed in red, helping you debug efficiently.

21 Monitor M=l E3
Fioject  Poogram  Action Tool
® ~ auTo ~ MNUSL ¢ TEACHCHECK 5T0P |
001 : ITITLE "PROOL" -
002 ; PROGRAM PROL
003
004 ;. Takearm
0os:  MOYE PP
006 :  MOWE P,P2
a7 . Givearm
0os
nno « ERIM LI

Erogranireses Eriariae Comtiner (5 | D |5|:|Ia_l,I """""" Hide
Il Step-sion Cyeleston B Stephact Stenfanand
[PROL | Lined v
Fig. 5-41-1 Monitor Window
5.74.2 Menu

The command menu of the Program Monitor is shown below.

Project

Program
Display
Hide

Actions

Tools
Settings

*1

*1 Menus exclusively prepared for vision equipment (uVision-21). In
WINCAPSII for standard robots, these menus cannot be selected.

5-47



5.7.4.3 Program menu
The Program menu of the Program Monitor is shown below.

Brogram  Acton Tool

Heset i
Ericrity k4
Gbartimeine
Dizplay Fi1
Hide Fl2

Fig. 5-41-2 Program Menu

Display/Hide: Displays or hides the contents of programs. If Display is
executed, the contents of a program selected in the program status list will
appear; if Hide, the program status list will appear.

5.7.4.4 Tool menu

The Tool menu of the Program Monitor is shown below.

T ool
Settngs. ..

Fig. 5-41-3 Tool Menu

Settings: Sets the operating environment of the program monitor. If Setting is
executed, the Settings window will appear.

Monitor tab: Sets the timer intervals at which the program monitor gets data
from the controller. The initial value is 1000 ms.

#F Settings K1
| Gener-ﬂl
—Dptions
Timer Intervals: '_JI _________ 1000) ms

] Cancel

Fig. 5-41-4 Settings Dialog Box (Monitor tab)

Note: If you set the monitor intervals short, the frequent communications
operations with the controller may load the Program Monitor. If the
Program Monitor cannot operate smoothly, set the monitor
intervals longer. (Recommended value: 1000 ms)
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General tab: Makes general settings for the Program Monitor.

EF Settings Ed

.............................

— atep-motion
[T Show message to make sure before programs running.

—honitar
¥ Getlastest data with the mode changes.

] Cancel

Fig. 5-41-5 Settings Dialog Box (General tab)

Step-motion: Determines whether or not the confirmation message will
appear before the execution of a program step.

Monitor: Determines whether or not the Program Monitor will get the latest
data stored in the controller every time the controller changes the mode.
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5.7.4.5 Operating procedure

This section describes how to monitor the program [PRO1].

Click a program ([PRO1] in this example) to be monitored by Program

> STEP 1 Monitor.

vz Monitor

Froject Program  Zcficn Toal

¥ || o © MANUAL ¢ TEACHCHECK STOP |

Friority

Mo Frogram | Status
PRO1
PROZ
PRO10

=

On halt
On halt

—a

Eragnamreset Eiarity [Fortimue Dizplay Hde

Hialt Steprsion [Enzle-ston T Stepact Step-fonmard

| 4

Fig. 5-41-6 Selecting a Program

Click the Display button to show the contents of the selected program.

> STEP 2 The running step is displayed in red.

w2 Monitor

Jrojest Program Achion Tool

M| e ¢ MANUAL ¢ TEACHCHELK 5TOP |

o1 : ITITLE "PROOL" -
002 @ PROGRAM PRO1
03

004 ;. Takearmn
nos:  MOWE P,P1
0o0c . MOVE PP2
o> . Givaarm

=
==y ;I
Erogranfesct Ericmit [Camtiue Hide
H &t Slep-stop [Epele-ston il Stepack Steptonmard
[PROI [Lme? v

Fig. 5-41-7 Displaying the Contents of the Program
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5.8 Help Menu

Use the Help menu to view descriptions on how to use WINCAPSII.

| Help

Lizenze Key

About Syztem bManager

Fig. 5-42 Help Menu

5.8.1 About PAC Manager

Displays the version information on PAC Program Manager.
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Manager

This chapter describes the Variable Manager
functions, in the WINCAPSII software, that may
be used with the personal computer teaching
system.







Chapter 6 Operating Variable Manager

6.1 Outline of Variable Manager

6.1.1 OQOutline of Functions

6.1.1.1

6.1.1.2

6.1.1.3

6.1.14

The Variable Manager provides variable data backups and monitoring functions
for the Robot Controller.

Through connection with the Arm Manager and/or the Vision Manager off-line
teaching is possible.

After starting the Variable Manager the Variable Manager window is displayed.

Tool bar Variable scope

[ﬁ C:\Program Files\WINCAPS 2\ RA-0000\IRA-DD0D0_var - Vanable Manager

File Edit Actions \[ools Help

ﬁ|m|ﬁ| fﬂ"l E-ll&l IlkGlmbalv/ariahIE} j

Type L | Type F| Type D] Type ¥ | Type P| TypeJ | Type T| Type s |

Mo YWalue |Usage |Macr|:|

L S N e =
[ R s R o R s Y e Y s - e |

[ 100 | A
Fig. 6-1 Variable Manager Window

Selecting Scope

Selects object variables from the variable scope list.

Global variables and local variables can be selected.

Note: Local variables can be selected only when WINCAPSII is online with the
robot controller.

Type I (Integer Type) Variables
Clicking on the Type | tab displays a list of Type | (Integer type) variables.

Type F (Single-precision Real Number Type) Variables

Clicking on the Type F tab displays a list of Type F (Single-precision real number
type) variables.

Type D (Double-precision Real Number Type) Variables

Clicking on the Type D tab displays a list of Type D (Double-precision real
number type) variables.
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6.1.1.5 Type V (Vector Type) Variables
Clicking on the Type V tab displays a list of Type V (Vector type) variables.

6.1.1.6 Type P (Position Type) Variables
Clicking on the Type P tab displays a list of Type P (Position type) variables.

6.1.1.7 Type J (Joint Type) Variables
Clicking on the Type J tab displays a list of Type J (Joint type) variables.

6.1.1.8 Type T (Homogeneous Conversion Type) Variables

Clicking on the Type T tab displays a list of Type T (Homogeneous conversion
type) variables.

6.1.1.9 Type S (Character String Type) Variables

Clicking on the Type S tab displays a list of Type S (Character String type)
variables.

6.1.1.10 Local Variables

If WINCAPSII is online with the robot controller, you may monitor and modify
local variables in each program by switching the scope of variables.
Note: For details, refer to the SETTING-UP MANUAL.

[ D:\HM-40702D'\HM-40702D_var - Yariable Manager

File Edit Actions Toolz Help
& @8l | 2l

Type I |Tw:|e F | Type O | Type v | Type P | Type 1 | Type T | Type 5 | Type 10

Narme Yalue |Refer

-]
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6.1.1.11 Folder Variables [RC7 Ver. 2.2 or later]

The Variables Manager monitors folder variables in the same way as local
variables.

Note: The name of a folder variable is preceded by [f:].

[l C:\PROGRAM FILES\WINCAPS2 DENSO\VP-6242F\YP-6242F -V var - ¥ariabl._. [H[=] E3

File Edit Actions Toolz Help

& =] = Bl W Scope of variables

Type I |Type F | Type D | Type v | Type P | Type ] | Type T | Type S | Type 10 |
Marne “alue | Refar
G1_L1 1
G1_L2 P
L T
fG1_F1 11 -
tG1_F? o0 Folder variables
fG1_F3 13
Y—
[1,1 I | y

6.1.2 Tool Bar

4| CONNECT button. For functions, refer to Chapter 6 “6.4.1 Connect” in this
manual.

SNAPSHOT button. For functions, refer to Chapter 6 “6.4.2 Snapshot” in this
manual.

MONITOR button. For functions, refer to Chapter 6 “6.4.3 Monitor” in this
manual.

El TRANSMIT button. For functions, refer to Chapter 6 “6.2.5 Transfer File” in
this manual.

Z| INPUT POSE button. For functions, refer to Chapter 6 “6.4.4 “Get Pose” in
this manual.

ﬂ MOVE button. For reference, refer to Chapter 6 “6.4.5 Move” in this manual.
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6.1.3 Basic Usage

When designing

Determine number Refer to Chapter 6 “6.1.3.1 Determining Number of
of variables Variables”.

Set application and
macro name of each
variable

Refer to Chapter 6 “6.1.1 Outline of Functions”.

Creating macro Refer to Chapter 6 “6.2.7 Create Macro Define File”.
definition file
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When monitoring

Connect to the Refer to Chapter 6 “6.4.1 Connect”.
Robot Controller

l

Select type and
range of variables to

monitor

Start monitoring

l

Change values as Refer to Chapter 6 “6.1.1 Outline of Functions”.
may be required

i

Refer to Chapter 6 “6.4.3 Monitor”.

Refer to Chapter 6 “6.4.3 Monitor”.
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6.1.3.1 Determining Number of Variables

You can change the number of variables in either of the following two methods:

B Setting with Pendant
Set the variable number with the pendant.
> STEP 1 For the data setting procedure, refer to the SETTING-UP MANUAL.

> STEP 2 Click on the connect button gf| in Variable Manager to establish a

connection, then click on the TRANSMIT button Elto display the
TRANSMIT dialogue on the screen.

@ Transfer Yariable Table

— Transfer Takle -
W< ors meger Type (15 SO

1 <Single Precision Real Mum

| | <Ciouble Frecision Real MNur

|1 <vector Type V>

|| <Position Type (Fi» Cancel

[ 1 <Jaint Type (>

| <Homogeneous Transfarme melect All

| | <Character String Twpe (3

< EEREkE

Select the variable object type and run.
> STEP 3 The number of variables in the Robot Controller and that in Variable
Manager should match.

B Setting with PAC Program Manager

You can set the number of variables by selecting [Tools], [Set], and [Variable] in
this order.
Refer to “6.5.1.2 Variables”.
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6.1.3.2 Editing Variables
[1] Editing Controller Variable Table
> STEP 1 Click on ﬁl button to establish a connection to the Robot Controller.

ﬁl button is displayed in the pressed state.

STEP 1 STEP 2

[ﬂ C:A\Program Files\WINCAPS25\BA-0000MBA-D000 var - Yanable Mana. .. !E[E

File Edf Actiome Tools Help

g ﬁl _I ’Ilﬁ‘l |<Glubaluar|able> j

Typel |T§.rpeF| TjrpeDl Type‘v’l TypePI Type.ll T}rpeTl TypeSI
Mo Walug _|Usage |Ma|:r|:|

[ I (O O L ) e B e
o R e B B L R e

[T 100 | S =

instan-taneously indicated from the Robot Controller.
The values of the Robot Controller variables are indicated in the grid.

> STEP 2 ICIick on button and acquire the variable information,

STEP 3 Select the variable grid you wish to change and input the new values.

[ﬂ C:\Program Files\WINCAPS2\RA-0000WRA-D000.var - Vanable Mana... [l[=] [E3
L"F\Ie Edit  Action: Tool: Help o
I_mlﬁl _I K:lr&‘l |<Glnbalvariable> j
Type! | Type F| Type I | Type V| Type P | TypeJ | Type T| Type 5 |
Mo walug |Usage |Ma|:r|:|
0 \ 2D
1 Z
2 3
3
4
5 a
1.1 100 [\ T
STEP 3
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[2] Editing Personal Computer Variable Table

> STEP 1 Click on ﬁl button to disconnect from the Robot Controller.

The button is shown expanded. At this time, the values of the variable table

currently being edited, by the personal computer, is displayed in the grid.

STEP 1

[ﬂ C:\Praogram Files\WINCAPS25BA-0000ABA-0000. var - Yanable Mana... !EIE

Eile Edit Action: Tools Help
- |m|ﬁ| _I K:lw&l |<Glnbalvariable> j
Type! | Type F| Type | Type V| Type P | TypeJ | Type T| Type & |

B IRT=] Yalus |Usage |Mau:ru:|
0 4;
1 ]
i b
3 a
4 a
5 ]
1,1 [ 100 | T |

> STEP 2 Select the variable grids to change and input the new values.

[ﬂ C:\Program Files\WINCAPS25RBA-0000ABA-0000. var - Yanable Mana... !EIE

Eile Edit Action: Tool: Help
Fﬂmlﬁl _I K:lw&l |<Glnbalvariable> j
Type! | Type F| Type | Type V| Type P | TypeJ | Type T| Type & |

B IRT=] Yalus |Usage |Mau:ru:|
3
|

o R s R B . R )
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[3] Transmitting Controller Variable Table

Change the values of the variable table on the personal computer, as
} STEP 1 I instructed to in Chapter 6, Section 6.1.3.2 [2] “Editing the Personal

Computer Variable Table” of this instruction manual.

Transmit the variable table from the personal computer to the Robot
} STEP 2 Controller according to the procedure described in Section 6.2.5

“Transfer File”. The values of the robot controller variable table

change to the new values that have been transmitted from the

personal computer.
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[4] Backing Up Controller Variable Table

» STEP 1 I

» STEP 2 |

values, received from the Robot Controller.

manual.

Receive the Robot Controller variable table, following the instructions
in Chapter 6, Section 6.2.5 “Transfer File” of this instruction manual.
The values of personal computer variable table change to the new

Save the personal computer variable table as a VAR file, following the
instructions in Chapter 6, Section 6.2.3 “Save File” of this instruction

-

6-10

- Variable Table Handling -

By using ﬁl button, select which grid to edit. The personal computer or the
controller? When the value of a grid changes, the content of the object variable
table changes. Pressing the monitor button displays the contents of the variable
table on the opposite end. (No change is enabled during monitoring.)

Data transmission between the personal computer and the controller is affected by
respective variable tables. Variable data, received by the personal computer, can
be saved as a “*.VAR’ file with “Save”. Existing data may be referenced with
“OPEN".

. 52RA-0000URA-0000.var - Varia
Monitor button

<Global varizble> ]
| Type V| TymeP | Typel| TypeT | Tymes |
Usege  |Macio

Tye | Type F| Type
Vel

| . Acquires data in T
succession

| . Acquires data for one s
time —

[ & : Selects connection ]
N T
Transmission
* VAR file Variable table Variable table
J N——
Personal computer Robot Controller

~




Chapter 6 Operating Variable Manager

6.1.4 Files to Be Managed

Figure 6-2 shows the file types managed by the Variable Manager. The following
sections explain each variable.

X

Variable
Manager

var_tab

Macro

Variable file definition file

Fig. 6-2 Files Managed by Variable Manager

6.1.4.1 Variable File (*.VAR)

The Variable file saves the variable information used for the program project.
Since a separate file is created for each project, respective variables can be
managed without any confusion, even if multiple program projects exist.

The file extension is “.VAR”.

6.1.4.2 Macro Definition File (var_tab.h)

This file contains variable macro names, by type and the variable numbers
corresponding definition.

The macro definition file is placed when the variable file, with extension (*.VAR).
The file name is “var_tab.h”.

To use a variable related macro from a PAC program, it is necessary to input this
macro definition file by using the #INCLUDE statement at the head of the
program.
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6.1.5 Menu List

The Variable Manager command menu has the following tree structure:

File
New (Programmer Level) *1
Open (Programmer Level) *1
Save
Save As (Programmer Level) *1
Transfer
Print
Make Macro Define File
Import Macro Define File
Close

Edit
Copy
Paste
Search on Grid

Actions
Connect
Snapshot
Monitor
Get Pose
Move

Tools
Options
RS232C Dummy Input
Calculator

Help
About Variable Manager

Fig. 6-3 Variable Manager Menu Tree

*1: Displayed only when the file extension display option menu is checked.
To set the display option, log-in again, at the programmer level. Select
Tools, Options, and View and check the optional file extension menu.
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6.2 File Menu (Variable Manager)

Variable Manager uses the VAR file (variable file) to save variable information
(variable table). The Variable Manager file menu is used for managing this VAR
file.

File Edit Action: Tool: Help

Mew

Open... Chrl+0
Save Chil+5
Save bz

irarEter,. (BT}
Frint... Chrl+FP

Make Macro Definition File
Impart Macra Definition File

Cloze

Fig. 6-4 File Menu

6.2.1 New (Programmer Level)

Creates variable information (variable table).

6.2.2 Open (Programmer Level)

Opens the existing VAR file.
Since the standard Windows dialogue box appears, select a VAR file to open,
click on [OPEN] to open the desired file.

Save As EHE
Sa'-.-'e_in:l'aha-l:ll:ll]l:l d I I'=_AF| IE%'

|RA-0000. var

File name:

Save I
Save az lype: I"...",-“.‘-.F: filef™ war) LI Cancel |

i

Fig. 6-5 Open Project Dialogue Box

6.2.3 Save

Saves the current state to the currently selected VAR file.
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6.2.4 Save As (Programmer Level)

Saves the variable information (variable table) to a new VAR file.
The standard Windows dialogue box appears. Select the path, input the file
name and click on SAVE to save data.

Save Az
Save in: | 3 Ir=-0000

IRA-0000. var

Save

File name:

Save &3 Wpe VAR file(* var) =] Cancel |

v

Fig. 6-6 Newly Saving File Dialogue Box

6.2.5 Transfer

When the communication with the Robot Controller is ON, the variable table data
may be transmitted or received.

The variable table refers to an array of variable data.

When the Transfer Variable Table dialogue appears on the screen, select the
respective variable types tables and click on either Transmit or Receive to
transmit data.

@ Transzfer Yariable Table Ei

— Transfer Table .
<Long Integer Type (> AL
<Single Precision Real Num PRy ——
<Double Precision Real Mur
Svector Type W)»

Cancel

<Faosiian Type (F)>
<Joint Type (3>

<Homogeneous Transforms select All
<Character String Type (5]

Fig. 6-7 Transfer Variable Table Dialogue Box
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6.2.6 Print

Prints variable tables for respective variable types.

6.2.6.1 Print Object

When the Print Manager dialogue box appears on the screen, select the Print
Object tab, select the table and click on Print to print the data.

B Print Manager E3

Print Object | Oplion |

Printer Canon LBP-430

— Print Ohject
U - Long integer tvpe (1)
1 - Single Precision Real NMumber Type (F)
2 - Double Precision Real Mumber Type (D)
3-%ector Type (V)
4 - Paosition Type (F)
5 - Joint Type (N
v b - Homogeneous Transformation Type (1) [j\\3
7 - Character Siring Type (3]

Select All |

Print Cancel | = = | Set |

Fig. 6-8 Print Object Tab (Print Manager Dialog Box)

e Select All: Selects all objects for printing simultaneously.

e Set: Displays the printer setting dialogue and makes various
settings for the printer.

e Preview: Allows the user to see the print format before actual printing.

e Cancel: Closes the dialogue box without printing.

e Print: Prints variable tables.

¢ Option: Displays printing options.

TIP: To print specified pages only, click the printer button |S after
previewing. You may specify the print range in the printing
preview.

Note: If you select more than one object to be printed, Preview is not
usable.
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E D - Long integer type [I] [_ (O] x|

Wariahk Managar augelnee?

0 - oAl Moo fils oo - o _wh b’

5

o

Valiz Taag= fazm

ceeecEe BB EE BB B

=l

1af3 [ 3 I b I Eancell. I I I Elnsel 100 af 100 Ttz

TN
LI
J

@LLL

&) gl

Export

Fig. 6-9 Preview Window

Moves to the head/tail end of the page.
Moves to the immediately preceding/following page.
Selects display (Reduction/Standard/Expansion)

Sets print execution
The printing range (specific pages) of an object file can be
specified.

Printer: Swztemn Printer [Canon LEP-730) 0k
Frirt B ange Cancel
(5 4| 3 pages

" Pages Copies: I 13:

Erom: | 1 Ta I 3 WV Caollate Copies

Fig. 6-10 Print Window

Exports the object file.
The selected object file will be converted into the file format
specified in Format and outputted (saved) to the Destination.

=]|

Farmat; Drestination

Character-separated values

| Disk file =l

(] I Cancel |

Fig. 6-11 Export Window
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6.2.6.2 Option
Selecting the Option tag will display the print options.

Note: Print option is not available from the Variable Manager.

6.2.7 Make Macro Define File

Create a “var_tab.h” file in the folder where the variable file (*.VAR) resides.

The “var_tab.h” file contains the variable macro name, listed by type and
information corresponding to variable numbers.

6.2.8 Import Macro Define File

Reads the macro definition file (var_tab.h) and expands in the "Use" and "Macro
Name" columns for each variable.

6.2.9 Close

Ends Variable Manager and closes the Variable Manager window.
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6.3 Edit Menu (Variable Manager)

= Action: Tool: Help

Copy Chrl+C
Pazte Crl+f

Search on Grid Clrl+G

Fig. 6-13 Edit Menu

6.3.1 Copy

Temporarily stores the same data as that in the selected range. Data
temporarily stored by copying can be used with the Paste command.

6.3.2 Paste

Pastes temporarily stored data by cutout or copying to a specified location.
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6.3.3 Search on Grid

Searches for a specified character string from an application field or macro name

field.

When the Search on Grid dialogue box appears on the screen, specify the
necessary items and click on Find Next. The line containing the found character
string is displayed in reverse.

e Search on Grid

Eind hat: ||

E32
Find MNext I

Field Name| Usage Field

[
j Cancel |

Ohject
o Al
" Selected Range

Search Im

[~ Watch Case

Fig. 6-14 Grid Search Dialogue Box

¢ Find What:
¢ Field Name:

e Search:

¢ Object:

e Match Case:

Enter a character string to be searched.

Select an object field to search from the application
field or macro name field.

Specify the direction of search. If All is selected,
searching is carried out downward until the end,
then it is continued from the beginning of the data.
Select the range to search, either All or selected
range.

If checked, upper case and lower case are
searched separately.

6-19



6.4 Actions Menu (Variable Manager)

The commands in this actions menu can be specified also with the buttons.

Actions Tools
v LConnect
S napshat
Moanitor | ::-I':l &l
Get Foze
Mave

Fig. 6-15 Actions Menu and Buttons

6.4.1 Connect

Establishes communication with the Robot Controller.

During connection with the Robot Controller, a checkmark appears in the menu.
£ button has the same function as the connect button. When connected, the
button is displayed in the pressed state.

6.4.2 Snapshot

Acquires variable data of the moment from the Robot Controller.
button has the same function as the snapshot command.
Set the communication conditions before executing the snapshot command.

6.4.3 Monitor

Acquires variable data in succession from the Robot Controller.

button has the same function as the monitor command.

Set the communication conditions before running the monitor command.

The personal computer acquires the data only of the variables displayed on the
screen from the Robot Controller during continuous monitoring, and does not
acquire the variable data not displayed on the screen. You can, therefore,
specify the data acquisition range by displaying the variables to be monitored.
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6.4.4 Get Pose

6.4.5 Move

With this command, the personal computer captures the current robot position
data from the Arm Manager to the currently selected variables of type P, J, or T.
(In the Variable Manager window, variable types and numbers are displayed in
reverse video.) If the Arm Manager is connected, you can obtain the actual robot
position.

Z| button has the same function as the Get Pos. command.

The values of the currently selected variable types P, J, and T are written to the
Arm Manager as the current robot position. (In the Variable Manager window,
variable types and numbers are displayed in reverse.) At this time, the robot
does not move to the specified position even if the Arm Manager is connected.
However, only the virtual arm of the Arm Manager moves to the specified
position.

#| button has the same function as the MOVE command.

Note: Arm Manager moves its imaginary arm in the continuous
monitoring state or when the Snapshot button is pressed.
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6.5 Tools Menu (Variable Manager)

6.5.1 Options

Used to set the operating conditions of Variable Manager.
When you select Options from the Tools menu, the Options dialogue box
appears on the screen.

Note: Items that can be edited differ by user level. For restrictions, by
user level, refer to Chapter “1.3 Security” in this manual.
For how to change the access level in the middle, refer to Chapter 4
“4.3.3 Re-Log In” in this manual.

6.5.1.1 Monitor

¥F Options

f‘l V:amable' D|3play|

~Option
|
Timet Intervals: ~ F 500 s

Ok | Cancel |

Fig. 6-16 Monitor Tab (Options Dialog Box)

e Timer intervals: Sets intervals of getting data from the monitor.
Default is 500 milliseconds.
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6.5.1.2  Variables (Programmer Level)

$E Options Ei

—Optian

Mo, of type | 100 Mo, of type T : I [
Mo, of tpe F: I 100 Mo, of twpe 5 I [

Mo, af type [ | Rl
Ma. of twpe ' I 0
Mo, of twpe P I 100

Mo, of type J 100

0] 4 | Cancel

Fig. 6-17 Variable Tab (Options Dialog Box)

o Click the variable tab to sets the number of variables for each type.

If you modify the number of variables, take the following procedure to bring the
modified result into the internal data of the robot.

Recompile the source file into the executable file.
> STEP 1 Refer to Section 5.2.8, "Make Exec. Program."

Transmit the Program Table, Execution Program Table, and
> STEP 2 Cross-reference Table to the robot controller.

Refer to Section 5.2.6, "Transmit a Project."

Loads the project from the teach pendant.
> STEP 3 Refer to the SETTING-UP MANUAL, Section 6.6, "Loading a project, [F6
Set]-[F1 Load!].
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6.5.1.3 Display (Programmer Level)

Click the display tab to set the display option for Show/Hide.
A display tab is indicated when the user level is higher than the programmer.

ﬂ- O ptions

......................

—Opfian
| 1 File Expanzion ke
Automatic refreshfdutomatic snapzhot)

(] | Cancel

Fig. 6-18 Display Tab (Options Dialog Box)

e File Expansion Menu: Used to extend FILE (F) menu of the PAC Program
Manager. For details, refer to Section 6.1.5, "Menu List”
in this chapter.

e Automatic refresh (Automatic snapshot): If selected, this option automatically
monitors the current status as a snapshop when the
communication gets linked or when you change the
window size during connection or scroll the screen.
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__________________________________________________________________________________________________________________|

6.5.2 RS232C Dummy Input

Note: To execute RS232C Dummy Input command, ensure the following
conditions are met:

e RoboTalk is set in RS232C.

e Each WINCAPSII manager is not connected. Since RS232C
Dummy Input command uses the RS232C port of the personal
computer. Therefore, if a Manager is connected to the Robot
Controller, an error will occur due to conflict.

The message entered in the dialogue box is transmitted to the Robot Controller
via RS232C.

Use this function when debugging the program.

If you execute RS232C Dummy Input command without connecting the robot,
the personal computer teaching system behaves as if it has transmitted the data
to the RS232C of Robot Controller.

You can choose a delimiter from between [CR+LF] and [CR] as an end code
attached to the output character string.

6.5.3 Calculator

Displays the standard Windows calculator. If the calculator is not installed, a
message reading “Could not find the file” appears on the screen.
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6.6 Help Menu

Descriptions on how to use WINCAPSII can be read by using the help menu.

Help

Lizenze ey

About Syztem Manager

Fig. 6-19 Help Menu

6.6.1 About Variable Manager

Displays the version information on Variable Manager.
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Chapter 7 Operating DIO Manager

7.1 Outline of DIO Manager

7.1.1 Outline of Functions

The DIO Manager can monitor 1/O status and/or manage the I/O layout table. In
addition, the program can be debugged prior to the completion of the facility to
test the program by adjusting Dummy SW ON or OFF to vary the /O state
falsely.

When the MONITOR SW is turned ON or OFF and the DIO Manager connected,
the status of an 1/O can be changed.

There are three methods for displaying I/Os: table, oscilloscope and panel. The
DIO Manager window appears on the screen when DIO Manager is started.
The DIO Manager can select a standard mode or conventional interchange
mode for I/O layout. For details, refer to 7.5.1.4 “Hardware”. For information
regarding the standard mode and conventional compatible mode for I/O layout,
refer to Chapter 5 the RC5 CONTROLLER INTERFACE MANUAL.

® C:AProgram Files\WINCAPS 25 BA-0000%BA-0000. dio - D10 Manager

File Edit Actions Tool Help
=] 9 [

Mo, | State |Type |U5age |Macru:u |MDnitD|Dﬁ
0|OFF | Systemninput | Step stop (all tasks) | SIN1 OFF O
1|OFF | Systeminput | <Reserved> SN2 OFF Ok
2|0OFF | System input  |Halt (all tasks) = 1K OFF O
3|OFF | System input | Strobe signal = IR OFF On
4|OFF  Systemninput | Interruption skip SIMG OFF OM
B|OFF | Swsteminput | Command data area o SING OFF Ok
B|OFF Swsterninput  Dataareal bt O (Gt S7 OFF  OF
J|OFF  Systeminput | Dataareal bit1 (8hit: SN JOFF OF
8| OFF  Systerninput | Dataareal bit 2 (8hit: S OFF OF
9|0FF  Systeminput |Dataareal bit3 (8hit: | SIN10 OFF OF

T01OFF Systeminput  Dataareal bit 4 (8hit: | SIMN11 OJFF |Okx
4] | 2

Fig. 7-1 DIO Manager Window

The following are the functions of the DIO Manager.
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7.1.2 Tool Bar

7-2

£| CONNECT button to make connection with the Robot Controller.

SNAPSHOT button to input the I/O status of the Robot Controller a single
time only.

MONITOR button to input the I/O status of the Robot Controller in
succession.

7] TRANSMIT button to either transmit or receive environmental table data.

91 DUMMY INPUT/OUTPUT button to select whether to use the dummy 1/O in
the Robot Controller. It selects the /0 number for which the DUMMY SW
grid is set to ON.

[ =] DISPLAY SELECT list for specifying the format of the I/O status
display.

i| RETURN button to select the preceding page when the number of I/Os to
monitor stretches over multiple pages.

il NEXT button to select the following page when the number of 1/Os to
monitor stretches over multiple pages.
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7.1.3 Table Item

# C:“\Program Files\WIMCAPS 2\ RA-0000%\BA-D000.dio - DI0 Manager

File Edt Actons Tool Help

£ 00| =] 2 e

Mo, | State |Type |Usaqe |Ma:ro |MonitD|Dﬂ
0|OFF | Systemn input | Step stop (all tasks) | SINT OFF 0O
1|0OFF  Systemn input | <Reserved> SIMZ OFF Ok
2|0OFF | Systeminput |Halt (all tasks) SIMGE OFF Ok
3|OFF | System input | Strobe signal Sir4 OFF Ok
J0OFF  Swsterninput | Interruption skip =1 OFF Ok
B|OFF  Swsterninput | Command data area o SING OFF Ok
B|OFF Systemninput  Data area 1 bit O (Bhat: | SIM7 OFF  OF
?|OFF  Systemninput |Dataarea bit1 (Bhit: SIMNG OFF OF
8|0OFF  Systerninput |Dataarea 1 bit 2 (Bhit: | SIN9 OFF | 0OF
9|0FF | Systemn input |Data area 1 bit 3 (Bhit: | SIN10 OFF OF

10|0OFF | Svsleminput | Dataarea 1 bitd (Bhit; SIM11 OFF Ok=
KN b
Fig. 7-2 Table Items

e Number: I/O layout number.

o State: Status of /0. In the MONITOR state, it indicates the status of the
Robot Controller 1/0 or the emulated I/O (memory) in the
personal computer. It is able to operate (ON-OFF) the Robot
Controller I/O or the emulated I/O in the personal computer
except when in the continuous monitor state.
In the connected state the Robot Controller I/O is the object of
action while in the disconnected state the emulated 1/O in the
personal computer is the object of action.

e Type: I/0O layout type. Display only and not for editing.

¢ Application: 1/O layout application. Can make entry as a comment. Double

e Macro name:

e Monitor SW:

e Dummy SW:

clicking enables entry.

I/0O layout macro name. Corresponds to the /O macro name and
the I/O number described in the macro definition file dio_tab.h.
Double clicking enables entry.

Specifies whether to monitor or not. Turns ON-OFF by double
clicking.

Specifies whether to use the actual I/0 of the Robot Controller or
the dummy SW (emulate memory). Turns ON-OFF by double
clicking. When turned ON the DUMMY SW (emulate memory) is
used. Unless the dummy I/O @4| button is set to ON, the Dummy
SW setting is not enabled.
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7.1.4 Basic Usage

When designing

DIO layout mode
setting

l

Setting of respective ) ]
I/O number application Refer to “7.1.1 Outline of Functions”.
and macro name

Creating Macro Refer to “7.2.7 Make Macro Define File”.
definition file

Refer to “7.5.1.4 Hardware”.
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When monitoring

Connect to Robot
Controller

l

Select variable type
and range to monitor

l

Select display format

l

Start monitoring

l

Change values as may
be needed

Chapter 7 Operating DIO Manager

Refer to “7.4.1 Connect”.

Refer to “7.4.3 Monitor”.

Refer to “7.4.5 Display Format”.

Refer to “7.4.3 Monitor”.

Refer to 7.1.1 “Outline of Functions”.
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7.1.5 Files to Be Managed

7.1.5.1

7.1.5.2

7.1.5.3

7-6

Fig. 7-3 shows the types of files managed by the DIO Manager:

X
DIO
Manager
3
dio_tab dio_cnf
*.DIO h h

DIO 1/O Distribution Configuration Macro
File Macro Definition Definition File

File

Fig. 7-3 Files Managed by DIO Manager

DIO File (*.DIO)

The DIO file saves I/O information used for the project.

Since a separate file is created for each project, respective 1/O information can
be managed without confusion even if multiple projects are involved.

The file name extension is “.DIO”.

I/0 Layout Macro Definition File (dio_tab.h)

This file contains definitions corresponding to I/O macro names and 1/O
numbers.

The 1/O layout macro definition file is located where the DIO file (*.DIO) is found.
The file name reads “dio_tab.h".

To render the 1/0O macro applicable from the PAC program, it is necessary to
input this macro definition file at the head of the program using #INCLUDE
statement.

Configuration Macro Definition File (dio_cnf.h)

Contains the macro definitions for the content of hardware settings.

The Configuration macro definition file is located where the system project file is
found.

The file name reads “dio_cnf.h”.




Chapter 7 Operating DIO Manager

7.1.6 Menu List (DIO Manager)

The DIO Manager command menu has the following tree structure:

File
New (Programmer Level) *1
Open (Programmer Level) *1
Save
Save As (Programmer Level) *1
Transfer
Print
Make Macro Define File
Import Macro Define File
Close

Edit
Copy
Paste
Find on Grid
Selected Range All ON
Selected Range All OFF

Actions
Connect
Snapshot
Monitor
Pseudo input/output
Display Style

Tools
Options
DIO Command Viewer

Help
About DIO Manager

Fig. 7-4 DIO Manager Menu Tree

*1: Displayed only when the file extension menu of the display option is
checked. To set the display option, (re) login on the Programmer level and
then select Tools, Options and View, and check the option file extension
menu.
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7.2 File Menu (DIO Manager)

The DIO Manager has the DIO files for saving I/O data. The File menu of DIO
Manager is used for managing the DIO files.

File Edit Actions Tool Help

Mew

Dpen... Chrl+0
Save Chrl+5
Save ba..

AR = [T}
Frint.... Chil+F

Make Macro Definition File
Import b acro Defintion File

Cloze

Fig. 7-5 File Menu

7.2.1 New (Programmer Level)

Creates new I/O information.

7.2.2 Open (Programmer Level)

Opens an existing DIO file.
When the standard Windows dialog box appears on the screen, select the DIO
file to open, and click on OPEN to open the file.

Opening file

Look in: | (3 Ir=-0000 =] &l e =

IRa.-0000.dio

File narme: Open

Files of type: [ DIO filef*.dic] =] Caricel |

i

Fig. 7-6 Open Project Dialog Box

7.2.3 Save

Saves the current status in the presently selected DIO file.
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7.2.4 Save As (Programmer Level)

Saves /O information to a new DIO file.
When standard Windows dialog box appears on the screen, select the path,
input file name, and click on SAVING to save the data.

Save As

Sawe jr: | 3 Ir>-0000 =] jGN=11E

IR-0000.dio

A-00010 Save I
Save as type: | DIO filef* dio] | Cancel |
%

Fig. 7-7 New File Save Dialog Box

File name:

7.2.5 Transfer

When the Robot Controller is connected for communication, it is capable of
transmitting or receiving the environmental table data.

The environmental table refers to an array of data the robot needs to operate.
When the Transfer Environment Table dialog appears on the screen, select the
table and click on either Transfer or Receive to transmit data.

@ Transfer Environment Table E

— Transfer Takle
<Hardware Settings>

< Beceive

Cancel

select All

'S
i

Fig. 7-8 Transfer Environment Table Dialog Box

Hardware setting: Setting various parameters needed for DIO operation.

If this content is changed, press either Transfer or Receive so as to share the
same data between WINCAPSII and the controller. After data transmission from
WINCAPSII to the controller, restart the controller.
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7.2.6 Print

Prints the DIO Manager environment table and I/O layout table.

7.2.6.1 Print Object

When the Print Manager dialog box appears on the screen, select the Print
Object tab, the table, and then click on Print to print the data.

!_., Print Manager

Print Object | Option |
Printer Canoh LBF-430

SelectAll |

i L,
|1 <Harchwvare Setings>

Frint Cancel Frawiew ot

Fig. 7-9 Print Object Tab Print Manager Dialog Box

e Select All: Selects all objects for printing.

o Set: Displays the printer set dialogue and makes various printer
settings.

e Preview: Enables the user to see the print before starting the print job.

e Cancel: Closes the dialog box without printing.

e Print: Starts printing.

¢ Option tab The printing option setting sheet appears.

TIP: If you wish to print only the specified page, see preview and click
on the print button |& .

Note: If you select more than one object to be printed, Preview is not
usable.
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R <Hardware Settings> O] %]

5

0K Managar LITHIT S

<hodwas Saung : Mioan fil oo - *dia_ea b’

Progzrir Valaz friacm Aeomalerd
Allocainn cod= (1,2 Comgobls, 1,3 Sundad) T_ASIRHT
Fanr b rdd, | Vaid) ¥ _FARTTY

[
1

Hmd 10 inwawpunn 3aung [ ardid, | Vaid] | | w_HD_EaaLen

Dricei¥ o ol inpudalon 8 | 10_Dow_w_sLar

Dy 40 ofouigusalow 7 | wo_oi_ouT_sLar

Dicriceiin._progominn cim [ volid, | Vahd) | | ™0 D EMERRCHE

EII 1of1 [ 3 I P I Eancell %Iﬂlﬂﬁll Clusel Eofd Tote

Fig. 7-10 Preview Window

ﬂl Moves to the head/tail end of the page.
LI . Moves to the immediately preceding/following page.
. Selects display (Reduction/Standard/Expansion)

Sets print execution
The printing range (specific pages) of an object file can be specified.

B~ =

Print |
Prirter: Spztem Printer [Canon LBP-730)
Print Range Lancel |

" Pages Copies; I 13:

Eram: | 10 Tao I 3 ¥ Collate Copies

Fig. 7-11 Print Window
B3| &0l :  Exports the object file.

The selected object file will be converted into the file format
specified in Format and outputted (saved) to the Destination.

Export E1

Format; Drestination;

| Disk file =l

Character-separated values

ak. I Cancel |

Fig. 7-12 Export Window
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7.2.6.2 Option
Selecting the Option tag will display the print options.

Note: Print option is not available from the Variable Manager.

7.2.7 Make Macro Define File

Create a "dio_tab.h" file in the folder where the DIO file (*.DIO) resides.

The "dio_tab.h" file contains the I/O numbers and macro name information.

7.2.8 Import Macro Define File

Reads the macro definition file (dio_tab.h) and expands in the "Use" and "Macro
Name" columns on the screen.

7.2.9 Close

Ends DIO Manager and closes the DIO Manager window.
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7.3

7.3.1

7.3.2

Edit Menu (DIO Manager)

Copy

Paste

=l Action: Tool Help

Copy Chrl+C
Paszt Chrl+td
Find on Grid Cl+G |

Selected Range All OM
Selected Range All OFE

Fig. 7-14 Edit Menu

Temporarily stores a specified range of data. Data temporarily stored by copying
can be used by the Paste command.

Pastes the temporarily stored data by cutting or copying to a specified location.
This operation is enabled in the “Application” and “Macro name” fields only.
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7.3.3 Search on Grid

7-14

Searches for a specified character string from either the application or macro
name field.

When the SEARCH ON GRID dialog box appears on the screen, specify the
necessary items and click on FIND NEXT. The line containing a found character
string is displayed in reverse video.

i Search on Grid

Find What | ~| | Findnext |

Field NamelUsage Field j Cancel |
Ohject Search Im

Al
¢ Selected Range [ tatch Caze

Fig. 7-15 Search on Grid Dialog Box

¢ Find What: Enter a desired character string to be
searched.

¢ Field Name: Choose the searching object field from
between Usage Field and Macro Field.

e Search: Specify the searching direction. If Whole
is selected, the search is made downward
to the end, and then the search restarts
from the beginning of the data downward.

¢ Object: Choose the searching range from between
all and just a selected range.

e Match Case: If this box is checked, search is made with
distinction between upper and lower
cases.
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7.3.4 Selected Range All ON

Multiple monitor and dummy switches may be selected and turned ON
simultaneously.

As Fig. 7-12 shows, first select the I1/O number of the desired item (monitor or
dummy switch), then select Selected Range All ON. The menu content can be
more easily displayed by clicking the right button of the mouse to select the
command as shown below.

|rv1|:|nit|:|rSW ||:ilurr1m3.f =

OFF ON

OFF ON

= Copy Chrl+C
Past Chrl+4f
OFF

OFF Search on Grid Chrl+G
OFF Selected Fange Al OM h
OFF Selected Bange A OFF

OFF OFF e

Fig. 7-16 Selected Range All ON

7.3.5 Selected Range All OFF

Multiple monitor switches and dummy switches may be selected and turned OFF
simultaneously.

As Fig. 7-13 shows, first select the I/O number of a desired item (monitor switch
or dummy switch). Then select Selected Range All OFF. The menu content can
be more easily displayed by clocking the right button of the mouse to select the
command as shown below.

JMDHITDI’SW |Dummy S .a
OFF

Copy Chrl+C
JFF
- Fast Chrl+
OFF Bl
OFF Il Search on Grd Chil+G
OFF o

Selected B ange Al DN
OFF OM Selected Fange All OFF

QOFF OFF T

Fig. 7-17 Selected Range All OFF
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7.4 Actions Menu (DIO Manager)

The Actions menu commands are also issued by depression of the tool buttons.

m Tool Help

LCaonnect
Shapshat
Fd anitar

Pzeudo input/output

v Table
Dzcillozcope
Panel

oo @l 7 = e«

Fig. 7-18 Action Menu and Buttons

7.4.1 Connect

Connects the communication line with the Robot Controller.

When connected, check mark is attached to the menu.

£ button works the same as the Connect command. When connected it is
displayed as if depressed.

7.4.2 Snapshot

Acquires the data of the moment from the Robot Controller.

button has the same function as the Snapshot command.

Before executing the Snapshot command, ensure that the Manager is
connected with the Robot Controller.
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7.4.3 Monitor

Acquires data in succession from the Robot Controller.

button has the same function as the Monitor command.

Before executing the Monitor command, ensure that the Manager is connected
with the Robot Controller.

During monitoring, the DIO Manager acquires the data only of I/O numbers
displayed on the screen from the Robot Controller, and does not acquire the 1/0
number data not displayed on the screen. You can, therefore, specify the data
acquisition range by displaying the 1/0 numbers to be monitored.

Monitor intervals can be set with the timer intervals. Refer to “7.5.1.1 Monitor”.

7.4.4 Pseudo input/output

To emulate (dummy input/output) the state in the Robot Controller, false I/Os are
provided in the Robot Controller in addition to the actual 1/Os. Selection of the
actual versus false I/Os can be specified for each port by turning the Dummy SW
grid of the table display ON-OFF.

When the Dummy input/output button 81 is turned ON, every port with the
Dummy SW grid set to ON will function as a dummy I/O.

If the button g} is turned OFF, all the I/O signals are activated as the actual I/O

signals irrespective of the setting of the Dummy SW grid in the table.
Valid setting range of dummy 1I/Os is as follows:
Standard mode
34-55, 552-575+(DeviceNet input slot number-8)x8
Interchange mode
21-55, 536-559+(DeviceNet input slot number-8)x8

Note: DeviceNet input slot number may be referred to with the hardware.
If DeviceNet is not installed, the range will be only 34-55 (Standard
mode) or 21-55 (Interchange mode).

7.4.5 Display Format
m Tool Help

Conkect
Shapshat
M onitar

Pzeudo inputdoutput

Dizplay Stule 4 v Table
Qzcillozcope
Farel

Fig. 7-19 Display Format Menu

The DIO Manager has three methods for displaying I/O statuses.
Select Display Style from Actions menu, and the three display styles appear on
the right: Table, Oscilloscope, and Panel. Select a required one.

You can also select the display style by clicking on Display selection list
[ =l and displaying the pull-down menu.
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7.4.5.1 Table

When you select the table type display, the 1/O states are displayed in the table
type as shown in the list.

® C-\Program Files\WINCAPS 2AIRA-DDODNRA-0000_dio - DIO Manager
Fil=  Edit Actions Tool Help
S BY [o-Tawie 5[ %] ¥
Mo, [ State ‘Type |Usage |Iv1a|:ru |MDm10r‘Dumﬂ
DIOFF  iSwsteminput | Step stop (alllasks) | ST OFF  OM
1|OFF  System input | <Reserved> SNz DOFF 0N
2|OFF  System input | Halt (all tasks) SIMN3 OFF 0N
3|OFF  Systern input | Strobe signal SiN4 OFF O
4|OFF  Swystern input | Interruption skip SING OFF O
5|OFF  Swystern input | Command data area o] SING OFF 0N
B|OFF  Systern input | Dataarea hit 0 (8hit: | SINT OFF  OFF
?|OFF  Systern input |Dataareal bit1 (8hit: | SIMNG OFF  OFF
8| OFF  Systern input | Data area? hit 2 (8hit: | SIN9 OFF  OFF
9|OFF  Systern input | Data areal bit 3 (8hit: | SINI0 OFF  OFF
10{OFF  System input | Dataarea bit 4 (Bhit: | SINTT OFF  ON o

Fig. 7-20 Table Display (DIO Manager) Window

In the table type display, I/Os are displayed in different colors depending on the
classification group. Tables 7-1 and 7-2 outline the colors and classifications in
the standard mode and compatible mode for the conventional type.
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Table 7-1 1/0 Colors and Classifications (Standard Mode)

Classification | Color | Delimit | Layout Name Macro Remarks
Standard input | White 0 0 | System SINxx (Robot stop and Enable Auto
(64 points) input are excluded.)
33 (34 points)
34 | Userinput | UINxx
47 45 (12 points) | (No. 46 and 47 are missing.)
48 48 | Hand HINxx
input
55 55 (8 points) No. 55 for interruptive
detection of disconnection
56 56 | (Missing Missing
number) number
63 63
Standard output | Pink 64 64 | Hand HOUTxx
) output -
(64 points) 71 71 (8 points)
72 72 | System SOUTxx
tput
103 | O (32 points)
104 | User UOUTxx
output
127 127 (24 points)
Internal 1/0 Yellow 128 128 | Internal ITIOxx
1/0
(384 points) 511 511 (384 points)
DeviceNet input | Green 512 512 | System DSINxx SINxx (517 and 518 are
(256 points) input missing.)
551 547 (34 points) | (548 to 551 are missing.)
552 552 | User DUINxx Extensible in unit of 8 points
input
767 767 (216 points) | Default: 24 points
DeviceNet Blue 768 769 | System DSOUTxx SOUTxx
output output
(256 points) 799 1246 (31 points) | (No. 768 CPU is normally
missing.)
800 800 | User DUOUTxx Extensible in unit of 8 ports
output
1023 1023 (224 points) | Default: 24 points
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Table 7-2 1/0 Colors and Classifications (Previous Model — compatible Mode)

Classification | Color | Delimit | Layout Name Macro Remarks
Standard input | White 0 0 | System SINxx (Robot stop and Enable Auto
(64 points) input are excluded.)
33 (21 points)
34 | Userinput| UNIxx
47 45 (25 points) | (No. 46 and 47 are missing.)
48 48 | Hand HINxx
input
55 55 (8 points) No. 55 for interruptive
detection of disconnection
56 56 | (Missing Missing
number) number
63 63
Standard output | Pink 64 64 | Hand HOUTxx
output
(64 points) 71 71 (8 points)
72 72 | System SOUTxx
tput
103 | OPY (32 points)
104 | User UOUTxx
output
127 127 (24 points)
Internal 1/0 Yellow 128 128 | Internal ITIOxx
1/0
(384 points) 511 511 (384 points)
DeviceNet input | Green 512 512 | System DSINxx SINxx (517 and 519 are
. input missing.)
(256 points)
535 534 (21 points) | (535 is missing.)
536 536 | User DUINxx Extensible in unit of 8 points
input
767 767 (232 points) | Default: 24 points
DeviceNet Blue 768 769 | System DSOUTxx SOUTxx
output output
(256 points) 799 1246 (31 points) | (No. 768 CPU is normally
missing.)
800 800 | User DUOUTxx Extensible in unit of 8 ports
output
1023 1023 (224 points) | Default: 24 points
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7.4.5.2  Oscilloscope

Upon selecting the oscilloscope display type, the 1/O statuses are displayed in
graphical form as on an oscilloscope.

When displayed in the table type, turn the Monitor SW grid of the desired 1/0
display to ON.

The maximum number of I/Os that can be displayed simultaneously is 8.
Clicking the Return button #] or Next button #] scrolls the list by one page.

€ C:\Progriam Files\wincaps24RA-0000MEA-0000. dio - DID Manager
FEile Edit Actions Tool Help

A e -C

Fig. 7-21 Oscilloscope Display (DIO Manager)
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7.4.5.3

7-22

Panel

Upon selecting the panel display type, the I/O states are displayed in panel.
When displayed in the table type, turn the Monitor SW grid of the desired 1/0
display to ON.

The maximum number of I/Os that can be displayed simultaneously is 32.
Clicking on the Return button ﬂ or Next button i| scrolls the list by one page.

® C:\Program Files\wincapz2%\RA-DD00ARA-0000_dio - . =] B3

File Edit Action: Tool Help

g | e

[ ik [] uing [] HiM3 [] HouT3
[] iz [] Uirto [] HiN4 [] HouT4
[ uinz [ Uik [] HirE [] HouTs
[ wir4 [ vtz [ HiNg [] HoUTs
[] wins [] no4e [] HiM7 [] HouT?
[] Wi [] no47 [] HiMa [] HouTs
[ iz [ Hirn [] HouT  [] souUTt
[ wia [] Hirz [] HouTz  [] souT?
[0 [0

Fig. 7-22 Panel Display (DIO Manager) Window
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7.5 Tools Menu (DIO Manager)

7.5.1 Options

Makes various types of settings needed for the DIO Manager.

Upon selecting Options from the Tools menu, the Options dialog box appears on
the screen. Clicking the tab enables each item to be set.

Checking Create Header File creates the configuration macro definition file
(dio_cnf.h). The dio_cnf.h file contains the macro definition information for
hardware settings.

Note: The items that can be edited differ depending on the user level. For
restrictions by user level refer to 1.3 “Security”. For information on
how to change the access level, refer to 4.3.3 “Re-Log In”.

7.5.1.1 Monitor

-ﬁ.} Ophons E
~ Dption
[
TimerIntereal = 500) ms

k. Cancel

Fig. 7-23 Monitor Tab (Options) Dialog Box

e Timer intervals: Sets the intervals for acquiring data through continuous
monitoring. Default is 500 msec.
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7.5.1.2  Oscilloscope

ZE Options Ed
| Panell Hardwarel M—DNEt| Displa_f;.:'l
—DOrawing Calor
Background Color: IEHEM:R j
Scale Colaor: IDark gray j
beasured Yalue Caolor: IWhite j
k. Cancel

Fig. 7-24 Oscilloscope Tab (Options) Dialog Box

e Background: Specify the background color of the oscilloscope.
e Scale color: Specify the scale color of the oscilloscope.
e Measured: Specify the color of measured values in the
oscilloscope.
7.5.1.3 Panel
-IiI- Options E3
Ml:unitl:ur| Oscilloscope | | Hardwarel M—DI‘Jet| Displayl
— Drawing Calor
Color at OFFE: IDarI-: gray j
OF. Cancel

Fig. 7-25 Panel Tab (Options) dialog Box

e Color at ON: Specify the color at ON in the panel display.
e Color at OFF: Specify the color at OFF in the panel display.
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7.5.1.4 Hardware

Click the Hardware tab to set various parameters needed for DIO operation.
For the meanings and element numbers of parameters, refer to “Appendix” in the
PROGRAMMER’S MANUAL.
The left side of the 1/0 layout frame displays I/O device, the right side displays
I/O layout.

1/0 device 1/0 layout

I Options

[ I | ——————

Fig. 7-26 Hardware Tab (Options) Dialog Box

7.5.1.5 M-DNet

Click the M-DNet tab to set the parameters needed for establishing the Device
Net master mode. For the meanings and element numbers of parameters, refer
to the instruction manual for Device Net master.

-IiI- Options E3

Propery SetWalue
Senal Mumber 171100
Expected Facket Rate 1]
Inter_Scan_Delay

&

P

a
1
a

0] Cancel

Fig. 7-27 M-DNet Tab in Option Dialog Box
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7.5.1.6 Display

Click the Display tab to set SHOW/HIDE option for display.
This display tab appears when the user level is higher than the programmer.

-Ief.I- Options E

...........................

~Cption
|| File Expanszion Menu
Autornatic refreshiAutamatic snapshot]

Ik, | Cancel

Fig. 7-28 Display Tab (Options) Dialog Box

¢ File extension menu: Extends the Files menu of the DIO Manager. For details,
refer to 7.1.6 “Menu List”.

¢ Auto Update (automatic acquisition of snapshot):
If you change the window size or scroll the screen when
the DIO Manager is connected or in the process of
connection to the Robot Controller, the Manager
automatically monitors the snapshot.
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7.5.2 DIO Command Viewer

The DIO command viewer shows the bit pattern of DIO command.
For information on the DIO commands, refer to Chapter 5 “Robot Controller
Interface” of the RC5 CONTROLLER INTERFACE MANUAL.

D10 Command Wiewer for Standard Allocation

~Command Area: O[30 TO 33](Dnet[544 TO 547)

1 - Program Operation -
TI547]  A0[544) I d P J

- Data Areal: I0[6 TO 13]({Dnet[520 TO 527])

I I I I I I I D 2III]|1 -Program Reset Star j

13[527) E5
- Data Area?: 10[14 TO 29){Dnet[528 TO 543))

OCOO0OOOCOCCOOOCO0A0 @
29(543) 14(528)

O 10[5)Dnets19]) - Odd Parity

Fig. 7-29 DIO Command Viewer
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7.6 Help Menu

The Help menu provides explanations on how to use WINCAPSII.

| Help

Lizenze Key

About Syztem bManager

Fig. 7-30 Help Men

7.6.1 About DIO Manager

Displays the version information on DIO Manager.
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Operating Arm
Manager

This chapter describes the WINCAPSII software
Arm Manager functions that are used with the
personal computer teaching system.







Chapter 8 Operating Arm Manager

8.1 Outline of Arm Manager

8.1.1 Outline of Functions

The Arm Manager is a tool provided for monitoring the current robot arm position,
effective tool number, and effective work number.

Since robot actions can be simulated without actually operating the robot, robot
programs can be developed efficiently and safely from the initial stage of
development.

Main tool bar Operation bar (1)

¥ C:AWINCAPSIINBINAYS-6577E \IRA-DD00MRA-0000.arm - Arm Ma... = E3

File Edit Action “iew Tool Help

EEE I R
x| v] oz mx| my] rz] FG|[#
EPDS p17.28 10884 5¥0.15  180.00 14.00 -170.00 g ﬁ
#

|

v

w5l ol

B

Y-axis rotation

—1
\\
-]
/ [T B | N
Operation bar (2) /
a: X-axis rotatio& \ b: Zoom bar /

Operation bar (4) Robot display Operation bar (3)

Fig. 8-1 Arm Manager Window
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8.1.2 Tool Bar (Arm Manager)

Main Tool Bar

CONNECT button. Refer to “8.4.1 Connect”.

SNAPSHOT button. Refer to “8.4.2 Snapshot”.

MONITOR button. Refer to “8.4.3 Monitor”.

TRANSMIT button. Refer to “8.2.5 Transfer Project”.

WORK COORDINATE SYSTEM SET button. Refer to “8.6.1.6 Work”.
TOOL COORDINATE SYSTEM SET button. Refer to “8.6.1.5 Tool”.

AREA COORDINATE SYSTEM SET button. Refer to “8.6.1.7 Area”.

® ek Qe

REMOTE OPERATION button. Refer to “8.6.2 “Remote Operation”.

| OBJECT TREE button. Refer to “8.6.4 Object Trees”.
Operating Bar (1)
L"_ Type-F T TYPE button: Displays the current position of the robot in T type.
P"F'E“‘JT P TYPE button: Displays the current position of the robot in P type.
ype-
Type-l+Ex J TYPE button: Displays the current position of the robot in J type.
Copy COPY button: Copies the current position of the robot to the clipboard.
X% v 7z mx| RY| RZ| FIC|
TIPos 61748 10684 57015 18000 14.00 -170.00 5

CURRENT POSITION DISPLAY box: Displays the current position of
the robot.
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Operating Bar (2)

b & Gl

L

B

WIRE FRAME button. Changes the robot arm drawing to a wire frame.
FLAT SHADING button. Changes the robot arm drawing to flat shading.
SMOOTH SHADING button. Changes the robot arm drawing to smooth
shading.

PROJECT button. Specifies whether to display the robot in perspective.
VIEWPOINT SHIFT Y-AXIS ROTATION bar. Rotates the robot display
around the Y-axis.

Operating Bar (3)

#|
#]

[

—
=

LOCK Z button which sets the viewpoint in the direction of Z-axis.
LOCK X button which sets the viewpoint in the direction of X-axis.
LOCK'Y button which sets the viewpoint in the direction of Y-axis.

VIEWPOINT SHIFT VERTICAL bar. Scrolls the robot display vertically.

Operating Bar (4)
a{l | P VIEWPOINT SHIFT X-AXIS ROTATION bar. Rotates the robot display

b:[l |

around the X-axis.

j ZOOM bar. Zooms the robot display in or out.
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8.1.3 Basic Application

This subsection describes the flow of off-line point teaching.

Note: Since the current Arm Manager has no such accuracy in calibration
to provide teaching with precision, rough point teaching is
conducted to check program operation.

During designing

Monitor started without | Refer to “8.4.3 Monitor”.
connection

—p| Robot operation with Refer to “8.6.2 Remote Operation”.
simulation images

l

Refer to “6.4.4 Get Pose”.
Note:
Operation with Variable Manager

Input the current
pose to variable

All points
completed

, Refer to “6.2.5 Transfer File”.
Variable data Note:

transmit

Operation with Variable Manager
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During Monitoring

Connected to Robot Refer to “8.4.1 Connect”.
Controller

l

Select item desired « P
for monitoring Refer to “8.6.1.1 Monitor”.

l

Start monitor Refer to “8.4.3 Monitor”.
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8.1.4 Files to Manage

8.14.1

8.1.4.2

8-6

Fig. 8-2 shows the files that the Arm Manager manages. The following are the
description of each file.

X

Arm Manager

arm_cnf
* ARM

5

)~

Arm configuration

Arm file definition file

Fig. 8-2 Files Managed by Arm Manager

Arm Files (*.ARM)

The Robot Controller servo information used for a project and other information
used for setting and reading using the SET command in the Arm Manager TOOL
menu are saved in an Arm file.

Since a separate file is created for every project, robot characteristics that differ
from one project to another can be managed without confusion even when
multiple projects are being managed.

The extension for the file reads “ARM”.

Arm Configuration Macro Definition File (arm_cnf.h)

Stores the macro definition information of arm set data.

The Configuration macro definition file is located where arm files (*.ARM) are
found.

The file name is “arm_cnf.h”".

To use a macro concerning arm configuration from the PAC program, it is
necessary to input this macro definition file at the head of the program using an
#INCLUDE statement.
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8.1.5 Menu List (Arm Manager)

The Arm Manager command menu has the following tree structure:

File
New (Programmer level) *1
Open (Programmer level) *1
Save
Save As (Programmer level) *1
Transfer
Print
Close

Edit
Cut
Copy
Paste
Rename
Rebuild

Actions
Connect
Snapshot
Monitor

View
Arm
Tool
Work
Area
Obstacle

Tools
Options
Remote Operation
Object Trees
Pose Conversion

Help
About Arm Manager

Fig. 8-3 Menu Tree of Arm Manager

*1: Displayed only when the file extension menu of the display option is
checked. To set the display option first re-login on the programmer level.
Then select Tools, Options, and View and check the option file extension
menu.
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8.2 File Menu (Arm Manager)

The Arm Manager has an ARM file to save information on trajectory generation.
The Arm Manager File menu is used for managing the ARM files.

File Edit Action Wiew

Mew

Open ... Chrl+0
Save Chrl+5
Save bz .
Tiramsten... [l
Brirt ... Ctrl+P
Cloze

Fig. 8-4 File Menu

8.2.1 New (Programmer level)

Creates new robot arm information.

8.2.2 Open (Programmer level)

Opens an existing ARM file.
When the standard Windows dialog box appears on the screen, select an ARM
file to open, and click on OPEN to open the file.

Opening file
Loak in: | ‘3 Ir=-0000 =] i
IFi-0000. arm

File name:

Open I
Files of type: |mm file[*. )] =] Cancel |

Fig. 8-5 Open Project Dialog Box

v

8.2.3 Save

Saves the current status in the currently selected ARM file.
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8.2.4 Save As (Programmer level)

Saves the current robot arm information to a new ARM file.
When the standard Windows dialog box appears on the screen, select the path
and input the file name. Click on Save to save the data.

Save jn: Ia Ira-DDDlD j gl iR EE

IRA-0000.arm

File name:  [IRA-0000 Save |
Save as hype: IArmfiIe[".arm] j Cancel |

v

Fig. 8-6 New Saving of File Dialog Box

8.2.5 Transfer

When communication with the Robot Controller is ON, this enables it to transmit
or receive the environmental table data.

The environmental table refers to the arrangement of data necessary for the
robot to operate.

When the Transfer Environment Table dialog box appears on the screen, select
the table, and click on either Transmit or Receive to transmit data.

& Transfer Environment Table |

— Transfer Table

|v| <Config> Transmit »
<Trajectory: Pecsive
vl «<Servoz

vl <Tool>

<ok Cancel

<Aread

Fig. 8-7 Transfer Environment Table Dialog Box

The items in the transfer table are the contents set in 8.6 “Tools Menu”.

Note 1: After sending the configuration setting, trajectory, and servo
data, you need to restart the Robot Controller.

Note 2: For the tool and work data, the Controller receives the values
which has been changed with the TOOL and WORK commands.
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8.2.6 Print

Prints the Arm Manager environmental table.

8.2.6.1 Print Object

The Print Manager dialog box appears on the screen. Select the Print Object tab
and select the object to be printed. Click on Print to print data.

B Print Manager |

Frinter

—Pr

Print DhjEmT Dption ]

[ 1 <Trajectorys
[ 1 <Sermo>

1 <Tool>

1 <WWork>

[ ] <Arear

Canon LBP-430

} .......................................................................................... SE'EI:L-":"\” |

Frirt Cancel Fresiew Set

Fig. 8-8 Print Object Tab (Print Manager Dialog Box)

e Select All:
e Set:

e Preview:
e Cancel:
e Print:

e Option:

Selects all of the environmental tables as the object for
simultaneous printing.

Displays the printer SET dialog box and makes various printer
settings.

Enables viewing of the print status prior to actual printing.
Closes the dialog box without printing.

Prints the table.

Print options appear.

TIP: To print only specified page(s), click on the printer button |& after
previewing.

NOTE: If you select more than one object to be printed, Preview is not
usable.
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i@ <Config> =] E3
iI
Arm Managar el 07
< Apphcane modwaa™ : baaa fil am - *apd_eai'b’
FProzerir Valie irlacm Aoooaleed
Caoounl 33 o mouno BpumTunn o CND_&SP&CC ]
Flogi-mauoe o Chroboxd -mouo ] D SPACE |
#ima o poyload (g1 2,000 | CHD_Low |
Furlomd cavm af giasrer %6 (o) o | €D _LoFvear I
Fuylood covm af i i (o) 30 | CHD LOFTRaY |
[ e p— S — - 100 | coD LoPee |
Eamad pulaz coums for pasweoiog diowmes 1) 2 | CHD PLEWDTHI I
Encmda pulat cuat i pasucsiop dlowme: [12) w0 | CHD PLSWDTHR |
Enmad pul= coums far pasweciog dlowmes JE) 0 | CHT PLEWDTHE I
Enemda pulas cuat far paauceiog dlowme: [4) W | CHD_PLEWDTHY |
Encmda pulas cuat far paauceieg diowme: [15) 0 | CHD_PLEWDTHS |
Enmad puli= coums far pasweciog dlowmes (5] 0 | CHT PLEWDTHG I
[ T S ——— E— 1 w0 | CHD PLEWDTH? |
Enenda pulac munt for poawsoiog dlowmes [12] m CHD FLEWDTHE |
[— d uer-ut fux) 5,600 | CHD_TRAOUT |
Canual lng mode I | cvp_Lomicee | ;I
EI' o2 [0]M] Eancell 5]e9|c0)[Close]  sactis  Tax

i35 |~ |=
EE=

Fig. 8-9 Preview Window

Moves to the head/tail end of the page.

Moves to the immediately preceding/following page.

Selects display (Reduction/Standard/Expansion)

Sets print execution

The printing range (specific pages) of an object file can be specified.

Print |
Printer: Systern Printer [Canon LEP-730)
Print Range Lancel |
il 3 pages
" Pages Copies; E
Erom; I 1 Ie I 3 ¥ Collate Copies

B

Fig. 8-10 Print Window

Exports the object file.
The selected object file will be converted into the file format
specified in Format and outputted (saved) to the Destination.

Export |
Farmat: Drestination:
| Disk file =
k. I Cancel |

Fig. 8-11 Export Window
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8.2.6.2 Option
Selecting the Option tag will display the print options.

Note: Print option is not available from the Arm Manager.

8.2.7 Close

Ends Arm Manager and closes the Arm Manager window.
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8.3

8.3.1

8.3.2

8.3.3

8.3.4

8.3.5

Edit Menu (Arm Manager)

This menu is for editing the object tree.

Edit Action  Yiew Tool

Cut Chrl+
Copy Chrl+C
Paste Chrl+
Fename
Beconfigure

Fig. 8-13 Edit Menu

Cut
Cuts data out of the selected range. The cutout data can be used with the Paste
command.
Note: Only the selected data is cut out. Note that the data that exists on
the lower level than the selected data will be also deleted.
Copy
Temporarily stores the same data as in the selected range. Data temporarily
stored by copying can be used in the PASTE command.
Paste
Pastes temporarily stored data by cutout or copying to a specified location.
Rename
Open the object tree, specify an object and use RENAME to change the name of
the object.
Reconfigure

Re-draws the display of the object tree and displays only the root object.
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8.4 Actions Menu (Arm Manager)

The Actions menu commands can be also issued by depression of the buttons

on the tool bar.
| Action NUCTINE

v LConnect
Shapshot
ke anitar

S8 =l El

Fig. 8-14 Actions Menu and Button

8.4.1 Connect

Connects communication between the Robot Controller.

When connected the menu is attached with a check mark.

The connect button gt| works the same as the Connect command. When
connected it is displayed as if depressed.

8.4.2 Snapshot

Acquires the data of the moment from the Robot Controller.

The snapshot button has the same function as the Snapshot command.
Before executing the snapshot command, ensure that the Arm Manager is
connected with the Robot Controller.

8.4.3 Monitor

Acquires data in succession from the Robot Controller.

The monitor button has the same function as the Monitor command.

Before executing the monitor command in succession, ensure that the Arm
Manager is connected with the Robot Controller.
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8.5 View Menu (Arm Manager)

Specifies the elements to be displayed in the robot display.

g C:\Program Files\wircaps2\IRA-0D0O0MBA-000D. arm - Arm Manager [l[=] E3 Arm

File Edit Action Wiew Tool Help

| D3| 7| o] 2 el

[Type-s =] 48[ 33571. 103 3596, 5359586, 0. 59 93585, 0] |

Work

Obstacle

\

Area

Fig. 8-15 View Menu and Screen Display

8-15



8.5.1

8.5.2

8.5.3

8.5.4

8.5.5

8-16

Arm
Specifies display of the robot arm. When Arm on the menu is check-marked, the
robot arm is displayed.

Tool
Specifies display of the tool coordinates. When Tool on the menu is
check-marked, the tool is displayed.

Work
Specifies display of the work coordinates. When Work on the menu is
check-marked, the work coordinates are displayed.

Area
Specifies display of the area. When AREA on the menu is check-marked, the
area is displayed.
Define the area with Object Tree in the Tools menu. Refer to “8.6.3 Object
Trees”.

Obstacle

Specifies display of an object. When Obstacle in the menu is check-marked the
obstacle object is displayed.

Define the obstacle with Object Tree in the Tools menu. Refer to “8.6.3 Object
Trees”.
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8.6 Tools Menu (Arm Manager)

8.6.1 Options

Help

Options...

Bemaote Operation

Object Tree

Poze Converzion

Fig. 8-16 Tools Menu

Makes various settings that are necessary for Arm Manager.

Select Options from the Tools menu to display the Options dialog box. Click on
the tab and set the required data at the respective items.

When you put a checkmark at Create Header File, the macro definition file
(arm_cnf.h) for arm configuration is created.

Note: The items that can be edited vary with the user level. For
restrictions by user level, refer to “1.3 Security”.
For information on how to change the access level, refer to “4.3.3
Re-Log In”.
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8.6.1.1 Monitor

T

| Cunfig.l Trajectory | Servo | Toal | Work | Area | Display |

o
v 500 ms
1
Action History:  —— J— 10 Points

™ MonitorWork Coordinate System Simultaneously

™ Wonitor Tool Coordinate Systern Simultaneoushy

ANAN

\\ n]s Cancel

Check this box when
displaying the monitored
values.

¢ C:\Program Files\wincaps2\IRA-0000MBA-0000.arm - Arm Manager [H[=] [E3
File Edit Action Wiew Tool Help

Zolo| vl xlile| «lEl

;I E 7 ||' ||' II' || 'I Il, 'l, I'l, ) I'.
[ R I B
Fig. 8-17 Monitor Tab (Options Dialog Box)

e Timer intervals: Sets the intervals for acquiring data on the monitor. Default is
500 msec.

¢ Action history:  When drawing the trajectory of a robot, this specifies how
many points of position data to draw. Default is 10 points.
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8.6.1.2 Configuration

Click the Config. tab to set various parameters that affect acceleration,
deceleration, and positioning. For the meaning of each parameter, refer to “4.6
Control Sets of Motion Optimization”, “4.7 Setting the Master Control
Parameters in User Preferences” and “Appendices” in the PROGRAMMER'S

MANUAL.

gl Trajectory | Servo | Toaol | Wark | Area | Display |

Setvalue

* 1

* 1

* 1

* 1

* 1

Control set of motion optimization n

Floor-mount or Owerhead-mount 0

hass of payload (o) 10000 -

0] 4 | Cancel |

Fig. 8-18 Config. Tab (Options Dialog Box)

8.6.1.3 Trajectory Generation

Click the Trajectory tab to set various parameters needed for robot arm
operation.

Change parameters by rewriting the set value grid in the list.

For the meanings of parameters, refer to “Appendix” in the PROGRAMMER'S
MANUAL.

-ﬁI- Ophions E3

Mnniturl Config. T

Froperty Setwvalue
* 4
1
* 10
Fositive software motion limit {(J1,deg*1073) 170000
Fositve software motion limit (J2, deg*1073) 135000
Fogitive software motion limit (J3,deg*1073) 165000

{

{

®

Fositive software motion limit (4, deg*10™3) 185000
Fositive software motion limit {5 deg*10™3) 120000

-

(0] | Cancel |

Fig. 8-19 Trajectory Tab (Options Dialog Box)
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8.6.1.4 Servo

Click the Servo tab to set various parameters necessary for the robot arm servo
system.

Change parameters by rewriting the set value grid in the list.

For the meaning of parameters, refer to “Appendix” in the PROGRAMMER'S

MANUAL.

HE Options
Mnnitorl Cnnfig.l Trajectory | Taal | Waork | Area | Display I
Froperty Setwalue
* 0
* 1]

* 1]

* 1]

* 1]

* 1]

* 3

w 3 -
Ik | Cancel |

Fig. 8-20 Trajectory Generation Tab (Options Dialog Box)

8.6.1.5 Tool

Click the Tool tab to define the tool coordinates to be displayed on the robot

display.
Clicking on the tool coordinate system set button 7| will open the same Options
dialog box.
ﬂ- Options [ x|
Mnnitnrl Cunﬂg.l Trajectnryl Servo | Wnrkl .ﬂureal Displayl
MNo. | v Z| R R Fﬂ
1 0 0 0 0 i
2 1 0 0 1 i
3 0 0 0 0 i
4 0 0 0 0 i
5 0 0 0 0 i
B 1 0 0 1 i
7 0 0 0 0 i .
4 I g : . . . . )I
(0] 4 | Cancel |

Fig. 8-21 Tool Tab (Options Dialog Box)
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8.6.1.6

8.6.1.7

Chapter 8 Operating Arm Manager

Work

Click the work tab to define the work coordinates to display on the robot display.
Clicking on the work coordinate system set button il will open the same
Options dialog box.

#E Options
rkl Area | Display |
Ry | RZ

Mnniturl Cunfig.l Trajectur_'.'l Servo | Tool

MNa. | v Z|
0 0 0

DDDDDDD% R

ps e QS I N TR
[ R e T e R s [ e R s |
o o O o O O
o o o o o o O

ok |

Cancel |

Fig. 8-22 Work Tab (Options Dialog Box)

Area

Click the Area tab to define the area to display on the robot display.
Clicking on the area set button @l will open the same SET dialog box.

ﬁl- Options
| Display |
Mo, | v Z| | R Fﬂ
0 1] 1] 1] 1] 0
1 1] 0 1] 1] 0
2 1] 0 1] 1] 0
3 1] 1] 1] 1] 0
4 1] 1] 1] 1] 0
5 1] 0 1] 1] 0
: 0 0 0 0 i _
4] N i . i . = 3|
(0]:4 | Cancel |

Fig. 8-23 Area Tab (Options Dialog Box)
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8.6.1.8 Display

Click the Display tab to set the display option between Show and Hide.
This display tab appears when the user level is higher than the programmer.

-ﬁI- Options |

.......................

~Dption
|| File Expansion Menu

] Permission of CALSET transmission
| 11)se hardware accelerator

. Cancel

Fig. 8-24 Display Tab (Options Dialog Box)

e File extension menu: Extends the Files menu of the Arm Manager. For details,
refer to 8.1.5 “Menu List”.

¢ Auto Update (automatic acquisition of snapshot):
If you change the window size or scroll the screen when
the Arm Manager is connected or in the process of
connection to the Robot Controller, the Manager
automatically monitors the snapshot.

e Only when the "Permission of CALSET transmission" is selected, CALSET
data (RANG, CALSET values) may be transmitted. This is to avoid unexpected
transmission of CALSET data.

This option is not selected by default.

Note:The RANG and CALSET values differ in each robot. When
transmitting them, make sure that correct data is set up for
transmission. If the robot controller receives incorrect data, the
robot will not run normally.

For details about "CALSET," refer to the INSTALLATION &
MAINTENANCE GUIDE.

e You may choose the use of hardware accelerator.

If enabled, the hardware accelerator will make Arm Manager draw faster on
screens according to the "Graphic hardware accelerator" settings of your PC.

If you modify this setting, restart WINCAPSII to make it go into effect.

Note: Depending upon graphics drivers installed in PCs, the hardware
accelerator may cause Arm Manager to fail to display correctly in
some cases. If such occurs, disable the hardware accelerator.
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¢ Displaying details of arm objects [Ver. 1.8 or later]

When “Detailed display of arm objects” is selected, the screen shows all the
robot objects in the object tree from base to flange. The screen is changed
when the WINCAPSI| is activated.

= Object Tree

............ Ea PgwerSupply
............ f Power Supply?
- BaseBody

S[=] E3

Tatal Ohjects: / 256

— Property - Object[]

Relative Position:

= D[R 0
ke 0 Ry I
Z 0 Rz I
Size: &1 Half e Eul
® 00 PR
¥ EOO Ry

z DRz

Fig. 8-24b Object Tree Dialog Box

8.6.2 Remote Operation

Selecting the remote operation command displays the Remote Operation dialog

box.

To remote-operate the robot, click the remote operation button on the Remote

Operation Dialog Box using the mouse.

Remote operation button

+. Remote Dperation E

WORKD-BASE ]
TOOLO-Flange |7

|

J
1
p

|

4
i
p
i
p

Fig. 8-25 Remote Operation Dialog Box

Note: Use the Arm Manager in the disconnected state. For reasons of
safety, the robot is designed not to move even if the Robot
Controller is connected.
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8.6.3 Object Trees

8-24

Defines the object to draw on the robot display.
Select Object Tree from the Tools menu to display the Object Tree dialog box.

;. Object Tree =[0]>]
@ GROUND =
{3 Base ‘ Total Objects: IENE ‘
............ @ Power Supply ~ Property - Object{104)
............ B PowerSupply?
&l () BaseBody 7 Display
E% Jl-Joint Relative Position:
e [B) Al 10 " 200 | g 0
© Armlu | C o0 Ry I
Arml-§ > 1 Rz [
Arml-RE
[ J2-T it Size & Half ¢ Full
............ B irea? % 50 R
red v 30 Ry
Areal z 500 RE
Areald
[F) Aread _|| Color: _ﬂ
............ B Areas
............ % Areds Joint A= E Corresponding axis
............ Areal |' I Movi i i
oving direction and scale
............ )k Workl Z A s . I ’
S Workl P < iti
- T orsl I _lll £ Additional buttons
< »

Fig. 8-26 Object Tree Dialog Box

e [+] mark: Indicates that the hierarchical structure of the lower order of the
object tree is hidden. Clicking will show the hierarchical structure of
the lower order.

e [-[] mark: Indicates that the hierarchical structure of the lower order is
displayed. Clicking will hide the hierarchical structure of the lower
order.

¢ Additional buttons: Use these buttons to add an object with the specified shape

as a subdirectory of the currently selected object.

¢ Close: Closes the Object Tree dialog box.

¢ Relative Position: Inputs the position of relative object in the event

coordinate system

o X/IY/IZ: Refers to x/y/z components of the relative position of the object.
Units in millimeters.

¢ RX/RY/RZ: Angle of rotation of the object around x/y/z axes.

Specified in degrees.

e Size(L): Inputs the size of the object.
o X/YIZ: Refers to the length (size) in the direction of x/y/z. Units in
millimeters.

e Color(C): Selects and inputs the color of the object.

o REDRAW: Refreshes the robot display.

e Display: When check-marked it is displayed on the robot display.

e Corresponding axis: It is possible to move the object in combined motion with
the selected robot axis. Select the corresponding axis and
its moving direction and scale.

Cautions: (1) Even if the property of the object is changed, it will not be
reflected unless the REDRAW button is depressed.
(2) Positions of the arm, tool, work, area and size cannot be
changed.
(3) To change tool, work and area use the SET menu.
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8.6.3.1 Adding New Objects to Object Trees

Select an object to be added.
»STEP1

> STEP 2 Right-click to display the contents menu, and copy the object.
Cut Chil+
Copy
Paste Chrl+f
Fename
Beconfigure
> STEP 3 Right-click to display the contents menu, and paste the object.
@I RD% Fase:1 Cut Ctrl+4
.......... E' Copy Ctrl+C

Paste Crl+

L Renarne

Beconfigure
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8.6.3.2 Deleting Objects

Select an object to be deleted.
»STEP 1

Right-click to display the contents menu and cut the object.
»STEP 2

Copy Ctrl+C
Paste Chrl+
Fename
Beconfiqure
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8.6.3.3 Rendering Object Images by Arm Manager

This section describes how to create object images including palette bases, palettes,
works, conveyer and its tool as shown below.

4 G:¥Proeram Files¥Wincaps2¥V5-6577E¥VS—6... M=l E3

File  Edit Action  YWiewm Tool Help

A@|g| 5 x5l «lEl
I~ 1| 1z 1] 1] 15 [
|| | wl#

The object image rendering procedure consists of the following steps:

(1) Creating a palette base

- Resizing the object
- Moving the object position
- Copying the object

2
3

(2) Creating a palette

(3)

(4) Copying a combined object (palette + work)
(5)

(6)

Creating a work

5
6

Copying a combined object (palette base + palette + work)

Creating a conveyer and its tool object, then setting the work object onto the
conveyer tool object.
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[1] Creating a palette base object
(1) On the Tool menu, click Object Tree to open the Object Tree dialog box.

(2) First let's create one foot of a palette base object.

Click the button to create a square base image object. The object will be
added to the object tree at the same time.

:, Object Tree - (O] x|
I@ Root
- ‘ Total Ohjects: [_109] ;256 ‘
@ <Otjectlame>  Propesty - Object(0]
I Display Bedraw |
Felative Pozition:
b 0 Rix 1]
i 00 Ry 0
z 0 Rz a0
Size: =] Half 6 Eul]
* 0 R
b 0 R
z 0fRZ
o |
Joint _ vl
-

= Object Tree

4 G:¥Program Files¥Wincaps2¥VS-6577E¥VS-6577E¥VS—6577E.. [M[=]E3

File Edit Action Aiew Tool Help

A28 7 %5 ¢E

-

il I 1| 14 s

6] |[#

[~ |
i

0.00 0.00 0.00 0.00 0.00

.00

(3) On the Object Tree, right-click the <ObjectName> and click Rename in the
dropdown menu to give it the desired object name.

Enter the object name you want to use and click OK.

IS [=] S

& Foot
i-{F Base Tatal Objects: / 256
@ <Ohjectl ame g Cut R {108)
Copy Citrl+G
paste cupry | [_Bedan ]
E R
Bebuild By
Move Fobot Data Rz a
Scale
+ Half ¢ Full
whatee Gt A =
Tmve @y A =
| 500 Rz
oo | |
Joint — vI
| == ‘
oo N _
I
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_ArmM anager

Input the abject narme.

d i—|:| bject ame:

Cancel |

I

(4) Change the object color, if you want, by

clicking the color buttons.

Color

Basic colors:

il il [l
T ECEEE
Er T EETEE
ErEEEEEE
AN
lllll_ll_

LCusgtom colors:

[ 11
FEEEEEEN

Define Custam Colors »» |

( ak I) Cancel |




" Object Tree

|@ Root

- Base
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To change the object size, click the object you want to change in size and enter
the desired size (numeric values) into the Size boxes as shown below at left.

I [=1 E3

‘ Tatal Objects: /256 |

— Property - Object[108]

¥ C:¥Proeram Files¥Wincaps2¥VS-6577E¥VS—6577E¥vS-6577E.. [Mi[=1E3

File Edit Help

A @8 5 8| gl

Betion  Miew  Tool

i

Display

Iz

hEll

4]

Is|

Ig|

[~ [ 1]
> \Tnt 0.00 n.00

0.00

0.00

0.00

0.00

Relative Position:

b

200 Bt 1]

ks

400 By 1]

z

0 gz 0

NN EE

= Object Tree

(6)

e

To move the object position, click the object you want to move and enter the target
position (numeric values) into the Relative Position boxes as shown below at left.

‘ Total Objects: [ 109 /256 ‘

r— Property - Object(108)————
W
" 300 B 0
i -600 Ry 0
-

Size: & Half ¢ Eull
" 500 Fi

¥ 400 By

z 500 Bz

LColor: l _I_l

Joint _ vl
| =l 1

Eile  Edit Help

Aol 5 %5 &gl
N I ] sl m] 54 15| o]
3 (| = 000 000 000 000 000 000

Action  Wiew Tool
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(7) To create another foot of a pallet base, copy and paste the object in Arm Manager
according to these steps:
Right-click the object (the foot created in the steps above) you want to copy and
click Copy as shown below at left.
Click the target place where the object should be pasted, then click Paste.

¥ C:¥Proeram Files¥Wincaps2¥\S-6577E¥VS-6577E¥WS—6577E. [M[=]E3

[-10]] Eile Edit Action Miew Tool Help
0o
@ Base Total Objects: [_104] /256 "glll ?—?l *h}l@l %flk::-l

L[] Pollct bl x| Objes
wﬁ;h‘ 1% I~ T T I
PPl ——ti—biririf— Bedon | Zs || [t 0.00 0.00 0.00 0.00 0.00 0.00 ﬂ

;. Object Tree 19 [=]
Rename _ ﬁl
00
Rebuild & E) Base Total Objects: [ 109 /256 H
Move Robe | © am—c_@) Girle¥ - Object(108)- — o
E— Cirb
Scale play BRedraw I 8
itz 9 ]
e e [&
300 R 1
,,,,BEbu”d 0 Ry i}
50 Rz a
o=EE & Half ¢ Eull
Chanee ftir. Lo
fi 50
Iloye Obj. v 400 :é
z| 50| Rz
Calor [T
Joint If vl
l vI *l 1
I~
&

(8) To move the pasted object in Arm Manager, click the object and enter the target
position (numeric values) into the Relative Position boxes as shown below at left.

;. Object Tree - 10O] x| 9 G¥Proeram Files¥Wincaps2¥VS—6577E¥YS-6577E¥VS-6577E... M=l ET
. File Edit Action Wiew Tool Help
‘Pwa'offd;:n”% | slmlgl o] el ele)
— Property - ech] —
P [N ] ;] 13 M 15| 1§ |#
W Display it 000 090 090 000 000 000 g
i Taition.
5 1200 | g Ij> & ﬂ
¥ 0 Ry 0 fod
= ODipz]l 1 )
Size: & Half ¢ Full |E
P 50 B -
¥ 400 Fy
= 50 Bz
LColor: l _I_’
Joint _ v[
S —
NNEEE]
»
J A
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(9) Let's create a palette base object.

Copy and paste the object and enter the desired size and target position into the
Size and Relative Position boxes, respectively, as shown below at left.

= Object Tree O] x| ¢ C:¥Proeram Files¥Wincaps2¥VS-6577E¥vS—6.. =13
|® Foot Eile  Edit Action \Wiew Tool Help
G Base ‘ Total Objects: [111] /256 ‘ =
'"@ Palletbase ~Prapetty - Objest(110)——————— I_ﬁl!l%l EJL ijlf@l |_I%I 5 Jlﬁ
Pallotbase 7 Display Bl :
v | o | o
Fielative Positinn: H ﬁ;‘
<3 500 | A 4 -
< ¥ 0 Ry 0 frid
z 60 RZ & I
Size: H ull IE
% 700 B >
Y 400 gy
N — 10 B2
Color: l _I_l
Joint — vl
| = ‘
NNINEE
v

[2] Creating a palette object

(1) First let's create a palette bottom plate.

Click the & button in the object tree window to create a square bottom plate
object. The object will be added to the object tree at the same time.

(2) Enter the desired size and the target position into the Size and Relative Position
boxes, respectively, to set the pallet bottom plate.

" Object Tree O] x| ¥ C:¥Proeram Files¥Wincaps2¥VS5-6577E¥vS5-6.. =] E1
|® Roat

3 Base ‘ Total Objects: [ 112 /255 ‘ = = =
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(3) Let's create a partition.

Click Pallet in the object tree and enter the desired size and target position into the
Size and Relative Position boxes, respectively, based on the bottom plate created.

" Object Tree

Im[=1E3

% G:¥Proeram Files¥Wincaps2¥VS—-6577E¥VS-6... M= E3

File  Edit Wiew Tool Help
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|

(4) Let's copy the original partition object created in step (3) to arrange it in parallel
with the original partition object.

Copy the original partition object and click the target position to paste it.

Enter the desired position (numeric values) into the Relative Position boxes to set
the partition. Repeat this operation to create the required number of partitions.

*. Object Tree _[O] x] 4 C¥Program Files¥Wincaps2¥V5-6577E¥VS—6.. [M[=]E3
& Root ‘ File Edit Action Wiew Tool Help
Total Objects: -11? /256 ‘
.625|!|!|E| K2 gl
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3 0 R
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z 100 | 7z
LColar: I J_’
Jaint _ vl
| = 1
SN [=
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(5) Let's create a partition perpendicular to the partitions created in steps above.

Click Pallet in the object tree and copy the original partition object and click the
target position to paste it. Enter the desired position (numeric values) into the
Relative Position boxes to set the partition.

" Object Tree ¥ G:¥Proeram Files¥Wincaps2¥VS-6577E¥V5-6... =]

) - File  Edit Action View Tool Help
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(6) Let's copy the original partition object created in step (5) to arrange it in parallel
with the original partition object.

Copy the original partition object and click the target position to paste it. Enter the
desired position (numeric values) into the Relative Position boxes to set the
partition. Repeat this operation to create the required number of partitions.
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[3] Creating a work object

" Object Tree

Create a work object by using the

button in the Object Tree window and put it in

the partitioned space, in the same way as described in the previous sections.
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[4] Copying a combination object (pallet + works)

(1) In the Object Tree, right-click a higher class

object containing objects to be copied, and
click Copy.

(2) Click the object to which you want to paste the
copied object, then click Paste.

(3) Enter the target position (numeric values) into
the Relative Position boxes to set a

combination object (pallet + works) as shown

below.
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[5] Copying a combination object (pallet base + pallets + works)

In the same way as described above, copy a combination object of a pallet base,
pallets and works onto the desired position.

% G:¥Proeram Files¥Wincaps2¥\5-6577E¥vS—6.. =12

File Edit Action Wiew Tool Help

o8 7 ol 2
[~

LTJ [ n| n] n| 1 1 1[#
iv }ﬁ
| Jé},l

5| Tlele

[6] Creating a conveyer object and its tool objects

In the same way as described in the previous sections, create a conveyer object and its
tool objects and then put works on the conveyer tools.

*, Object Tree = (O] % C:¥Program Files¥Wincaps2¥VS-6577EXVS—6.. M=l E3
I@' Root File  Edit Action Miew Tool Help
.......... ) Base | Total Ohjects: [ 157] j 256 ‘ = = =
T ! it =
... @) Palletbase EE—— |_£|£|£|I Ell iITUI@I |&|_-|| |
[ Ju ;| g3 34 us| J#E
- @ Pallst Fielative Positi;n: -
w--fg Pallethase & e
H g 100 | By 1]
B~ @ Corveyer z 200z ]
@ Conveyer
B Conveyer tool Size: = Half C Eull
E--fg Conveyer tool
- 30 R
- 30| Ay
80 Rz
5@ Conveyer tool coior: | ! |
---------- o Conveyer tool
Jaint _—L,
| =l |
" ANl
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8.6.4 Pose Data Conversion

This is the tool for converting the data type between the three types of pose data
(P type, J type and T type). Conversion is made on the basis of the specified
work coordinate system (WORK) and tool coordinate system (TOOL). Clicking
on the work coordinate system, tool coordinate system or the data type will run

the calculations for conversion.

~Local Coordinate System

% |worko-BasE  ¢] 17 [TOOLO-Flange 7]
Data Type

& Type P  Type J C Typa T

“Yalue

% 0 e i] FIG |3

|0 R o

Z {0 rz [0

Fig. 8-27 Pose Conversion Dialog Box
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Chapter 8 Operating Arm Manager

8.7 Help Menu

Descriptions on how to use WINCAPSII can be viewed using the Help menu.

| Help

License Key

Abaout System M anager

Fig. 8-28 Help Menu

8.7.1 About Arm Manager

Displays the version information on Arm Manager.
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Operating Vision
Manager

The Vision Manager handles the functions of the
vision control device. This chapter describes the
WINCAPSII Vision Manager used by the personal
computer teaching system.







Chapter 9 Operating Vision Manager

9.1 Outline of Vision Manager

9.1.1 Outline of Functions

The Vision Manager supports the creation of vision programs in PAC.

The Vision Manager enables you to interactively proceed with the defining vision
processing windows, create search model, and lookup tables.

Image data can be backed up in BMP format, while search model data can be
backed up by user defined specific formats.

You can start the Vision Manager by clicking on the @l System Manager button
or from the Window menu.

When the Vision Manager is started, the Vision Manager window appears on the
screen. The following are the functions of the DIO Manager.

Note: A pVision board (optional) is needed to use the Vision Manager.

Vision Manager Window

Shape edit tool bar Main tool bar Menu bar
i C:¥Program Files¥Wircaps?¥HS-E¥XHS-Evis — !lil

File _itisre—TFoof

zm| o A% g8 Bls]llalmlP

Hetm

[ [,

| F ecewe\d Image D ata\

\ Object screen status

Image data status

\ Teaching panel

Display screen status

Fig. 9-1 Vision Manager Window
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Teaching Panel:

When editing the window shape and/or search model shape, adjust the
shape with the teaching panel, using the mouse.

Display Screen Status:

Displays the current screen displayed state on the Vision Monitor. The
camera or processing screen state is also displayed here.

Object Screen Status:

Displays the screen analysis processing object (Process Screen 0 to 3).

Image Data Status:

Displays the attributes of image data displayed on the teaching panel.

9.1.1.2 Options Window

$F Options

Look Up | General Sating | Displayl

Brigh Tahls0 |Tahlel |Tahble? [Takle3 \T;ﬂ

o 0 0 0 255

1 1 0 1 254

2 7 1 5D 253

3 3 2 63 252

4 4 2 74 251

h R 3 A7 ZRN hl
Standard Table: 100%

j Set ko Standard |

™ Create Header File

Cancel |

Fig. 9-2 Options Window

Look Up tab:
Sets the lookup table.

General Setting tab:

Sets general information concerning vision function.

Display tab:
Sets the extended display.
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9.1.1.3 Edit Macro Name Window

¥E Edit Macro Name |
Window | Search kodel |
Mo |Usage |rv1a|::r|:|

I

1

2

3

4

5

B

? -
CK. Cancel

Fig. 9-3 Edit Macro Name Window

Edits the macro names of the windows and search models. The macro name

definition file can be created from the input macro name. The macro name can
then be used in programs.
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9.1.1.4 Various Tool Windows

Area. Gravity Center. Principal Axis
—hdeasuring Condition
Object 'Wwindaw: Iwmdnwu: j Back
Measuiing Mode: (2-Principal xis = Edit Window
Object: & Wwhite ™ Black e [

Binary Processing | IR

’7 Lower: lm Dhject Window:
Windowl: j ﬂ

Fiesult Property: M
ltems Farameter Walue
Frocessing Time (ms) . arigin 24 Delate
Ared ' origin 34 -
Grawity Center X e L 473 ——
Gravity Center™’ Square - height 417 izt
Angle Sguare - angle 0
Integrate Brightness Square - rmode o Cam Image

Fig. 9-4 Various Tool Windows

The Tool window is called from the main window. The work objective is carried
out through a combination of these tool windows.

Table 9-1 Functions of Various Tools

Camera input Inputs camera images
Select display screen Controls screen to display on vision monitor
Edit window Makes window
Edit search model Makes search model
Binary-coded Sets binary code level for image analysis

registration

Area, center of gravity, Analyzes area, center of gravity and spindle

principal axis
Measure labeling Analyzes labeling
Measure edge Analyzes edge
Model search Makes pattern matching using search model
Read code Reads QR code
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9.1.2 Tool Bar

Shape edit tool bar

Main tool bar

€% C:\Program Files\WINCAPS 2\RA-0000\RA-00... S E3

Ele Tools Help

Bchion

[ @ | (% &]&] Be]2]e]lm]

Fig. 9-5 Main Window and Tool Bar

Main Tool Bar

B

BlEek=g

Connects with the Controller.

Displays the environmental table
transmit dialog.

Displays the camera input tool.

Displays the window edit tool.

Displays the binary processing
registration tool.

Displays the labeling tool.

Displays the model search tool.

Shape Edit Tool Bar

K Makes changes, moves and edit.

y
[

|

Specifies the shape of lines
(between two points).

Specifies the shape as oblong.

Specifies
ellipse.

the shape as an

©

L.
O
[y

Acquires controller information.
Displays the screen display tool.

Displays search model edit tool.

Displays the area, center of
gravity and spindle tools.

Displays the edge tool.

Displays the code read tool.

Makes rotary editing.

Specifies the shape of the line
(length).

Specifies the shape as a circle.

Specifies the shape as a sector.
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9.1.3 Basic Application

During image analysis

@

Connect the Robot
Controller

A

Display camera images by
selecting display screen

Input camera images

Register a window
to use for analysis

Register the binary-coded
level to use for analysis

Measures the area, center
of gravity and spindle

End

9-6

Chapter 9, subsection 9.3.1 “Connect.”

Chapter 9, subsection 9.4.6.3 “Select Display
Screen."

Chapter 9, subsection 9.4.6.2 “Camera Input.”

Chapter 9, subsection 9.4.3 “Edit Window."

Chapter 9, subsection 9.4.6.4 “Binary-coded
Registration."

Chapter 9, subsection 9.4.6.5 “Area, Center of
Gravity, and Principal Axis."
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9.1.4 Files to Be Managed

Fig. 9-6 shows the five files that the Vision Manager manages.

vis_cnf / Vision \ vis_tab
h manager .

o

Configuration macro Macro definition file
definition file
3
.bmp mdl *is
Bit map file Model data file Vision file

Fig. 9-6 Management Files of The Vision Manager

9.1.4.1 Vision File (*.vis)

Contains set information about the vision board including window, search model,
calibration, lookup table and system settings. Since they are in different files by
project, the respective vision information can be managed without confusion,
even if multiple projects are involved. The file extension is “.VIS”.

9.1.4.2 Model Data File (*.mdl)

Contains the search model image data. Itis managed with relational information
registered to the vision file. The model data file is located wherever the vision file
(*.vis) is. The extension is “.MDL”.

9.1.4.3 Bit Map File (*.bmp)

The Vision Manager can handle files in BMP format. Image data received from
the Robot Controller can be stored in BMP format. Also, BMP formatted files
stored, in advance, in the Vision Manager can be opened. Bit Map File is located
wherever the vision file (*.vis) is. The extension is “*.BMP”.
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9.1.4.4 Macro Definition File (vis_tab.h)

Contains the correspondence definition, between the window macro name and
number, and the macro name and number of search model. The macro
definition file is located wherever the vision file (*.vis) is. The file name is
“vis_tab.h”.

9.1.4.5 Configuration Macro Definition File (vis_cnf.h)

Contains the vision set data macro definition information. The configuration
macro definition file is located wherever the vision file (*.vis) is. The file name is
“vis_cnf.h”.

To use the macros related with window, search model, and configuration in PAC

project, it is necessary to read this macro definition file by specifying #i1NCLUDE
statement at the top of program.
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9.1.5 Menu List

The Vision Manager command menu has the following tree structure:

File
New *1
Open *1
Save
Save As *1
Transfer
Open Image Data
Save Image Data As
Print
Make Macro Define File
Import Macro Define File
Close

Actions
Connect
Get Info

Tools
Options
Edit Macro Name
Edit Window
Edit Search Model
Calibration
Image Analysis
Camera Input
Display image
Binary-coded Registration
Area, center of gravity, principal axis
Labeling
Edge
Model search
Read code

Help
About Vision Manager

Fig. 9-7 The Vision Manager Menu Tree

*1: Displayed only when the display option file extension menu is checked. To
set the display option, re-log in at programmer level, then select Tools,
Options and View, and check the option file extension menu.



9.2

9.2.1

9.2.2

9.2.3

9.2.4

9-10

File Menu

The file stores necessary information for operating the vision device and it also
reflects the contents of editing with the Vision Manager. The following shows the
list of data stored:

System set data (camera setting, etc.)

Lookup table data

Window data

Search model data

Calibration data (teaching point data and conversion factor)

File Actions Toolz Help
Hew
Open...
Save Chl+S
Save ...
iramsten,.

Open [mage Data
Have [mame Eta ds

Print... Chrl+FP

Make kMacro Definition File
Impart Macra Definition File

LCloze

New (Programmer level)

Creates a new set file for an editing object. Default is stored when making a new
file.

Open (Programmer level)

Opens the saved set file to edited an object.

Save

Saves set data currently being edited.

Save As (Programmer level)

Saves the set data under editing by newly creating a file.
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9.2.5 Transfer

9.2.5.1 Transmitting Set Data

Transmits set data between the Robot Controller and the personal computer.
This function is used for transmitting set data edited by the Vision Manager or for
receiving Robot Controller (backup) set data.

To transmit set data, it is necessary to be connected to the Robot Controller. For
instructions how to establish a connection, refer to Chapter 9 “9.3.1 Connect” in
this manual.

9.2.5.2 Transmitting Image Data

Image data is transmitted between the teaching panel and the Robot Controller
(Ver.1.5 or before: Process screen 0 to 3, Ver.1.6 or later: + Camera screen 0 to
1). The teaching panel displays the images of the currently held image data. If
nothing appears on the teaching panel, no image data is being held.

& C:¥Program Files¥Wincaps2¥HS-E¥HS-Evis —. [Nl B3

Ele detens ol Help Robot Controller,
% @) o] M| 2le) lolsaldal ) )

— g N

Process Screen 0 Camera Screen 0

oS [E|SIN s

(Ver.1.5 or before) Addition (Ver1.6 or later)

| Heca}(ted Image Data

Teaching panel

Note1: If no image data is held, only
receiv-ing is enabled.
2: Camera screen is only for receiving.
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9.2.5.3

9-12

B /ﬂrawng 1 [
Screen Si -

c—

Image Data Transmit Procedure

@ Transfer Environment Table

~ Transfer Tahle

| 1<System Settings> Transtmit >
[ 1<Look Up> ;
<R
| | <Calibration> EEERE
<hindowy

earch Model> Cancel

<Image Datax(Feceive Only

Select All

44

% Transfer Image Data |

Process 5 rocess Screen "I

€& C:¥Program Files¥Wincaps2¥HS-E¥HS-Evis — [M[EE3

File” Actions  Tools  Help

& B ol Mm@l @]t alw

A

|:.I,.I l

|!,_-’ | a II.'_‘_-ID |i

|Heceived Image Data

€4 C:¥Proeram Files¥Wincaps2¥HS-E¥H5-E.vis —.. [H[EE3

File | Actions Toolz  Help
7 remet | ] @lev[odla] )

Get Info

Dizplay Screen irayitie
Process Screen

Feceived Image Data

(1)Check image data (A) in the Transfer
Environment Table dialog.

(2) Click on either Transmit or Receive.
The data update check dialog appears
on the screen, click on Yes.

The Transfer Image Data dialog appears.

(3) Set the processing screen (B) and the
drawing screen (C) as the object screen
for transmission. Image data is
transmitted between the processing
screen, specified here, and the teaching
panel.

(Drawing Screen is for Ver.1.6 or later.)

(4) When receiving image data only, set the
Screen Size to either 1/4 screen or 1/1
screen. When transmitting, the screen
size is determined according to the
image data held in the teaching panel.

(5) Click on OK in the Transfer Image Data
dialog box.
The image data is transmitted.
When receiving, images of new image
data are displayed on the teaching panel.
Also, during transmission, image data is
transmitted onto the processing screen
specified.
(When transmitting, the image data on
the drawing screen is not transmitted.)

~ Received
image

(6) After receiving image data, you can
display the drawing screen or the
process screen by selecting the action
menu, and can save image data.
(Ver.1.6 or later)

| Displayed screen
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. ______________________________________________________________________________________________________________|

9.2.54 Image Data Screen Size

Determine the size of image data to be received using the Screen Size setting in
the Transfer Image Data dialog. The 1/1 screen receives all the image data on
the processing screen. The 1/4 screen receives the image data on the
processing screen by thinning the data to 1/4. When 1/4 screen is selected, time
required for data transmission is reduced to 1/4 of the 1/1 screen thus saving
time.

The display size of the teaching panel differs by the screen size. Since the 1/1
screen is about 4 times larger in size than the 1/4 screen, it is not possible to
display everything on a low-resolution personal computer screen. In cases like
this, receive the image data by setting the screen size to 1/4 screen.

When the image data that has been saved is transmitted to the Controller, it is
possible to analyze the same image data. In this case, if image data to be
transmitted is on the 1/4 screen, the analytical result will be different from before,
since the image data is thinned to 1/4.

Note: If the number of possible colors displayed on the personal
computer screen is less than 256, some color errors may be
generated to the image data displayed on the teaching panel.
Although no particular operational problem will result, use a
personal computer screen having 65,535 (16-bit color) or more
colors that can be displayed to ensure correct color display.

9.2.6 Save Image Data As

The Vision Manager can save image data displayed on the teaching panel in a
bit map formatted file. When image data is received from the Controller, the data
image is displayed on the teaching panel. Select Save Image Data As to save
the image data sample.

<Ver.1.6 or later>

The Vision Manager can save image data set on the teaching panel by selecting
“Export”. If the process screen or the drawing screen is selected, composite
image data is saved.

Screen sizes are as follows.

Kind of screen Selection Size
Process screen 1/1 screen 512 x 480
1/4 screen 256 x 240
Drawing screen 1/1 screen 640 x 480
1/4 screen 320 x 240

9.2.7 Open Image Data

With Save Image Data As, the Vision Manager can read the image data saved
in the bit map format and display it on the teaching panel. By transmitting image
data displayed on the teaching panel to the Robot Controller, you can analyze
the sample image that has been saved.
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9.2.8 Print

Prints the set data currently being edited with the Vision Manager.

9.2.8.1 Print Object

e Select All: Selects all of the environmental tables as the object for
simultaneous printing.

e Set: Displays the printer SET dialog box and makes various printer
settings.

e Preview: Enables viewing of the print status prior to actual printing.

e Cancel: Closes the dialog box without printing.

e Print: Prints the table.

e Option: Print options appear.

TIP: To print only specified page(s), click on the printer button | & after
previewing.

Note: If you select more than one object to be printed, Preview is not
usable.
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FR <System Settings> =] E3

LI

W= Managar LT T

<Syavam Saunga ; Mon fil oo - ma_mih
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[
Coman | - lowa mpu leed o | ca_teve i
0 | ca_LevEL M
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Preview Window

4] M| : Moves to the head/tail end of the page.
il LI . Moves to the immediately preceding/following page.
@l . Selects display (Reduction/Standard/Expansion)

=l . Sets print execution
The printing range (specific pages) of an object file can be specified.

Print
Frinter: Swaterm Printer [Canon LBP-730)
— Prirt Range Lancel |

" Pages Copies: I 13:

[ Collate Copies

Print Window
B3| &0l :  Exports the object file.

The selected object file will be converted into the file format
specified in Format and outputted (saved) to the Destination.

E xport [ x|

Format; Deztination;

| Disk file =l

Character-zeparated values

Ok I Cancel |
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9.2.8.2 Option
Selecting the Option tag will display the print options.

Note: Print option is not available from the Vision Manager.

9.2.9 Make Macro Definition File

Prepare the data created using the macro-name-edit function. This function is
used to create the macro definition file (vis_tab.h) in the folder having the vision
(*.VIS) file. By reading the macro definition file into the program, you can use the
macro names entered using the macro edit function.

9.2.10 Import Macro Definition File

Reads the macro definition file (vis_tab.h) and expands in the Macro Edit
Window.

9.2.11 Close

Erases the Vision Manager from the personal computer screen. The vision
manager is not displayed on the screen but exists on the memory. When
restarted from the System Manager, the Vision Manager appears with the edit
data displayed just before the Vision Manager is closed.
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9.3

9.3.1 Connect

Actions Menu

Sets the connection object (edit object) of the Vision Manager. By establishing a
connection, communication with the Controller becomes possible. As a result,
editing of the controller setting (window and search model) and image analysis
can be performed. If set for non-connection, the Vision Manager sets the file on
the personal computer as the object to be edited.
m Tools Connection selection method 1:
@ Click on Actions in the menu bar. The Actions menu
appears.
@ Click on Connect.
The Vision Manager is connected and disconnected
alternately each time this command is issued.
Connection selection method 2:

The connection ON/OFF state alternates also when
you click on g in the tool bar.

Connect

[5eb| o

- Display of Connection State -

The connection state is indicated by the pressed state of CONNECT button
& in the tool bar or a checkmark in front of Connect in the Actions menu.

Disconnected Connected
File actio  |IEey Look File  Actic Tools
gﬁl | Connect I’éﬁ | v LConnect
(5l lafe [Eet |nfo
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9.3.1.1 Edit Object of Vision Manager

The objects to be edited using Vision Manager can be mainly classified into the
following three types:

Type A, editing only the files in the personal computer. After editing, the set
value is transmitted to the Controller.
(Objects: general setting, lookup table, and calibration data).

Type B, editing both the settings of the Controller and the personal computer
files. After editing, the set values are shared between the personal computer and
the Controller by data transmission.

(Objects: Window)

Type C, editing only the settings of the Controller. After editing, the set values
are backed up in the personal computer file
(Objects: Search model).

In the case of Type A, the file on the personal computer is always the object of
editing, irrespective of the connection state with the Controller.

Types B and C have different edit objects, depending on the state of connection.
When connected, Type B selects the Controller information as the object of
editing. When disconnected, it selects the file on the personal computer as the
edit object.

Type C selects the Controller information only for the edit object. Consequently,
editing cannot take place unless connected to the Controller.

4 )

- Relationship Between the e
Connection and Edit Object - | i

File on the personal computer 1:"':—.-. —— | Controller setting
Type A: Type A:
« General settin . i
g ‘/ Q General setting
o Lookup table 3 o Lookup table
« Calibration 8 « Calibration
7~ 2 7~
Type B: K| Object of editing 4 TypeB:
« Window pun differs by the state of o Window puu
connection/non-conn
ection.
Type C: w Type C:
¢ Search model e Search model
L= L=
« Type A edits the file on the personal computer and transmits set value to the Controller.
\ ¢ Type C edits the Controller information and backs it up on the personal computer. /
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9.3.2 Get Info

To edit Controller Types B and C settings, as described in Chapter 9 “9.3.1.1.
Edit Object of the Vision Manager” in this manual, you must read the Robot
Controller information into the personal computer in advance. Without getting
information on the Controller, the Vision Manager cannot correctly edit the Robot
Controller settings.

To get information, connect the Vision Manager with the Controller in advance.
For details on connection the Robot Controller, refer to Chapter 9 “9.3.1
Connect” in this manual.

m Tools Information acquisition method 1:
w Connect ® Click on Actions in the menu bar. The Actions
Gict Info menu appears on the screen.
@ Click on Get Info.
Controller information (window/search model) is
acquired.

Information acquisition method 2:
Click on in the tool bar to acquire same
information.
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9.4 Tools Menu

9.4.1 Options

9-20

Creates the various settings needed by the Vision Manager.
Checking the Create Header File creates configuration macro definition file
(vis_cnf.h).
® Click on Tools in the menu bar. The Tools menu appears.
@ Click on Options.
The Options window appears.

Note: Items that can be edited differ by the user level. As to restrictions
by user level, refer to Chapter 1 “1.3 Security” in this manual.
To change the access level in the middle of operation, refer to
Chapter 4 “4.3.3 Re-Log In” in this manual.

l (u]u] | ko

® Change the set contents.
@ Click OK to register the changed contents.
Click Cancel to invalidate the changed contents.
-If} Oplions E

Look Upl General Setting  Display |

Edit Macro M ame
E dit %o

Edit Search Model
Calibraticn

~ Option
File Expansion Meru

wibomatic snapshot]

=N

Image fnalysis

bk

aK | Cancel |

—__/

0] | Cancel |




Chapter 9 Operating Vision Manager

9.4.1.1 Look-up Table

Click the Look Up tab to set the lookup table characteristics. By changing the
lookup table the user can change the camera image input characteristics,
camera images and processing screen display characteristics. 0 to 4, in the
lookup table, are reserved by the system. 5 to 15, in the lookup table, can be
changed by general users.

g =] Graphic display of characteristics
® Drag scroll bar (A) to display the table of

Lock Up | Generel Seina| Diepey | characteristics in the list (B)

St Tonlehsoirel [Teble? [Teoled [T @ Click the column (C) in the table to display
— 1 0 T characteristics.
- In this example, the graph (D) shows the
] 1 z 74| o5l characteristics of Table 7.

B

Stgndard Takle St o Standard

“

o
)

=

=

E
=)
a3
ma
a
=

-
A4 4

I_I Create Header File \ e
/

l \ /

A Cc D

Input and edit of set value numerals

Tahbleh |Tableb | Tahbleb | Tablek ® Double-click the cell (E) to change the set
241 241 241 e value.
547 242 G 247 247 The ce]l character is dlsplayed in reversal..
@ The input character will then be input
243 E I:[; 2431100 (inserted) in the position in the reversed
244 | 244 299 character.
245 245 245 245
2 AF 2 4F ] 4R AR Copy a standard table
) i @ Click the column (F) in the table to copy the
E standard table.
@ Select the standard table (G).
% Dotior ® Click on Set to Standard (H).
Look Up | General Seting | Displey | The standard table is copied into the selected
Briqt: Tab\eﬂulTab\eW D\Tah\EEU\TahIeEZSIT-‘ table. In this example, 100% is copied to Table
I 1 0 7 254 5.
2 2 1 50 253
i 3 2 6 & Save editing results
. . z_ 1 EE;_H Click OK to save the set value.
EIN v To invalidate the editing results, click Cancel.
Standafd Table: 100% =l Set ta Gtandard |

r CrE-,LﬂE: Header File

|

/ Cancel |
/

—
)

G
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9.4.1.2

General Setting

Click the General Setting tab to make various settings for Vision Board.
For parameter definitions and element numbers, refer to “Appendix” in the
PROGRAMMER'S MANUAL.

Note: If you put a checkmark at Create Header File and select OK, the

parameter macro definition file “vis_cnf.h” is automatically created.
To use macro name with GETENV and LETENV in PAC language,
you must include this file.

#E Options

Look Up  General Setting |D|5p|ay|

Setvalue

Froperty

Camera 1 - shutter mechani

- 1

Camera 1 -lower input leve

Camera 1 -upper input lewve

*

Camera 1 - camera usakle;

-

i}
i}
nao
0
100
i}
0
n

Back to Standard |

[~ Creste Hesder File

Ok

Cancel |
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(1) Shutter method
Set the camera shutter system for each camera.
0: Field shutter 1: Frame shutter

(2) Input upper/lower limit level

® Double-click the cell (A) to change the set
value.
The cell character is displayed in reverse
video.

@ Enter a value. The entered value appears
(is inserted) in the reversed value position.

® Click OK to register the changed value.
Click Cancel to invalidate the changed
value.

@ Click Back to Standard to restore the
default value settings.

Set the camera input level and the camera output signal relationships for
each camera.
By changing the upper/lower limit, the pertinent camera output signal can be
input, in more detail.
Always set the lower limit value to value lower than the upper limit value.
(Upper limit value > Lower limit value)
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(3) Synchronous method
Set the synchronous method in the camera. Since all the cameras are
simultaneously set, it is not possible to discretely change the camera settings.
For internal synchronization, set camera input with the Vision Board internal
synchronous signal. For external synchronization, set camera input with the
camera synchronous signal.
0: Camera internal synchronization 1: Camera external synchronization

(4) SHCORNER setting
Set the SHCORNER command measuring conditions. For details of each
parameter (distance, intervals, width and height), refer to SHDEFCORNER
command.

(5) SHCIRCLE setting
Set the SHCIRCLE command measuring conditions. For details of each
parameter (intervals and width), refer to SHDEFCIRCLE command.

(6) Search time-out time
Set the timeout time for search measurements (SHMODEL command,
SHCORNER command and SHCIRCLE command).
Search measurement error is detected by timeout.

(7) Vision monitor display position
Set the display position with the processing screens (0 to 2) displayed on the
Vision Monitor.
0: Center 1:Left 2:Right

(8) Search compatible mode
Set the kind of search models to be registered.
The search models are classified into two kinds: search mode that does not
require angle measurement and the model that requires angle measurement.
This setting allows you to choose the model kind for registration. If you select
“1” or ”2”, the models that can be registered with one model number to limited
to one kind; thereby, you can increase the number of models that you can
register.
1: Model that does not require angle measurement
2: Model that requires angle measurement
3: Both
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9.4.1.3 Display

Click the Display tab to set the display option between Show and Hide.
This display tab appears when the user level is higher than the programmer.

-ﬁI- Options E

Look: Upl Gererd Setting  Display |

—Option
File Expansion Menu
Autormatic refreshldutomatic snapshat)

] Cancel

¢ File extension menu: Extends the File menu of Vision Manager. For details,
refer to Chapter 9 “9.1.5 Menu List” in this manual.

¢ Auto Update: When you connect the Vision Manager to the Robot Controller
(by selecting Connect from the Actions menu), the Vision Manager obtains
information in the same way as you select Get Info from the Actions menu.
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9.4.2 Edit Macro Name

Edit window and search model macro names and usage. A Macro definition file
is created from the input macro name, which can be used in the program.

Only single-byte characters can be used for macro names, as shown below.
Using any other characters than these, the macro definition file will be created
but it cannot be used in the program.

Characters that can be used for macro name

Single-byte alphabetic
character

AtoZ atoz

(The upper and lower cases are treated with the
same.)

Single byte numerical
character

Oto9

Single-byte katakana

Single-byte underline

® Click on TOOL in the menu bar.

Locls : The TOOL menu appears.
DOptionsz @ Click on Edit Macro Name.
— """"""" The Edit Macro Name window appears.
ST - ® Double-click on cell (A) to be edited.
Edit Windov Characters already entered in the cell are
Edit Search hModel displayed in reverse video. If the cell has no
Calibration characters, the cursor appears.
Image Analysis , @ Input character.
= Input characters will then be input (inserted)
in the position in the reversed character.
® Click on OK to register the changed contents.
: Click on Cancel to invalidate the changed
“vinclomy | Search Model |
contents.
Mo |Usage |N1a|:r|:|
0
1
2
3
$F Edit Macro Hame
Wincow Search Model |
Mo.[Usage |Nlacm
|| 0
1
z
T 3
1
3
B
7 =
OK\ | Cancel
\
Window edit \
A
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9.4.3 Edit Window

To edit the Robot Controller window settings, it is necessary to get the Robot
Controller information on the personal computer, in advance. For the method of
getting information, refer to Chapter 9 “9.3.1 Connect” and “9.3.2 Get Info” in this
manual.

9.4.3.1 Window Editing Tool

Edit the window (register, delete, etc.).

Window edit tool Displays an edit object window.

Qhbject Y¥indow: . . .

Windowl | Bacx._——Displays previously displayed tool.
B = .

i Creates a new window.

Pararneter | Malue

X origin %Deletes an edit object window.

Y arigin . . . .

Soquere - widt Regwsterj—Reglsters the edit object window.

Slephenio ~incle] ___Imput ————|nputs camera images.
Square -angl
Square - mod M—Displays the camera screen.

Displays edit object window information.

- Window -

The uVision board sets the image processing range
window area. The window size is stored on the
uVision board by window number. There are two

’ methods of editing the window; Vision Manager

method and user program method.  Window
information edited by a user program is temporarily
registered. It will be deleted upon turning off the
power. Use care when using this method.

Object of Window
measurement

\- J
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9.4.3.2

New

When newly registering a window, click on New. The Create Window appears in
the window edit tool. To validate this window, you must register the window.

Window edit tool

Edit Window =
Ofjed Window:
[winciow H _ Ba |
Eroperty: —
Parameter  |Walus m“
— _peee | C
Y origin 4|
Scjuare - widh Register
Square - heig 271 Input
Square -angl P |
Souare - mod Carn Imane |

-= Cre

ate Window

Wlind o Mo |1 ill

Shajpe: |Ren:tang|e :l\\ A

@ Click & in the tool bar.
The Window edit tool appears.

@ Click New.
The Create Window dialog box appears.

® Set a window number.
(By default, an unused window number is
automatically set.)

@ Set the window shape (B).
The example screen shows “Rectangle”.

® Click OK.
The default shape (rectangle) is displayed as the
set value (C).
The window shape is displayed on the teaching
panel.
If the Vision Manager is connected to the
Controller, the window shape is displayed on the
Vision Monitor.
To change the shape, refer to Chapter 9 “9.4.3.3
“Modify Windows” in this manual.

® Click Register.
The set value (C) of the window edit tool is
registered in the window.
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9.4.3.3 Modify Windows

Edit the edit object window with the teaching panel. To validate the window after
editing, you must register the window.

(1) Edit with the teaching panel

Window edit tool

E dit "Window

Dbject windon: R
IWmdDW]: j LI

Property:
Parameter  |Walue —
¥ arigin Delete
Y orngin _
Sguare -width Fiagister
Sguare - heig It
Square -

Sguars - Carn Image

Teaching panel

& C:\Program Files\wincapsZAIRA-0000MRA-0000__ = E3

File Actions Tools Help

=] = el e sl e e

Fl

=N
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@ Click on & in the tool bar.
The window edit tool appears.

@ Select window (A) as the object to be changed.
The window shape in the edit object appears on the
teaching panel.
If connected, the window shape appears on the Vision
Monitor.

® If the window shape requires changing to some other
shape, click on the shape change button (C).
Shape after change appears on the set value (B).
The specified shape window appears on the teaching
panel. If connected, the window shape appears on the
Vision Monitor.

@ Drag the window displayed on the teaching panel with the
mouse to adjust the window shape.
When the shape is changed, the new value appears as the
window edit tool set value (B).

® Click on Register in the window edit tool.
The set value (B) in the window edit tool is then registered
to the window.
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(2) Edit by numerical value input

Window edit tool @ Click on /&) in the tool bar.
The window edit tool appears.

F it Window @ Select a window (A) to be edited.
Objedt Window ® Double-click on the cell (B) to change the set value.
Windowl. Cell characters are displayed in reverse video.
Eroperty A @ When you enter a value, it replaces (or is inserted into) the
Farameter |“alue
reversed value.
w P Delete . . . . .
T 4' ® Click on Register in the window edit tool.
Sejuare - wicl? leter g The set value (B) in the window edit tool is registered to the
Sejuare - heig 271 Input window.
Sgjuare - angl w
Sjuare - mor Cam Image |

(3) Teaching window by key operation
Using the teaching panel, the window shape can be fine-adjusted by carrying
out the following key operations while editing the window shape.

Window type Illustration Teaching method
Name
) X Start Point Shift Left/Right [>][«]
@ | WNDDPT End point | Y Start Point Shift Up/Down [1][l]
3 Start point X End Point Shift Left/Right [W][S]
cg_' Y End Point Shift Up/Down [H][L]
;—;. X Start Point Shift Left/Right [—][«]
® | \WNDALN Y Start Point Up/Down [1][{]
Start point e Length Extend/Reduce [W][S]
Angle Increase/Decrease [B][C]
& Startpoint  wyigth X Start Point Shift Left/Right [—][«]
a Y Start Point Shift Up/Down [1][l]
§ WNDRCT Height | Width Increase/Decrease [W][S]
o Height Increase/Decrease [H][L]
o r: Radius
o X Center Shift Left/Right [—>][«]
é WNDCIR Y Center Shift Up/Down [T][{]
T Radius Increase/Decrease [W][S]
gm XR:Width | % Center Shift Left/Right [—][«]
Q= YR YR: Height X 9
52| WNDELP " ™ | Y Center Shift Up/Down []{]
@ © Width Increase/Decrease [W][S]
< M_‘ Height Increase/Decrease [H][L]
¢: Outside Diameter
r:  Inside Diameter
01: Starting Angle
02: Ending Angle
e} X Center Shift Left/Right [—>][«]
o Y Center Shift Up/Down [T][{]
nc—, WNDSCT Inside Diameter Increase/Decrease [W][S]
o N Outside Diameter Increase/Decrease [H][L]
3] Circular Arc r Starting Angle Increase/Decrease [B][C]
Ending Angle Increase/Decrease [M][N]
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9.4.3.4 Delete Window

Delete a window selected for editing.

Window edit tool @ Click on ﬁ in the tool bar.
The window edit tool appears.
@ Select the window to be deleted in the cell (A).
E;Ea”:"""'j ® Click on Delete.
IM;‘Z;;D = —] e | The selected window is deleted.
Property:

Parametel|valus

Width e
Height 108

Fieference i Delete
Reference 1]

: EEgisiEr
hodel size 18708

Rernaining 924672

Input

DLkl

Cam Image

9.4.3.5 Register Window

Register a window selected for editing.

Window edit tool @ Click on &g in the tool bar.
T = The window edit tool appears.
FN?JTEDE‘E'Z ack @ Select the window to be registered in the cell (A).
odell: \d oC
Property ® Edit the window set values (B).
- kMaode . .
P;rametew Walue A @ Click on Register.
et _ tew | The windows set value (B) is registered to the window.
Height
Fieference Delete |
Reference —
hodel size B
Bernaining Input |
Cam Image |
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9.4.3.6 Editing Windows with Teaching Panel

(1) Window size change and shift

To change the window size or shift the window, click on Change-shaft ® in
the shape edit tool bar.

Size change Shift

To change the size, To shift, drag the outer
drag the handle shape

(2) Window rotation

To rotate, click on & (Rotate) in the shape edit tool bar.

Rotate
Handle

=

To rotate, drag the
handle
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9.4.3.7 Projection Window

For window shape parts (rectangle and sector), it is necessary to set the mode.
The mode is a parameter for specifying the window projection shape. It is quite
important when measuring the edge. For measuring shapes, other than the
edge, it is necessary to set the mode = 2 (all projection). When a window is
newly created or a window shape is changed, it is set to mode = 2.

Set the mode parameter according to the purpose.

(1) Rectangle window

Mode = 0 (X-axis Mode = 1 (Y-axis Mode = 2 (total)
projection) projection)
Origin @
Height
Width (No projection)

(2) Sector window
Mode = 0 (projection in Mode = 1 (projection in Mode = 2 (total)
meridian direction) perimeter direction)

(No projection)
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9.4.4 Edit Search Model

To edit a search model in the Robot Controller, it is necessary to get the Robot
Controller information on the personal computer, in advance. For the method of
getting information, refer to Chapter 9 “9.3.2 Get Info” in this manual.

9.4.4.1 Search Model Edit Tool

Edit (register, delete, etc.) the search model. Editing of a search model is
possible only when the Vision Manager is connected to the Robot Controller with
a built-in vision board.

Search model edit tool

Displays an edit object search model.

Edit Search Maodel
Ubject Model: . . .
Modell- j Back j—— Displays the previously displayed tool.
Eropery: : i i iai i
kodel DISj_p Displays the search model images to vision monitor.
Farametal|Valua
‘Wiclth [l ey — Newly creates a search model.
Height
BrlEienme Delete :I—— Deletes an edit object search model.
REferenFE Register:l—— Registers the edit object search model.
Model size 1
Femainine Input j——lnputs the camera images.
Carmn Imﬁgﬂ—— Displays the camera images.

Displays the edit object search model information.

Note: If the Robot Controller is not capable of angle measurement, you
cannot set any data at Offset Angle.
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9.4.4.2 Search Model Reference

Display the search model image registered to the vision board on the Vision

Model size 28144

Monitor.
Search model edit tool 5 @ Click on & in the tool bar.
The Edit Search Model window
E;ean::}-.-iu:ll appears_
M;ZZED = @ Select a search model to be
Property: . referenced in the.cell (A).
S —— Madel Disp | ® Click on Model Disp.
idth 00 New | The search model image appears
Height 100 on the Vision Monitor.
Feferance X Delete |
e D |
Input |
_ Cominege |

Cam Image

Display to the vision monitor

Search model image

\ Reference pOSition

Monitor display frame
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9.44.3 New

Use the New command to register a search model. When the search model is
newly created, the search model edit tool shows the range of images to be
registered to the vision board. To register the search model image to the vision
board, a registration process is required.

® Click on & in the tool bar.
The search model edit tool appears.
@ Click on New.
The Create model dialog box
appears.

B @ Setthe search model number (A).
(By default, an unused search model
number is automatically set.)

@ Click on OK.
Default search model data appears
as the set values (B).
The search model shape appears on
the teaching panel.
The shape also appears on the vision
monitor if the Vision Manager is
connected with the Robot Controller.

Search model edit tool

Ohject Model:
[Modein:

Property:
Eroperty Model Disp
Delete

Farameter |value

Width it

Height 100

Reference X 50

Feference Y 50

Offset angle 0

Model size 2a144 Input

Back

Hegister

o [oeck ]
[ vk |
]
(=D
[ P |
o rex |
4I

Cam Image

- Create Model
el M |2 :Il

| 0K \i\ Cancel |

A

Teaching panel

File  Actions Toolz Help

® Drag the search model shape
displayed on the teaching model with
the mouse to adjust it.

[ @ o e R e e When the shape is changed, the
value appears as the search model

= edit tool set value (B).

Jci — When changing the shape, refer to

v |7‘ Chapter 9 “9.4.4.5 Editing Search

£ Model with Teaching Panel” in this

L manual.

2 ® Click on Register.

= Register the image, in the range
specified with set value (B), in the
search model edit tool, to the vision

Digplaw/Process

Object/Process

board.

9-35



9.4.4.4 Delete Search Model

Delete the edit object search model.

Search model edit tool

Edit Search Model
Object Model:
[Modeln:

Property: \

Parameter | alue \
‘Width 100
Height 100
Reference X
Referance ¥
Dffset angle

Model Dizp |
New |

Delete |
Fegister |
Model size 28144 - Input |
Cam Image |

\

A
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@ Click on & in the tool bar.
The Edit Search Model window
appears.

@ Select the search model to be
deleted in the cell (A).

® Click on Delete.

The selected search model is
deleted.
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9.4.4.5 Editing Search Model with Teaching Panel

(1) Changing size and moving the search model

Change size Move

To move the search
model, drag the
frame.

To change the size,
drag the handle.

Handle %

(2) Changing the offset position

Change the offset position

To change the offset
position, drag the
cross.

(3) Changing the offset angle

Change the offset angle
O

To change the offset
angle, drag the long
bar of the cross.

(4) Search Model Teaching by Key Operation
When editing the search Model shape with the teaching panel, the search
Model shape can be fine adjusted with the following key operation:

Width

Start point X Start Point Left/Right [«1[-1]
Y Start Point Up/Down [MN]

o Width Increase/Decrease [WI[S]
Height Increase/Decrease [HI[L]
Reference point X Offset Left/Right BI[C]

| Height Y Offset Up/Down [MI[N]

| Offset Angle Increase/ Decrease [ |][D]
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9.4.5 Calibration

9.4.5.1 Camera Calibration Tool

Camera calibration tool Specifies the object (white/black) to be measured.

A

Displays the binary coded level used for
measuring the center of gravity.

[zl _ Specifies where the point is registered.

Camera Calibration

- Calibration Data

Begistration |Pgm|1 /—}{
Edit Mo~ [0 ~Wision Paint I Returns to the previously screen.
Obied:/ﬁﬂj/ & Black &I— . . . o
oot Bimellemst sdib Displays Binary Processing Registration Tool
e | [ Lower 22 s || _camion Executes calibration
ltern Paint 1 F ’
| igher 255 N
Vision X i Higher =etWind et | Obtains camera image.
Wision v 0 <« Get | teasure o — )
Riohot i Displays camera screen
Foboty' i} i Ropot Point
Fobat 2 d anshle P Mo, |0 :ll
= | \ Displays the cross cursor.
ﬁl Sets Window.
B Measures the center of gravity in the Window.
L4 ™ . .
B h Specifies the P variable number to be obtained.

\ Obtains the Robot Variables.
Obtains the vision coordinates.

Lists the coordinates (for editing and display of teaching point).

Displays the calibration conversion coefficient.

9.4.5.2 Camera Calibration Procedure

The camera calibration tool calculates the coordinate conversion coefficients
from the robot coordinate values, corresponding to the coordinate values of the
three points of vision.

The camera calibration tool manages 32 different sets of camera calibration data
(edit No. 0 to 31) and calculates the coordinate conversion coefficients,
according to the procedure described later. The vision coordinates, robot
coordinates, and coordinate conversion coefficients are registered with the
calibration number specified in the edit number (A).

Camera calibration is as follows:

Positioning at 3 places
J L
Specifying calibration No. In the Edit No. grid (A)
L
. ) Refer to “9.4.5.3 Entering Vision
Entering vision coordinates Coordinates”
Enteri ) Refer to “9.4.5.4 Entering Robot
ntering robot coordinates . "
Coordinates”.
L _
Calculating coordinate conversion Refer to “9.4.5.5 Executing Camera
coefficients Calibration”.
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9.4.5.3 Entering Vision Coordinates

There are the following three methods for entering vision coordinates:
(1) Numerical Input Method
(2) Cursor Input Method. This method is a method of marking while checking
the images on the vision monitor screen (cursor)
(3) Measurement Input Method. This method uses the center of gravity data,
in the image, as the input value by using the image analysis function
The following are the procedures of the above methods.

The points refer to the three points for calibration. Coordinates in the three points,
of the vision and the robot coordinates, can be correlated with each other by
point number.

(1) Input of numerals

. A @ Double-click on cell (A) to input the vision
Itern Point1 B~ X coordinates.
Wisionx 7 0i B The cursor appears in the cell.
“igion /a/ @ After entering the numeral, it is input

(inserted) to the cursor position.

Robot = . ® Pressing the Enter key registers the
Fobot Y 0 numeral.
Fobot £ I @ Input the vision coordinates in cell (B) for

the vision Y coordinates, using the same
2 steps as above.

® Click on (C) in the scroll bar.

ftern Point 2 F The 2 point cells appear.
“ision = 1] ® Hereafter, input the vision coordinates (X,
Vision i Y) for points 2 and 3, using the same
Robot < 0 steps as above.
Rokbot 0
Robot £ 0

/h
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(2) Cursor input

You can enter the vision coordinates while observing the camera images
using the cross cursor.

Eegistration IPDim‘]

= BN

—%ision Point
Object: ¢ White & Black A
Binary Level
Lower: Cursor | \
Higher. SetWwindow | B
<< Gt :l heasure |

Cc

/ Cross cursor

List of coordinates

® Enter the camera images to the
processing screen.
@ Display the processing screen with the
camera image on the vision monitor.
® Select Point 1 at Registration (A) where
the coordinates are to be entered.
@ Click on Cursor.
The cross cursor appears on the teaching
panel and on the vision monitor.
® Move the cross cursor by dragging or key
operation. Set the cursor to the target
coordinates.
® Click on Get (C).
The cross cursor coordinates are entered
in the vision coordinates of Point 1 set at
Registration (A) (and displayed in the
coordinate list).
© Enter the coordinates of Points 2 and 3 in
the same procedure.

Key operation of

e Fomtl  |F cross cursor
Wision 2 il
ision 0 [«<] [>] Cross cursor shift
left/right
Faobot % i}
@) @) Robot 0 [?1 [1 Cross cursor shift
Fabot 7 0 up/down

Vision monitor
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(3) Measurement input
Center of gravity can be obtained from the camera image, through image
analysis, and entered as the vision coordinates.

Begistration |F’|:|in11
Vigion Paint

"l

® Enter the camera images to the
processing screen.

Dhject C White @ Black T~ p @ Display the processing screen with the
B Binary Level camera image on the vision monitor.
Lower [120 Gusor_| ® Select Point 1 at Registration (A) where
Higher [255 ] setwindosy | the coordinates are to be entered.
<< Get | Meaaure\l ™~ C @ Set ObjeCt (B)
N ® Click on Set Window.
D A window appears on the teaching panel.
A window appears on the vision monitor.
® Shift or adjust the window position by
dragging or key operation.
@ Click on Measure.
The Vision Manager measures the center
of gravity in the window and displays its
position on the vision monitor.
Click on Get (E).
Measured center of gravity coordinates
are entered in the vision coordinates of
Point 1 set at Registration (A) (and
displayed in the coordinate list).
® Enter the coordinates of Points 2 and 3 in
the same procedure.
| Window List of coordinates Window teaching
[ 2 : by key operation
ltern Foint1 |F
Wision % I |[€][>] Window shift left-right
Wisian ' 0 [N [¥]  Window shift up-down
@) @) Fobotx a [W][S] Window width increase-
Fobat Y n decrease
Riohot 2 0 [H] [L] Window height increase-
decrease
Vision monito\ H

Center of gravity
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9.4.5.4 Entering Robot Coordinates

Input the robot coordinates with either of the following two methods:

(1) Input numerals directly

(2) Use the coordinates stored in the P variables of the robot, as the input
values.
The following are the procedures of the above methods.

Note: Always input the robot coordinates at a position corresponding with
the input point number of the vision coordinates.

(1) Numeral input

Itern Poirt1  |F
Yision X 0
Yision v a
Fobot = 0 A
Faoboty 0 B
Fobot 2 0 ¢

o —

[tem

Faint 2

I

“ision =

Yision

Fuobotx

Eobot™’

Rohot £
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® Double-click on the cell (A) of the robot X
coordinates.
The cursor appears in the cell.

@ When entered, a value is inserted at the cursor
position.

® Press the Enter key to register the entered
value.

@ Enter the robot Y coordinates (B) and robot Z
coordinates in the same procedure.

® Click on the scroll bar (D).
The Point 2 cell appears.

® Enter the robot coordinates (X, Y, and Z) of
Points 2 and 3 in the same procedure.
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(2) Variable input
Coordinates stored by the P variables of a robot can be used as the input
values.

® Select Point 1 at Registration (A) where the
Begistration  |Point 1 = .
iebon Pa \k A coordinates are entered.

_ _ @ Specify the P variable number where the point
. Oblf':t |  Whie  © Black coordinates are stored at Variable P No. (B).
inansLeve ® Click on Get (C).
Lower[128 | &l The robot variable coordinates are entered in
Higher[255 ]| setwWindow | the robot coordinates of Point 1 set at
Registration (A) (and displayed in the
«Get | Messure | B coordinate list).
E=ST=—— @ Enter the robot coordinates (X, Y, and Z) of
_ — Points 2 and 3 in the same procedure.
“ariable P Mo. |D =
<< Get :I

Coordinate List

It Foint1  |F
YWisian ¥ I}

YWigion 0
Fobot = 1
Fobot v 0
Fobot 2 1

o —

Note: When entering variables, connect the Variable Manager to the
Robot Controller. The personal computer can get the robot
variables via the Variable Manager. If the Manager is not connected,
the computer cannot get the current robot position.
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9.4.5.5 Executing Camera Calibration

When you execute camera calibration, the Vision Manager calculates the
coordinate conversion coefficients from the entered vision coordinates and the
robot coordinates. Then, the Manager stores the calculation results in the file
specified on the personal computer. To register the calibration data to the
Controller, you need to transmit the data to the Controller from the personal
computer.

When the calibration data is transmitted to the Controller, only the coordinate
conversion coefficients are registered to the Controller. You can convert the
vision coordinates of user program into robot coordinates using the coordinate
conversion library.

The coordinate conversion library converts the coordinates using the coordinate
conversion coefficients registered in the Controller.

LI Y LS WS

Coordinate: | Lower[1Z8 | cusor | [T Eaimraton

[term Faoint 1 F :

ision 737 Higher 255 | Sethdowl Input }

— A
“ision M 224.0714

<< Get keasure

Fobat % 555 5655 | | 4“&”” Image
Fobot -2.04930 —Rohot Faint

Rokot Z 105 Vatiable PNo. [z =

|!| ‘ >| << Get |

F= 3519625 Ry =-218.3685 .RZ =105
Ox= 89225305 0% = 1%583545[!2 LOZ=10

\

® Click on Calibration (A).
Coordinate conversion coefficients are calculated and displayed in B.
The coordinate conversion coefficients are saved in a set file on the personal
computer.

@ Transmit the calibration data to the Robot Controller from the personal
computer.
For the transmit method, refer to Chapter 9 “9.2.5 Transfer” in this manual.
When calibration data is transmitted, all the data is transmitted in a batch.
When executing calibration at several points, execute calibration of all the
points, and then transmit the data to the Robot Controller.

ERIDN

B

Notes ©: If the error message “Improper coordinate data” appear during
calibration, check the coordinates of all the points and enter
them again.

@: If you change the coordinates, always press the calibration
button to recalculate the coordinate conversion coefficients.
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9.4.6 Image Analysis
9.4.6.1 Image Analysis Tool in General

[1] Common Button Functions

Buttons shared by each tool are arranged in the image analysis tool. The shared
buttons include Input and Cam Image.

Click on Input, and the Vision Manager enters the camera images to the
processing screen under the condition set using the camera input tool. The
Manager displays the obtained image data of the processing screen on the
vision monitor. The same result can be achieved by clicking on Input in the
camera input tool.

Click on Cam Image to display the image of the camera number set in the
camera input tool on the vision monitor.

Goodnates ™ 1;\:: — ‘C?“hmﬁpng/ Caera input tool
I\t/?:mx Puoint1 232|F ﬂ\gher SotWindow T |r'|FIL,It Input Camera
Wision Y 224.0714
Robotx 5555685 <Gt | Measure | ml QﬁmeraNnthamer 1 j . Back i
Robot Y -2.043341 Robaot Paint
FobotZ 105 ( Vericbie PNo, [T =] Cam Image Lock Up:[100%(0) \ -] ot |
H — \
P = 351.9625 R =-216.3685 .RZ = 105 = *
Op = 9225306 ,0% = 1.368364E-02.02 =0 B
Input Screen: |Frocess 0
; s
<
[2] Object of Image Analysis Camera number
Main window The image analysis tool analyzes the image data stored on
T A - T the processing screen. At this time, the analysis tool
[ @) o mm| 28] @]tz alm) measures the processing screen indicated at the status of
= the main window. By entering camera images with the
E’ camera input tool (Input), the processing screen to which
e image data is entered is selected as an object to be
= processed. When the processing screen appears with the
= image display tool, the displayed processing screen
- — Status becomes the object for processing.
DisplCamt_ ([obiiPe0 | )

[3] Process Time

The image analysis tool displays the processing time required for measurement
in terms of milliseconds. However, since the minimum intervals of measurement
for processing time is 10 (milliseconds), time under 10 (milliseconds) cannot be
correctly displayed. For example, if actual processing time is 35 milliseconds,
the image analysis tool displays the time as 30 (milliseconds). Moreover, if the
processing time displayed on the image analysis tool reads 0 (millisecond), the
actual processing time would be 0 to 10 (milliseconds) or less.

[4] Measuring Result

To display the measurement data, bring focus to an object in the list of
measurement result of each window.

Note: When you execute image analysis, the screen mode (such as character size) of
the pVision board changes. Therefore, when you run a user program after
image analysis, you may obtain unexpected results. In this case, make
corrections by setting the necessary points in the user program.
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9.4.6.2 Camera Input

[1] Camera Input Tool

This tool inputs images from the camera to the processing screen.

Camera input tool

3

i Batk——

[t —|——

Camera ND:ICﬁmerﬁ1 j

Laook Up:lwﬂ%(ﬂj 'I

I_nputSErEBn:lPrDceEs ] "I

Selects the camera of which image is taken.
Displays the previously displayed tool.

Inputs camera images to the processing screen.

™~ Specifies the lookup table used for input.

Specifies the processing screen where camera images are stored.

[2] Input Video Image

Input Camera

Camera ND.:IC eral j
Loaok UpiITZ [T (1)] \ 'l

1npu13cn%n PrDDBE\D
K

;N\

A

taken.

on.

B

@ Click on /M| in the tool bar.
The camera input tool appears.
@ Select the camera number (A) from which image data is

® Select the look up table used for display in the cell (B).
@ Select the input screen (C) to store the camera images

® Click on INPUT.
The camera images are input to the processing screen.

~

The pVision board internally handles image data as a group
of individual points, one of which is called pixel.

The uVision board handles 512 x 480 pixels (lengthwise x
widthwise) in the storage memory (processing screen), and
624 x 480 pixels (lengthwise x widthwise) in the dedicated
drawing memory (drawing screen).

- Pixel - )

4 ™
- Brightness -

Each pixel of image data processed by
the uVision board has a value (0 to 255)
that represents brightness (in 256
steps). This value is called brightness.
As the number gets close to “0”, the pixel
becomes darker. As it gets closer to 255,
the pixel becomes brighter.

512 624
) 4 N
Process result 255
480 Ex 480 | O <: ﬂ
0
Processing screen Drawing screen Processing screen
. J Y,
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9.4.6.3 Selecting Display Screen

[1] Display Screen Tool

Select a screen (camera, processing screen and drawing screen) to be display
on the vision monitor.

Display screen tool

_Selects the drawing screen to display.

~ Ciraming . . .
Qisplalerawmg ] j Displays the previously displayed tool.

- Camera and Processing Execute | Selects the vision monitor display for a specified screen.
Digplayl@amera1 g.

\

Lok Ual70% (1 = Selects the camera screen or processing screen to display.

Selects the lookup table used for display.

[2] Selecting Vision Monitor Display

Display screen tool @ Click on &g/ in the tool bar.

Display Screen The display screen tool appears.
*DfﬂW'_ng : @ Select the drawing screen as the screen to be displayed on
Q'Sp'ﬂﬂD’aW"?‘ [ the display screen (A).

~Camera and Procgssing Exacite | ® Select the camera screen or processing screen to display
Dizplay] Canieral -
\

with the display screen (B).
/ \ @ Select the lookup (C) table used for display.
® Click on Execute.

Select the vision monitor display for a specific screen.

Laok Ualfos: (17

/N N

A

Note: After image analysis, the Vision Manager automatically changes the
display screen setting (A) on the display screen tool so that
drawing screen 1 will appear, where measurement result is drawn. If
the current setting is Drawing 0, the setting will be changed to
Drawing 0+1 after image analysis.
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9.4.6.4 Binary-coded Registration

[1] Binary-coded Registration Tool

Register the binary-coded level with the image analysis tool.

The detection method for the binary-coded level includes manual and automatic
methods (mode method, discriminant analysis method and P tile method).
Optimal condition can be verified by using the binary-coded register tool.

Binary-coded register tool Selects a window that specifies the range of processing.
Binar ion

tect Binary Processing Level Selects the select mode for binary-coded level.

Histogram Process Range: Back . . .
indowll [| Displays the previously displayed tool.
i3] Changes the vision monitor display to the normal display.
Detection Methad " Bina . . . . .
ry Dt ~
Detecion Mode —a'l— Changes the vision monitor display to binary-coded display.
[Pt biethow [ ﬂl— Binary-codes the currently displayed processing screen.
FEZT'DCE“'”Q LE"EJ T‘lijﬂeﬁ&ﬂ [Beteattovell — pgtects the binary-coded level if detection mode is set to auto.
B : - Histogram . .
Jower ﬂL Otject & W Black ‘ Displays a histogram.
t .
/ \ _mpa ] Inputs camera images.
Cam Image | .
/ Displays the camera screen.

N\

Specifies the reference area to be used by P tile method.
Specifies the measuring object of an area to be used by P tile method.

Specifies binary-coded Specifies binary-coded level.
level manually.

Displays the histogram.

4 . . Image data input from the camera to the A
- Binary-coding -

uVision board has 256 gradations of
brightness per pixel.

Binary-coding refers to rewriting the
brightness of each pixel into white or black,
Before being based on a threshold borderline value.
binary-coded

@ Such threshold value is called the

binary-coded level. The pVision board
specifies the binary-coded level with two

binary limits, the lower and upper limits.

Values greater than the lower binary limit
After being
binary-coded

\_ binary-coded as white (1) and other values )

and to the upper binary limit are

Note: Only the oblong window can be selected for processing (angle = 0).
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~

- Histogram -

Here, histogram refers to the counting of the frequency of appearance of
brightness values, for a range specified by the window of the image data
input from the camera. When graphically displayed, the histogram provides
ease of understanding the distribution state of brightness, which makes it
easier to determine the binary-coded level, when image data is being
binary-coded. Moreover, the uVision board provides a function for
automatically determining the binary-coded level. This function determines
the binary-coded level by using the histogram.

Figure 1 shows the histogram of image data before it is binary-coded,
showing that the object and background are separated into two portions.
Figure 2 shows the result of binary-coding, on the different binary-coded
level, the lower limit (lower limit of binary) and the upper limit (upper limit of
binary) are adjusted to produce different binary-coding results.

Fig. 1

Fig. 2
Brightness 55 Lower Upper Lower Upper

o Z
X C
© 3

g

o
S — gt gt

ground
Before binary coding After binary coding After binary coding
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[2] Binary-coded Level Registration

(1) Manual

Binary process registration tool

in: 0
~D cessing Level

Historarm

Binary Processing Lewel Feferance Area
Higher, ——— |
Lower, —— |— \ Object & WWhite ©Elal

[=]
Frocess Bange: Back
Wi clonQ Vi
Normal
Binary Data.

Execute

Dietection Method
Detection Modea:

Binary Frocessing Lewel

Hicher J
Lower J
VAR
D

Cc

(2) Automatic

Binary process registration tool

Bi Process Registiation

[=]

inary q
~Detect Binary Processing Level
Histogram

Binary Frocessing Lawvel

Higher.

) =
— [

Lower

Frocess Fange Back
Wincowd: VI

Morrmal
Binary Data.
Execute
Detect Leval

Histogram

Detection Method
Detection Mode:

PHile Method

Reference Area -
l =
Object ﬂhkr Bl

\\ \\
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@ Click on # in the tool bar.
The binary process registration tool appears.

@ Select a window for measuring the histogram with
process range (A).

® Set the detection mode (B) to Manual.

@ Click on Histogram.
The histogram appears.

® Drag the slider (C) and set the lower Ilimit of
binary-coding level.

® Drag the slider (D) and set the upper limit of
binary-coding level.
Sliders (C and D) can be dragged (changed) only
when the detection mode (B) is set to Manual.

@ Click on @ in the tool bar.
The binary -coded register tool appears.

@ Select a window for measuring the histogram with
the process range (A).

® Set the detection mode (B) to automatic mode (mode
method, discriminant analysis method, and P tile
method). If you are using a method other than the P
tile method of detection, this is the end of the
procedure.

@ Specify the reference area (C) used for the P tile
method.

® Specify the object (D) of the area to measure with the
P tile method.
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[3] Selecting Display

The binary-coded register tool can display the camera screen and the process
screen currently displayed on the vision monitor in a binary-coded format.

In binary-coded display, it is possible to check the binary-coded results without
having the actual data binary-coded.

Binary process registration tool ® Click on @ in the tool bar.
The binary process registration tool appears.
@ Click on Binary Data.
The Vision Monitor display changes to binary code.

[x]
Histogram FProcess Range: Back |

Wind ow(: j

Normal Set detection mode (A) to Manual and change the
Detection Methed Binary Defe binary-coded level by dragging sliders (B and C).
l% Erociie Then the display of vision monitor is updated with the
Binary Frocessing Level ReferenceXea Dete:tLeve\l binary_COded Ievel aﬂer the Change'
Higher [ = i ® Click on Normal. The vision monitor returns to
Leszs —{— Otject & WiXe € Ainek — normal display.
\ \ \ Cam Image
\\ \\ \\
B 'C A

e ™
- Result of display selection -
Normal display Binary-coded display
\. y,

9-51



[4] Binary Process Registration Screen

Converts the specified range of the currently displayed processing screen to the
binary codes.

Binary process registration tool

Binary Process Reagistration

~Detect Binary Processing Level

Histogram

Frocess Fange:

Wi chowl: v'l
Detection Meth

Detection Maode:

Binary Processing Level

Higher. '_J
Lower —— ——

[=]

Back

Normal
Binary Data.
Execute
[Defactiieye]
Histagram
Input
Cam Image

[S] Detecting Binary-coded Level

@ Display the processing screen to be binary-coded on
the vision monitor by using the monitor display.

@ Click on & in the tool bar.
The Binary Process Registration window appears.

® Select a window for specifying the binary-coding
range at Process Range (A).

@ Click on Execute.
The specified range of the processing screen is
binary-coded.

( )
- Result of binary-coding -
Before binary After binary
coding coding
\ J

Automatically detect the binary-coded level of the processing screen currently

on display.

Binary process registration tool

Higtogram

Frocess Fange:
inclonvt: j Vl

Datection

[=]
Eack

Bormal
Binany

IManua\

Reference Area:

Binary Processin
(Hinher

Lowver

Dietection method
g Level 77—
bzl

i Execute :I
[Defectlewel

Histagram
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@ Display a processing screen where you want to
detect the binary-coded level using the monitor
display tool.

@ Click on @ in the tool bar.

The Binary Process Registration window appears.
® Select a window for detecting binary-coded level with
processing range (A).

@ Set detection mode (B) to auto (mode method,
discriminant analysis method and P tile method).
For detection mode other than P tile method,
proceed with step after @.

® Specify the reference area (C) to use for the P tile
method.

® Specify the object area (D) to measure with the P tile
method.

@ Click on Detect Level.

The histogram appears.
Displays the detected binary-coded level at (E).
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9.4.6.5 Area, Center of Gravity, and Principal Axis

[1] Area, Center of Gravity and Principal Axis Measuring Tool

Measure the area, center of gravity, and principal axis in a specified window.
Set the binary processing level to use with the image analysis tool using the
binary-coded register tool.

Area, center of gravity and principal axis measuring tool

Area. Gravity Center. Principal Axiz

~Measuring Condition

Specifies a window for specifying the range of measurement.

Objsct Wincdow: Iwmdgwl] — -

Measuring I2—Principﬁl;-‘xx\5 j
Object. = \White l"ﬁla:k\

M Displays the previously displayed tool.
MI— Displays the window edit tool.

Edit Binany |— Displays binary-coded register tool.

Execute I— Measures the area, center of gravity and principal axis.

Birary Pru:}gﬁing Lewveal \
’V Lawear: [128\ | Highar [255  \ |
AN \ \
N\ \ \
Result \
tems NGesulis\

&I— Inputs camera images.

Cam Image |— Displays camera screen.

Frocessing Time [ms) \ \
Area

Grawvity Center =
Gravity Center Y
Angle

Integrate Brightness

Displays the result
of measurement.

\

Specifies the object being measured.
Displays binary processing level.

Specifies the object being measured (white/black).

~

- Brightness integration value - Brightness integration value

Window refers to the sum of the
brightness values of every

pixel, within a range specified
100/100{100{100|100

by the window, of image data
100(|100{100{100[100| input from the camera.

20 (20|20 |20 |100
20|20 (20 |20 (100
20 (20|20 | 20 |100

Brightness integration = 100x13+20x12=1540
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- Area -

Window

Area refers to the counting of white (1) or
black (0) pixels in the range specified, by
the window, after binary-coding the image
data is input from the camera. The result

is the number of pixels. With the uVision

board, the area is measured by

binary-coding the brightness of every
\\ pixel in the window in real time without

1 (white) area =
E 0 (black) area =

changing it, so it is not necessary to

13 binary-code image data in advance.

12

- Center of gravity -

X
Window

/

Object \ .
Center of gravity

The object from the image data input from
the camera forms a plane. The center of
gravity refers to the point at which the weight
of an object on the plane would remain in
equilibrium.

The uVision board obtains the center of
gravity from white(1) or black (0) pixels
within the range specified by the window
after image data is binary-coded. The center
of gravity is expressed with X coordinates
and Y coordinates.

- Principal axis angle -

Major

axis
Minor
axis

0

X

=== \
Window Object

The object from the image data input from the
camera forms a plane. When this planar
object is rotated, the longitudinal axis around
which the object rotates best is called the
major axis of the principal axis and the axis
that intersects it orthogonally is called the
minor axis. The uVision board defines the
angle (theta) from the horizontal axis (X-axis)
to the major axis of the principal axis as the
angle (0) of principal axis. The angle of
principal axis is obtained in from white (1) or
black (0), object in a range specified by the
window after the image data is binary-coded.
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[2] Measuring Area, Center of Gravity and Principal Axis

Area, center of gravity, and
principal axis measuring tool

@ Click on ﬂ in the tool bar.
The Area, Gravity Center, Principal Axis
measuring window appears.
The window shape appears on the teaching
panel and the vision monitor.

@ Select object window (A).
The range of the specified window shall be the

Area Grawiy Center Principal Axis

~heasuring Condition

Olsjact Wineowe [windown S _ Back |

T — A

Measuring IE—PrmCipal A 'l EditWindDWI

object of measurement.

Object & White ¢ Black . B
Emaw;fmef_m - EcitBinary | ® Select measurement mode (B).
{ Lower [128 \ | Highar [255 | Execute | Select the object of measurement from Area,
\

Center of gravity and Principal axis.

@ Select object (C).
Select object for binary-coded measurement
from White and Black.

\ |
Result \
lerns Results Cain| |age
\ 390

Processing Time [ms)

Area 160218

Grawity Canter ¥ 248.0182 ® Click on Execute.

ff‘g‘;;‘yoe”'e’v Ll The processing screen, of the current object

Ineqrate Brighiness 40472380 being processed is measured, and the results

' AN are displayed in the measuring results (D) list.
The vision monitor displays the result of
processing.
D cC
e A\

- Result of measurement -
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9.4.6.6 Labeling

[1] Labeling Measuring Tool

Measure the labeling in a specified window.
Set the binary-coded level to be used with the image analysis tool using the
binary-coded register tool.

Labeling measurement tool

Specifies the window used to specify the range of measurement

{ With.
~Measuring Canditian

Ohject Wmdmwiwmdnwn

|

Sont MDdEi 1-Area, Des:endin‘g\Ordej

Area Luweri[l

Object  * \Whita

&l— Displays the previously displayed tool

M-I— Displays the window edit tool.
M— Displays binary-coded register tool.

Measures the labeling.

Binary Pmc:hgsing Lersel \

[ Lower, [128 | Higher. [255  \] Input
B |

Result \ \ L
Ite m General \lLabeIT}\ |Lab‘
Processing T 260
Label Numbe 48
Area 7278
Gravity Cente
Gravity Centa
La-THOREREREN B R

4 : \ » -
A \

Inputs the camera images.

Displays the camera screen.

Specifies the display sequence of measurement results (labeling
order, descending order of area, ascending order of area)

\

Displays the result
of measurement

Grants the labeling order if greater than this area.
Displays binary-coded level.

Specify the measuring object (white/black)

Vs

~N
- Labeling -
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Labeling refers to the numbering process of the concatenated areas of white (1) or black
(0) pixels after binary-coding image data input from the camera. (Refer to Fig. 1) Labeling
enables you to separately handle multiple objects that are present in the area specified by
the window.

With the uVision board, area, center of gravity, angle of principal axis, fillet shape and
circumferential length are obtained as the characteristics of respective objects upon
running the labeling. The fillet shape refers to an oblong that circumscribes the object.
(See Fig. 2) The circumferential length refers to the counting of pixels that constitute the
external shape of the object. (See Fig. 3)

Fig. ZO/Origin of fillet

)

Fig. 1 Fig. 3

| External
shape

S

Window

Circumferential
Length = 12 pixels

\

Object Width of fillet Height of fillet

J

Note: Only the oblong window can be selected for processing (angle = 0).
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[2] Measuring Labeling

Labeling measuring tool

~keasuring Condition
Oisject Window]\window: \ =

Sort MDdEi 1-Area Deac\ind\qg Orde j
I~

Avea Luwerin

Ohject | « YWhile

Binary Procgssing Lewve
( Lower |1§4
1

\ 1\

/ \
Result / \
/ \|Lat\

0

Cam Image |

=]

Back |

Ed\tWindle
Edit Binary |

8
\
C

ltem General |Lab\:|ﬂ
D
Fesult

¥
\
B

A

PrncesswrﬁT 260
\ 4
\
E
[term General

Lakell

|

Lahel Nufnbe

Ared /

Gravity[:ente

Grawt}/CenlE

l;) 5 :f-l N

Frocess time [ms) 130
Label numhber 33
Area
G-center =
G-center

/
J7 \

120

11201
2h4.5717
231.0651

0 A AT

|

@ Click on ®a] in the tool bar.
The labeling measuring tool appears. The window
shape appears on both the teaching panel and the
vision monitor.

@ Select an object window (A).
The object of measurement shall be the range of the
specified window.

® Select the sort mode (B) from Labeling Order, Area
Descending Order, and Area Ascending Order.
Measuring results are displayed in the specified
order.

@ Specify Area Lower Limit (C).
Labels greater than the specified area are measured.
This setting allows you to disregard minor objects.

® Select Object (D).
Choose an object for binary-coded measurement
between White and Black.

® Click on Execute.
Measures the processing screen currently being the
object of processing. The number of measured
labels is displayed in the Measuring Result List (E).

@ Click on the respective label grids (F) under Result.
Detailed results of the clicked table are displayed in
the table under Result and the vision monitor.

- Measurement result -
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9.4.6.7 Edge

[1] Edge Measuring Tool

Measure the edge in a specified window.
Use projection window (mode = 0 or 1).
Read 9.4.3.7 “Projection Window."

Edge measuring tool

Specifies a window to specify the range of measurement with.

MDisplayS the previously displayed tool.

- Displays the window edit tool.
Edlthdnwl

EdiTBiﬂﬁ_l_w Displays binary-coded register tool.

M—Dlsplays the measuring condition and set screen.

Giraph Displays the distribution graph screen.
Execute | Measures the edge.

~ Measuring Conditian

Ohjact Wmdmwiwmdnwa-

Qetec‘fmniﬂ-ﬁnghmess Absn\{e

Edge Object| »whole \\

Leve\imﬂl

Scannino Dy * Positiva \C Hegaie
HianiEiacesaNm lLewva]
|V Lower: Hicher:

K0 JEANEY

Result \\\ > o Inputs the camera image.
ltems Gene\@\\ |Resu|tl] ‘ RéQL - .
Processing T 0 Ca Displays the camera screen.
[Wumker of De 1
s 158
\: \ 14 = Specifies the edge detection system.
O\ \ Specifies the object edge to detect (black—white, white—black, all).
\ \Specifies the level for detecting edge (brightness, area).

Specifies the scanning direction of the edge.
Displays the binary-coded level during area measurement.

Displays the result of measurement.

- Edge -
In wVision board, edge refers to a point at which an
Window object in the specified window changes from
darkness to brightness (black to white) or from

| brightness to darkness (white to black).
_\ The position of the edge detected by the pVision
Edge board refers to a point at which the brightness in the

window or the area value meets the specified level

w value. To specify the level value, an absolute value
@ or differential value is used depending on the
5 circumstances of the object. The absolute value
A detects the position at which brightness or area
> Position value passes a spemﬂt_ad Iocatlo_n. The_d|fferent|al
value detects the position at which variation of
Absolute Differential ~ brightness or area is greater than the specified
A Value A value value.
@ o
@ @
= =
> =]
8 2 O: Edge detect positi
7] . ge aetect position
- J

Note: Windows that can be selected with the object window are those
where the edge can be measured (straight line, oblong {mode =1,
0}, sector {mode =1, 0}).
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[2] Measuring Edge

Edge measuring tool

Edge
~Measuring Condition

Object WimdawiwindDWS

QETEd\DniU-EI’ighTHESS Ahiulute \

Edge Objact]2-whols \ \ \

Back

Eclit Wiinc o

14

Edit Binary |

[ KN IR

i

Lavell1 28
Scanning Dir & Podjtive \ ¢ Megat

|—El|nary Eracessiiol

Lower

SetScreen

Graph

Execute

\\ \ \ \

IResult \‘ \(e }j\ ‘\h \ Input |
tems General Fksul BsL,
Processing T a0 \ x—‘ Camlmagel
Mumber of De mn
* \ 184
A 14 -
[
VLl L
F EDC B A

4 )

@ Click on #4| in the tool bar.
The Edge measuring tool window appears.
The window shape appears on both the teaching
panel and the vision monitor.

@ Select Object Window (A).
The specified window range is to be measured.

® Select Detection System (B) from among Brightness
absolute value, Brightness differential value, Area
absolute value, and Area differential value.

@ Select Edge Object (C) from Black—White,
White—Black, and Whole.

® Specify Level (D).

® Choose the projection window scanning direction
between Positive and Negative at Scanning Dir (E).

@ Click on Execute.
The Vision Manager measures the currently selected
processing screen and displays the result in the
Result table (F).
The processing results appear on the vision monitor.

- Measurement result -

EEEEEEEEEEEN
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[3] Distribution Graph

The edge measuring tool can display the distribution graph of a measured

window. According to this distribution graph, variation of brightness in the

window and the area can be checked. By linking the distribution graph and the

distribution data display, brightness and area of the graph-specified point can be
A checked with ease.

_ﬂ Displays distribution graph
® Click on Graph.

BlighiticzzltbiE Rk EEER A distribution brightness graph appears. At this
time, Brightness Distribution Graph appears as
Edit Windawr the title (A)

The brightness integration and area appear as
the distribution data (B).

Edit Binany

EE
EEE
[ By
_SetSareen |

Set Screen

Selection of graphic display
@ Click on Integrate Brightness grid (C) of
Sl Distribution Data (B) or Area grid (D).

Injut When the Brightness Integration grid is clicked on,
the brightness distribution graph appears.
Conversely, when the Area grid is clicked on, the
area distribution graph appears. The currently
displayed data name (Brightness Distribution
Graph or Area Distribution Graph) appears at the
title (A). At this time, the marker (E) appears at the
B distribution graph at the position corresponding to
the projection position of the clicked grid.

Distribution Data

Projection | Inedxate B Area,
0

Cam Image

3

[ gl (BN SN R Y ) o

Projection Brightness Area

position C D F
Read the distribution data of a graph-specified
Brightness distribution Back pomt_ . L. i .
e ® Click on the point of distribution data (F) desired

for reference in the distribution graph.

The cursor (G) appears at the clicked point in the
Edit Binany distribution graph.

The brightness integration and area of the point

Editvindiow

Set s
G - clicked on in the distribution graph appear in
Erepls Distribution Data (H). At this time, the projection
Distribution Data " position corresponding to the clicked point is

Projection | Brightness |Area
0 252
253
2hd
254

254
24 iz -|

\

displayed in reverse order.

Input

A

Cam Image

| e || —
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Chapter 9 Operating Vision Manager

[4] Setting Measuring Conditions

Level

Specify the level at which to detect the edge. If the detection system
is based on brightness absolute value and differential value, specify
brightness (0 to 255).

If the detection system is based on the area absolute value and
differential value, specify area value (0 to 512).

Binary
processing
level

If the detection system is based on the area absolute value and
differential value, specify area value (0 to 512).

Values greater than the binary value lower limit of the binary value
upper limit shall be judged as white.

Scanning
direction

Set the edge scanning direction.
The definition of + and - directions differ by window shape.

Mode = 0 (X-axis projection)

<Oblong window> <Straight line

(between 2 points)>

Mode = 1 (Y-axis projection)

Origin o + Start point
SAS + direction
8|8 \A
Height 2 &
g3 V\
- direction
Width End point
+ direction
- direction
<Sector> <Straight line length>
Mode = 0 (Projection in Mode = 1 (Projection in Mode = 2 (All)

meridian direction)

- Stmangle

direction of circumference)

Origin

- direcm ° /;rection - direct:n\

Origin
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9.4.6.8 Model Search

[1] Model Search Measuring Tool

This function searches and measures the specified search model inside a
specified window.
It is necessary to register, in advance, the search model used for measurement.

Model search-measuring tool Specifies the window where you specify the range of measurement.

Model Search
— Measuring Condition

Object Window]\window:
Search Modeli Modell:

Back —|-—Disp|ays the previously displayed tool.

EditWindtl——Displays the window edit tool.

Edit'*"0‘19’—|-—Displays the search model edit tools.

11—Performs search measurement.

LCoincidence XiBD

Dietection Qniti 0-Pixel \

Detection Mumberh

b Lp el L L

Start angle :ID \ \ N

End angle:[360 \ N\ \ = —Reads camera image.
Result \ \ | N
ltems Goneral _ YResu N\ Displays the camera screen.
Processing T 260
Number of De 1
B 242 i
v 037 Specifies a search model to search.
Coincidence \ 100 . L

\ \ Specifies the criterion on concordance.
\ \Specifies the rotation range of the object to be searched and measured.
Specifies detection unit (pixel/subpixel).
Specifies a maximum number for search-measuring.
Displays the result of measurement.
N
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4 )

Search refers to searching for a point of concordance, by moving the standard image data
(search model), registered in advance, within the range for search (within the window range) of
the object to be measured. (Refer to Fig. 1) With the uVision board, the standard image data
is called “search model” which consists of image data and reference coordinates (OX, OY).
(Refer to Fig. 2) Numeral to express the degree of concordance between the search model and
measure object image is called “concordance”. If acquired concordance is greater than the
specified value, coordinates for the point of concordance between the search model and the
measure object image can be obtained. The minimum unit for coordinate detection accuracy
for pixel is one pixel. With sub-pixel, measuring result can be obtained with an accuracy of
under one pixel. If measured by sub-pixel, the measuring time will be longer than the
measurement by pixel.
Fig. 1 Fig. 2

Search
‘ E O
IS or

- Search -

Image data OX

/

K Search model Window /

Note: ©: Only the rectangular window can be selected (angle = 0).
@: If the Robot Controller is not capable of angle measurement,
you cannot set any data at Start Angle or End Angle.
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[2] Model Search Measuring

Model search measure tool

® Model search measure tool @_I in the tool bar.

e Congion The Model Search window appears.
thectWindDW1WiﬂdDwD \\ ﬂ Back | The window shape appears on both the teaching
Search Madel| Model: . hd — panel and the vision monitor.
Conziderze 2J70 = @ Select Object Window (A).
Disteciion U] 0Fvel | el ocel_| The specified window range will be the object for
Detection Humber 1 \ \ i measuring.
i AR | ® Select Search Model (B).
. Ered anls. '35”\ \\ \ \ \\\ = @ Specify Coincidence (C).
I GE"E,\ﬂ‘\ N \Esu\m \ m' ® Select Detection unit (D) from Pixel or Sub-pixel.
Frocessing T ® Specify Detection number (E).
;‘“mbem'DE - @ Specify Start Angle (F).
5 ; Specify End Angle (G).
Coincidence 1 D @ Click on Execute.

I

[N The Vision Manager measures the currently
selected processing screen and displays the results
in the Result table (H).

The processing results appear on the vision monitor.

|

H GFE DC B A

- Measurement result -

Search model

B n E
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[3] Setting Measuring Conditions

Object window The range of a specified window shall be the object of measuring.

Runs the search/process inside the window by using a specified

Search model
search model.

Position having the concordance value greater than specified will be

Concordance | |- dled as the result.

Specifies accuracy (pixel or sub-pixel) of the coordinates to be
Unit of detection | search-measured. If measured with sub-pixels, longer measuring
time is required.

Specifies the number of results obtained from a search-measuring.
If the number of results reaches the value specified with the

Maximum ; :
maximum number of detection, the measurement ends normally. If

number of ) . .

detection the number of result fails to reach a specified maximum number,
TIMEOUT error will be generated. In this case, reduce the
maximum number.
Specify the rotation range of the object to be searched and

Start Angle measured.

End Angle The Vision Manager measures the object of which angle from the

origin resides between the preset start and end angles.

9.4.6.9 Reading Code

[1] Code Reading Measuring Tool

Read the QR code in the specified window.

Code reading measuring tool Specifies a window for specifying the range of

measurement.
~Measuring Condtion—————————

Olaject Window] v nclowD: 7| Biack :l'—DispIays the previously displayed tool.
Binary Processing Level ———————— e
Edit Windo Di ; f
. !”_-I—— ispl he window edi l.
I Autamatic Ed\tEhnagﬁl ——— splays the dow edit too
| Ewecuts .
Ddxger. Higher|?55 | Nese==e.z——Runs code measuring.
Measuring Sigs —Inputs the camera images.
ems GF}vqraI |Reier§qce 1|F‘

EoEe T Displays the camera screen.

Number of Ch

Displays binary-coded register tool.

Displays binary-coded level.

Specifies the presence of automatic binary-coded.

Displays the measuring Specifies the presence of automatic binary-coded measuring.
Character string.
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[2] Code Reading Measuring

Code reading measuring

~heasuring Condition

Object Wmdowlwmdc.wu:

N\ Automatic

chaer:
\

|—Eliﬂ ary Frocessing Lewel

Measurhqg Status

ltems \ General |Referenc§g 1|F*

Prcn:essing}\T 330
Number chtl 1

X 1649.5703 204.005

nnnnnnnnnnnn

.

Input |

CamImage | automatic binary processing, set the binary code

® Click on M in the tool bar.
The Read Code window appears.

E The window shape appears on both the teaching
E— | panel and vision monitor.
@ Select Object Window (A).
Eaninduwl The range of a specified window will be the object of

measuring.
® To perform automatic binary processing, check the
Automatic check box (B). If you do not select

level with the binary processing registration tool.

@ Click on Execute.
The Vision Manager measures the current selected
processing screen and displays the status at
Measuring Status (C).
Measured character string is displayed in Measuring
Result (D).
The processing results appear on the vision monitor.

- Measurement result -

_:-'!l'

[3] Setting Measuring Conditions

Al:)tic:]r:ft'c If you select automatic binary processing, the code is read on an
y optimal binary code level.
processing
Binary code Set a binary code level to be used when not using automatic
level binary processing.

9-66




Chapter 9 Operating Vision Manager

9.5 Visually Calibrating Robot Position

This section describes the procedures for visually correcting the robot position.
In the example shown, a series of operations are performed, that includes: ®
Moving the robot to the standby position (P1), @ Moving the robot to the work
position detected with the camera (P2) and holding the work, ® Moving the work
to the pallet position (P3) and unload.

P2 (work)

9.5.1 Work Flow

Set the robot and vision according to the following steps:

Input coordinates (vision,
robot) of points 1 to 3

| Refer to Chapter 9, subsection
9.4.5 “Calibration”

Execute calibration

|
Refer to Chapter 9, subsection
Transmit the calibration 9.2.5 “Transfer’.

data to the robot (register)
I

Edit program

Transmit the program to the
robot

Check the robot motion

9-67



9.5.2 Calibration of Robot Coordinates and Vision Coordinates

To visually correct the robot position using measured coordinates, it is
necessary to convert the vision coordinates to robot coordinates. To do this, it is
necessary to obtain the relationship between the vision and the robot
coordinates, in advance. The work for acquiring this relationship is called
camera calibration. It is possible to calculate coordinate conversion coefficients
(calibration data) by entering the vision coordinates (Vx, Vy) of 3 points (S1, S2,
and S3) determined in the camera field of view (vision coordinates) and the robot
coordinates (Rx, Ry and Rz) of the Vision Manager camera calibration tool.
Once obtained, coordinate conversion coefficients needs to be transmitted to the
Controller for registration. With the user program, convert vision coordinates to
robot coordinates by using the coordinate conversion library (viTran6). The
coordinate conversion library uses the coordinate conversion coefficients
registered to the Controller for converting coordinates.

Vision
Robot coordinates coordinates Ry
\‘ \ R Rx1, Ry1, Rz1: Robot coordinates of
f » ™ | Point S1

Vx1, Vy1: Vision coordinates of Point S1

Vy1 .. S1, S2, S3: Reference points

S Vxl

Rx1
/ &) "
. S Rx1 -
Vy S2 Conversion Vx1
. Ry1 coefficients X vyt
Rx

/ - Calibration Data and Coordinate Conversion - \

Camera calibration data registered to the Controller can be referred to
using the VISREFCAL command. (See Table 1) The coordinate
conversion library converts vision coordinates to robot coordinates by
using the calibration data referred to by VISREFCAL command. (See
equation 1)

Table 1 Relationship between VISREFCAL Command and
Vision Manager VISREFCAL (a,b)

b
0 1 2|1 3|4 |56 |7]|8|9 1|1
a=0to 31 | NX|OX | AX|RX|NY |OY |AY |RY | NZ | OZ | AZ |RZ

Equation 1 Conversion of coordinate conversion library (viTran6)

RX NX OX AX RX|| VX RX, RY, RZ : Robot coordinates

RY| |NY OY AY RY| vy VX, VY . Vision coordinates

NX, NY,NZ : Table 1
RZ| |NZ OZ AZ RZ|| 0 OX,0Y,0Z : Table 1

1 0 0 0 1 1 AX, AY,AZ : Table 1

RX, RY,RZ : Table 1 /
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Chapter 9 Operating Vision Manager

9.5.3 Camera Calibration Procedure

Obtain camera calibration data (coordinate conversion coefficients) according to
the following procedures. This operation will complete preparation for running
visual robot position correction.

:Ry1

Ry @ Input vision coordinates (Vx1, Vy1) of Point S1 and
the robot coordinates (Rx1, Ry1, Rz1) for Point 1 of

the camera calibration tool.

Rx1

Rx
Ry2

pRY @ Input vision coordinates (Vx2, Vy2) of Point S2 and
the robot coordinates (Rx2, Ry2, Rz2) for Point 2 of
the camera calibration tool.

R ® Input vision coordinates (Vx3, Vy3) of Point 3 and the
p Y robot coordinates (Rx3, Ry3, Rz3) for Point 3 of the
camera calibration tool.

Rx3
v . O I

Rx @ Click on Calibration of the camera calibration tool
and calculate calibration data (coordinate conversion
coefficients). Refer to Chapter 9 “9.4.5 Calibration” in
this manual.

Rx, Ry: Robot coordinate ® Transmit the calibration data (coordinate conversion

Vx, Vy: Visual coordinate coefficients) to the Robot Controller. Refer to
Chapter 9 “9.2.5 Transfer” in this manual.
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9.5.4 Program Example

The following program list represents an example of visual robot position
correction. Take note on how to use the coordinate conversion library. This
program enables you to check the method for moving a robot by converting the
coordinates measured with vision to the robot coordinates.

Program List “PRO1”

“Robot position correction”
#INCLUDE "dio tab.h"

o\

Specify the 1/0 macro definition file.

PROGRAM PR1

TAKEARM

TAKEVIS

CHANGETOOL 1 'Set the tool for vision calibration

MOVE L, P1 'Move to the standby position (P1)

VISSCREEN 1,0,1 'Specify drawing screen0O as the object screen for drawing
VISCLS 0 'Clear drawing screen0

VISOVERLAY 1

CAMIN 1,0,0

VISWORKPLN 0

VISPLNOUT 0,1

WINDMAKE R ,1,512,480,0,2
VISMEASURE 1,0,0,1,1,100,255

'Display drawing screen(

'Input camera images to processing screen0
'Specify process object to processing screen(
'Display processing screen0

'Set window

'Measure center of gravity (work position)

IF VISSTATUS (0) = 0 THEN
Fl = VISPOSX(0) 'Store vision coordinate X to F1
F2 = VISPOSY (0) 'Store vision coordinate Y to F2
P2 = P1 'Copy the data of standby position attitude
CALL viTran6 (0, F1, F2 , P2)'Convert vision coordinates to the robot coordinates

(by using “0” of vision calibration data)

APPROACH P,P2,100

MOVE L, P2 'Move to the position measured by vision

GOSUB *ChuckItem 'Part chuck

DEPART L, 100 - -
APPROACH P, P3,100 Cgordlnate _convgrsaon library
MOVE L, P3 'Move to pallet P3 position “VITra.n_SG” IS reg!Stered to
GOSUB *UnchuckItem 'Part unchuck the Vision class in the

program bank. To convert

DEPART L, 100 . .
coordinates, add the library

CHANGETOOL 0

END IF

GIVEVIS

GIVEARM
END

*ChuckItem:
SET IO[ioChuck]
RESET IO[ioUnChuck]
RETURN

*UnchuckItem:
RESET IO[ioChuck]
SET IO[ioUnChuck]
RETURN
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Chapter 9 Operating Vision Manager
. ______________________________________________________________________________________________________________|

9.5.5 Executing Program

Execute the program according to the following procedures:

® Create a new project.

@ Create a new program and input the program from Chapter 9, subsection
9.5.4 “Program Example” of this instruction manual.

® Add the “viTrans6” library to the project from the program bank.

@ Define macro names “ioChuck, ioUnChuck” to be used with the hand chuck
for general output of the DIO Manager.

® Create the DIO Manager macro definition file.

® Create the execution program.

@ Transmit the program to the Controller.

® Teach the robot standby position (P1) and the pallet position (P3).

® Check the program motion.
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9.6 Help Menu

The Help menu provides explanation on how to use WINCAPSII.

Help

Lizenze ey

About Syztem Manager

Fig. 9-8 Help Menu

9.6.1 About Vision Manager

Displays the version information on Vision Manager.
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‘—
Operating Log
Manager

This chapter describes the WINCAPSII software
Log Manager that is used with the personal
computer teaching system.







Chapter 10 Operating Log Manager

10.1 Outline of Log Manager

10.1.1 Outline of Functions

The Robot Controller holds the record of operation as a log. The personal
computer teaching system Log Manager inputs this log to the personal computer
and controls it in batch. The Log Manager can run log search, display graphics,
or reproduce action with the Arm Manager, error monitor, etc.

It can implement the initial stage of the maintenance operation from a remote
location by using the communication function.

Start Log Manager by clicking on button of the System Manager or from the

WINDOW menu.
When started the Log Manager window will appear on the screen.
The Log Manager window displays the logs as described in the following:

10.1.1.1 Document

Click the Document tab to record the history of maintenance operation, service
operation, etc.

Note: As for the history of program changes, users are recommended to
record changes in document in the project setting of the PAC
Program Manager. Refer to 5.2.5.1 “Document”.

i® C:\Program Files\WINCAPS 25\ RA-D000MBA-D000 log - Log Mana... =] E3

File Edit Actionz Taool: Help
A2 2| | | w || =] ]

f Cormrm. log ? Warsion Tf Error detection ? COrmm. spec. )
‘Document! 3/ Errar log ? Operation log 'i/ Control log 1

Use this area to mainly record the results of
maintenance or services.

Fig. 10-1 Document
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10.1.1.2 Error Log

If an error is generated during robot operation, this log records the content of the
error together with the time of generation. To acquire the error log, run the
operation given in 10.2.5 “Receive Data” and receive the Error Log from the
robot controller.

il C:AWINCAPS2\PROJECTAYM-6070D\WM-6070D log - Log Manager M=l E3

File Edt Acton: Tools Help

e N S N L A A

™

[ Camm. Log T YWersion T Error Detection T Camm. Spec.
Dacument T Error Log T Qperation Log T Cantrol Log 1
Mo, | Date |Time |Mudule |C|:|de |Message -]
114920000616 160627 26700 | J4 encoder phase B
120) 20000616 160627 24884 | J4dencoder cahle dis
12120000616 160627 26701 | J5 encoder phase B
122| 20000616 160627 24885 | J5 encoder cakle dis
123 20000616 160627 25702 | JB encoder phase B
124| 20000616 160627 24886 | JB encoder cahle dis_l
125 20000616 160627 2hazd | J3 encudernhaseisill
1 3 =

Fig. 10-2 Error Log

10.1.1.3 Operation Log

10-2

Click the Operation Log to record the content of operation from the teach
pendant. To acquire the operation log, run the operation given in 10.2.5
“Receive Data” and receive the Operation Log from the robot controller.

il C:AWINCAPS2\PROJECTAYM-6070D\WM-6070D log - Log Manager M=l E3

File Edt Acton: Tools Help

[ DD 3| = || @] =] ]

[ Camm. Log T YWersion T Error Detection T Camm. Spec.

™

Diocument T Error Log Téoperatinl I.ngg’l/ control Log
Mo, | Date |Time |Client |CDde |Operati|:|n canten
54| 2000061/ 160625 -26010 | Mode setting

h5| 2000067160627 -26010 | Mode setting

hE| 2000067 160627 -26043 | kMachine lock OM
h7| 2000067160631 -26010 | Mode setting

58| 20000617 161407 -2B032 | Setting cammuni
hY| 2000067161407 -26032 | Setting communi
BO| 2000067 161415 -2B032 | Setting cammuni
R112NNNNART TR141R =2RN32 | Seting commini

Fig. 10-3 Operation Log
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10.1.1.4 Control Log

Click the Control Log to record the command value, encoder value, current value
and load ratio for each respective operating axis. Although the number of control
axes differs by model, the record for the number of control axes is retained. To
acquire the control log, run the operation given in 10.2.5 “Receive Data” and
receive the Control Log from the robot controller.

i C:\WINCAPS2\PROJECT\VM-6070D\VM-6070D log - Log Manager  [I=] E3

File Edt Action: Tool: Help

£ D3| 7] = | w|f@] R K|

[ comm Log |  wersion | Error Detection | cComm. Spec.
Document | Errorlog | OperationLog | Comtrol Log |

Mo J1 - Command value|J1 —Encodervalue|J1 —Currentualue|J1ﬂ
0 0 a

a
1]
a
a
a

"ol
| o H

Fig. 10-4 Control Log

e B = L o s e e
L s e e s Y e
o s e e s Y e

10.1.1.5 Communication Log

This log is used for checking the status of communication. It is the same thing as
the communication log in Communication Manager.

To acquire the communication log, run the operation given in 10.2.5 “Receive
Data” and receive the Communication Log from the robot controller.

i C:\Program Files\WINCAPS 2\IRA-D000MBA-0000.log - Log Mana... =] E3

File Edit Actions Tools Help
I e B LA A=

|/ Document T Errar Log T Cperation Log T Comtrol Log
‘Comm. Log T Wersion T Error Detection T Comim, Spec. |

—ROBOT alk Communication Recaord

Total Mumber of Transmitted Packets:
Total Mumber of Received Packets:
Mumber of Transmitted MNAKs:
Mumber of Received MAKs:

Mumber of Received MNAKs (Standby):

Mumber of Timeout Errars:

L R s R o N N s N

Fig. 10-5 Communication Log
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10.1.1.6 Version

Records the version of each respective section of the Robot Controller. To
acquire the version log, run the operation in 10.2.5 “Receive Data” and receive
the Version Log from the robot controller.

i C:\Program Files\wINCAPS 2\IRA-0000M RBA-D000 log - Log Mana... [Hi[=] E3

File Edit Actions Tools Help

ot | w || R &

( Diocurment T Errar log T Ciperation lag T Zantral log
Camim. log ] Mersion: T Error detection T Camim. spec.

kodule name Yarsion

<R0M wersion> 0.0.0

klain board 000

DIO board 000

“ision board .00

Dewvice netboard .00

Teaching pendant IRIRI]

Operation panel 0.0.0

PAC languade processing module |0.0.0

Interim code processing module  [0.0.0 B

Fig. 10-6 Version

10.1.1.7 Error Detection

If an error occurs, the error detection lamp in the Log Manager window changes
from green to red and the detected error appears in the Search conditions (C)
dialogue box.

The error detecting conditions correspond to the error detection settings in the
Set dialog box which is displayed using the Set command in the Tools menu.
Clicking on Program starts the application specified as the start program in Error
detection of the Set dialog box.

For information regarding Error detection in the Set dialog box, refer to 10.5.1.4
“Error Detection”.

Note: No error is detected unless the error and monitor buttons are turned
ON.

i® C:\Program Files\WINCAPS2\RA-00005RA-0000.10g - Log Manager M=l E3

Fil= Edit Actiohs Tool: Help

P 1 | L L A
[ Document T Error Log T Cperation Log T Control Log

camrmn. Log T Warsion TErrurDete(tiunl Camm, Spec.

Error detection lamp ~Detail of Detected Error

Green: No error -

Red: Error detected o Error_| |
L

Search conditions (C)

dialog box

Program start — |

—
Program | B

Fig. 10-7 Error Detection
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10.1.1.8 Communication Specifications

Click the Comm.spec.tab to record the contents of the Robot Controller
communication setting. For communication use, run the operation in 10.2.5
“Receive Data” and receive the Communication Application Log from the robot

controller.

i€ C:\Program Files\\WINCAPS 2\IRA-0000\RBA-0000.log - Log Mana... [l=] E3

File Edit Actions Toolz Help

£ 0|0| | »|w| & =] &

f Diocurment T Errar log

T Cperation log T Contral log

Camim. lag T Yersion T Errar detection T Comm. spec-i
Froperty Yalue
Time-outtime (msec) 4000
Mo, of retrials on occurrence of time ]
Mo, of retrials on ococurrence of MAE 1
D10, Communication right 2
RS232C(1). Communicatian right 2

RS232C(1). Baud rate

RS232C01). Parity (0: Even, 1: Nane 1

RS232C(1). Data length

RS232C01). Stop bit (0: Thit, 1: 1.5h0it 1]

Fig. 10-8 Communication Specification
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10.1.2 Tool Bar (Log Manager)

10-6

Tool bar

i C:\Program Files\WINCAPS 25\RA-D000\BA-0000.log - Log Mana... [l[=] B3

File Edit Actions Toolz Help
T glolel ol »x (s ]

f comim. log ]f WYersion ]’ Error detection T Comm. spec.
Document; T Errar log T COperation log T Contral log

Use this area to mainly record the results of
maintenance or services.

Fig. 10-9 Tool Bar

£ CONNECT button: Establishes connection to the Robot Controller. When
connected, this button is displayed as if depressed.

SNAPSHOT button: Records the current status of the Robot Controller
once.

MONITOR button: Records the status of the Robot Controller in succession.
| RECEIVE button: Receives the Controller data.

:l CONTROL LOG START button: Starts the recording of the control log at the
Robot Controller. This serves the same function as the STOPLOG
command in the PAC command set.

Ll CONTROL LOG STOP button: Stops the recording of control log at the
Robot Controller. This serves the same function as the STOPLOG
command in the PAC command set.

1it| CONTROL LOG CLEAR button: Erases Robot Controller control log record.
This serves the same function as the CLEARLOG command in the PAC
command set.

®| CONTROL LOG MOTION REPRODUCTION (1 cycle) button:
Reproduces robot action for one cycle using the Arm Manager based the
command values recorded to log at intervals of 8 msec.

|&|] CONTROL LOG MOTION STOP button: Stops reproduction motion if the
control log motion is being reproduced.

&4 CONTROL LOG GRAPHIC button: Graphically displays data recorded to
the Control Log.
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10.1.3 Basic Usage

During monitoring

Connect to Robot
Controller

l

Select and receive a
log desired to acquire

l

Log analysis

Refer to “10.4.1 Connect”.

Refer to “10.2.5 Receive Data”.

Refer to “10.3.9 Search on Grid”.
(Another tool may be used as an option)
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10.1.4 Files to Be Managed

The Log Manager manages log files (*.LOG) as shown in Fig. 10-10.

X

Log Manager

3

Fig. 10-10 File Managed by Log Manager

10.1.4.1 Log File (*.LOG)

10-8

A log file stores the log information of project.
Since log information is stored in separate files for each project, the log

information can be managed without confusion even when multiple projects are
involved.

The extension of the file reads “.LOG”.
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10.1.5 Menu List (Log Manager)

The command menu of the Log Manager has the following tree structure:

File
New *1
Open *1
Save
Save As *1
Receive
Print
Import
Export
Close

Edit
Undo
Cut
Copy
Paste
Delete
Select All
Search
Replace
Search on Grid

Actions
Connect
Snapshot
Monitor
Begin Control Log
End Control Log
Clear Control Log
Reproduce Control Log Action
Graph Control Log

Tools
Options
Analyze by Control Log
Servo Joint Graph

Help
About Version

Fig. 10-11 Menu Tree of Log Manager

*1: To be displayed only when the file extension menu of the display option is
checked. To set the display option, re-login on the programmer level, select
Tool, Options, and View, and then check the option file extension menu.
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10.2 File Menu (Log Manager)

The Log Manager File menu is used for managing files of saved logs.
A file used for saving the content of a log is attached with “.log” as the extension.

File Edit Actions Tool

Hew

Dpen... Cti+0
Save Chil+s
Save Az

EECEwEL Bl

Print... Ctrl+F

Imnport
Export »

LCloze

Fig. 10-12 File Menu

10.2.1 New (Programmer Level)

Newly creates a LOG file for saving the contents of a log. The extension reads

Jog”.

“

10.2.2 Open (Programmer Level)

Opens an already existing LOG file.
When the standard Windows dialog box appears, select a log file to open, and
click on Open to open the file.

kOpen

Lok ir: |'!3 lra-00000 j il i S

|Fi-0000.log

File name: Open
Files of type:  |LOG file[*.ag) =] Cancel

Fig. 10-13 Open Dialog Box

10.2.3 Save

Saves the contents of the current log to the currently selected file.
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10.2.4 Save As (Programmer Level)

Saves the content of the current log to a new file.
When the standard Windows dialog box appears, select a path, input the file
name, and click on SAVE to save the log data.

Save As

Laook in: I'a Ira-0000 j Al Sk
IF&-0000.log

File name: Qpen
Files af type:  |LOG file[*lag) =] Cancel

Fig. 10-14 Save As Dialog Box

10.2.5 Receive

Receives log data in the Robot Controller.

This command can be operated using Receive.

When the Receive Table dialog box appears, check select the desired item and
click on Receive.

The log data is input to the personal computer.

2 Receive Table |

— Transter Tahle .
{Er“:lrLl:“H} ................................................. < HECE'VE
<Operation Log>»

<Control Log>
<Communication Log>
<ersions

<Communication Specificatic

<Servo Joint Log»

Cancel

Select All

[ Flash area

Fig. 10-15 Receive Table Dialog Box
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10.2.6 Print

Prints each log.

10.2.6.1 Print Object

When the Print Manager dialog box appears, check select the desired item and
click on PRINT.

Clicking on PREVIEW allows the printed image to be reviewed on the screen.
Check selecting the optional PRINT LINE NUMBER adds the line number for
printing.

B Print Manager [ x|

Print Dhjec:tT Opaticn ]

Frinter Canon LEF-430
~FPrint Object

| ErrorLog

| | Operation Log

| Control Log

| |"ersion

|| Communication Spec.

Print Cancel Fresiew Set

Fig. 10-16 Print Manager Dialog

e Select All: Selects all objects for printing simultaneously.

e Set: Displays the printer setting dialogue and makes various printer
settings.

e Preview: Allows the user to see the print format before actual printing.
e Cancel: Closes the dialogue box without printing.

e Print: Prints variable tables.

¢ Option: Displays printing options.

TIP: To print specified pages only, click the printer button | after
previewing. You may specify the print range in the printing
preview.

Note: If you select more than one object to be printed, Preview is not
usable.

10-12
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E Yersion =] E3

5

Lag Managear 199901 07
<Veaaon'~
modalc 1ame Yemon
=R raionT [IFFTRIE RS L]
oo bood 1 000 0zl 90E
DY boad 1 000 0831998
Yinoo bood F 3 IR R R
Dricc oo bood 1 000 0831998
Techiog peadem
Cpamen pmd
FéC lmpumgs pras=nag meduls V1 d el el bod
Towamlim mds pioc=aiop oaduls 1213 030999
Taul pab pmesaog oodul: 1220 10e1 2l 900
[ p—
Communicunn piocanng madule 12012 09cs0e] 9o
P\:ndml.plu:l:ulng madule 1220 10el el 9o
Yinoo dan pioang madule 1250 09l 590
Vinoo caexn pleeanng madul=z 1 000 1ol el 9oE
[ | 020 00a a1 002 LI
101 [ ] ] [cancel] S|e9|c0][close] 20124 Tax

Fig. 10-17 Preview Window

4
4 Moves to the immediately preceding/following page.
Selects display (Reduction/Standard/Expansion)

Sets print execution

il . Moves to the head/tail end of the page.
L

W=

The printing range (specific pages) of an object file can be

specified.

Frinter: Swztem Printer [Canan LEP-730) ak.

Cancel

Frint B arige
£ Pages Copies: I 13:

From: | L 3 v Collate Copjes

Fig. 10-18 Print Window

B3| & : Exports the object file.

The selected object file will be converted into the file format
specified in Format and outputted (saved) to the Destination.

E xport

Farmat: Destination:

| Disk file =l

0k I Cancel |

Fig. 10-19 Export Window
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10.2.6.2 Option

Selecting the Option tab will display the print options.

!__, Print Manager

PrintObject |  Option |

™| Erint Eantihueus!iy
v Erirt i E

Frint Cancel Frewview Set

Fig. 10-20 Option Tab (Print Manager Dialog Box)

e Print Line No.: Selecting this with a check mark will print the selected
program together with the line numbers.

10.2.7 Import

Reads "Servo Single-Axis Data Log" data stored in the CSV format. The
read data can be displayed graphically with "Servo Single-Axis Data Graph"
on the TOOL menu.

The Windows standard dialog box appears. Select a desired file and also select
a read file, then click on Open.

10.2.8 Export

Stores "Servo Single-Axis Data Log" data in a CSV-format file. The stored
file is available for "Import" on the FILE menu or another application.

The Windows standard dialog appears. Select a path, enter the file name, and
click on Save.

10.2.9 Close

Ends Log Manager.
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10.3 Edit Menu (Log Manager)

This EDIT menu has the standard editing menu functions as are in any
application software used for Windows 95.

2l Actioh:  Tool: Help

Lndo Chrl+
Cut Chrl+=
LCopy Chrl+C
Fast Chrl+#
Delete Del
Select Al

Search... Ctrl+F
Replace... Ctrl+H

Search on Grid Chrl+l:

Fig. 10-21 Edit Menu

10.3.1 Undo

Cancels immediately preceding operation to "document" to restore the original
status.

10.3.2 Cut

Cuts out a selected range of data of the “document.” Cut data can be used by
the Paste command.

10.3.3 Copy

Temporarily stores the selected data in the Error Log, Control Log, Version,
Error Detection, and Communication Specification. Data temporarily stored by
copying can be used in the PASTE command.

10.3.4 Paste

Temporarily stored data by cutting-out or copying is pasted to a specified
location in the “Document.”

10.3.5 Delete

Deletes the selected data in the “document.”

10.3.6 Select All

Selects all the data displayed when the “Document” tab is clicked on.
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10.3.7 Search

10-16

Searches for the specified character string in the “document.”
When the Retrieve dialog box appears, specify the necessary item and click on
Find Next. Detected character strings are displayed in reverse.

i Search
Eind What [| >| | Find Next

Object Search IAII TI Cancel

& Document
" Selected Range

0.

[T kdatch Case

Fig. 10-22 Search Dialog Box

e Find What: Input the desired character string for search here.

e Replace With: Input character string desired for replacement here.

o Search Direction: Specify the direction of the search. If All is selected, search
runs downward to the end, then it runs downward from the top of the data.

e Object: Select the range of search; all the document or within a selected
range.

¢ Maintain cases: If you check this box, upper and lower case letters will be
distinguished in searching character strings.
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10.3.8 Replace

Replaces the specified character string in the “document” with the separately
specified character string.

When the Replace dialog box appears, specify the necessary item and click on
Find Next. Detected character strings are displayed in reverse.

Clicking on Replace replaces the character string currently being displayed in
reverse.

Clicking on Replace All replaces every applicable element in the selected object.

& Replace
Find Yhat: I | j Find [N et
Feplace With: | j Cancel

Object Search IAII vI Replace

& Document

" Selected Range Feplace Al

flrel

[™ hdatch Cage

Fig. 10-23 Replace Dialog Box

e Find What: Input the desired character string for search here.

¢ Replace With: Input the character string desired for replacement here.

e Search Direction: Specify the direction of search. If ALL is selected, search
runs downward to the end, then it runs downward from the top of the data.

e Object: Select the range of search; all the document or within a selected
range.

e Maintain cases: If you check this box, upper and lower case letters will be
distinguished in replacing character strings.

10-17



]
10.3.9 Search on Grid

Searches the Error log and Operation log grids.

The basic operation is the same as described in 10.3.7 “Retrieving”, but the field
name is added to the retrieving condition. The search runs for the field specified
in the Field Name box. If a matching character string is found the appropriate
page is displayed.

1 Search on Grid

Eind “What;

Search on Errar Lag

=1l [l Eet

Cancel

Field Name: |paie

eefielie

Object Search |2
v All
£ Selerted Eange ™ Match Cage

Fig. 10-24 Search on Grid Dialog Box
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10.4 Actions Menu (Log Manager)

Commands arranged in this Actions menu can be also specified by the buttons
shown below.

-l Tools Help
LConnect
Snapzhot
Honitar

End Control Log

Clesr Contral Log
FReproduce Control Log Action » Start 1-Step

LGraph Control Log Start 1-Cycle
Stop Step

Beqgin Control Log F5 ‘

A== =] » | n| & K| &[]

Fig. 10-25 Actions Menu and Buttons

10.4.1 Connect

Makes connection for communication with the Robot Controller.

When connected, the menu has a check mark.

The CONNECT button ﬁlworks the same way as the CONNECT command.
When connected, it is displayed as if depressed.

10.4.2 Snapshot

Acquires the instantaneous data from the Robot Controller.
The SNAPSHOT button works the same as the SNAPSHOT command.
To run the snapshot command communication must be set up in advance.

10.4.3 Monitor

Acquires data in succession from the Robot Controller.
The MONITOR button works the same as the MONITOR command.
To run the monitor command communication must be set up in advance.
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10.4.4 Begin Control Log

Starts recording the control log at the Robot Controller.

To run the Begin Control Log command, it is necessary for the communication to
be set up in advance.

The START LOG button :l works the same as the Begin Control Log command.
It has the same function as the PAC STARTLOG command. Refer to “19.2
STARTLOG (Statement)” in Part 2 of the PROGRAMMER'S MANUAL.

10.4.5 End Control Log

Stops recording the control log at the Robot Controller.

The STOP LOG button Ll works the same way as the End Control Log
command. It has the same function as the PAC STOPLOG command. Refer to
“19.2 STOP LOG” in Part 2 of the PROGRAMMER'S MANUAL.

10.4.6 Clear Control Log

Erases the content of the control log at the Robot Controller.

The Clear Control Log button ﬂ works the same way as the Clear Control Log
command. It has the same function as the PAC CLEARLOG command. Read
19.2 “CLEARLOG (Statement)”, Part 2, the PROGRAMMER'S MANUAL.

10.4.7 Reproduce Control Log Action

»STEP 1
»STEP 2

10-20

Prepares the Arm Manager and Log Manager using the following procedure to
reproduce motion by control log:

Click on ﬁl button of System Manager.
The Arm Manager starts.

Set 4| button of Arm Manager to the disconnected status.

STEP 2 STEP 3 Arm manager

el C:\Pragram Fileshwircaps2\RBA-0000%BA-0000.arm - Arm Manager [H[=] B3

File Fdit Action Aew Tool Help

deje| =] e EE

ITypE_p =] @5 oeEso00

L[] ]

L

[T Bl B
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> STEP 3 I Click the button of Arm Manager to enter Monitor status.

Click the El button.
> STEP 4 STEP 4 Log Manager

& C:\Program Files\YwIMCAPS 2\ A-0000M RA-0000.1og - Log Manager [ O] =]

File Edit Actions Tool: Help
A 2|2 v == ®| =] &g

[ Comm log T Wersion ‘i’ Errar detection T Comm. spec
Document T Error log T Operation log T Control log

Ma.|J1 - Cornmiand valuel J1- EncudervaluelJ‘l - Current valuelJ'I -1]
175
176 |
177
174
174
180
181

182 %
[« | _'IJ B

This completes the preparation. Run respective reproduction operation
according to the following descriptions:

Start 1-Step

Reproduces one step portion of the currently selected control log.

Start 1-Cycle

Reproduces robot action using the Arm Manager and the command value
recorded in the control log of Log Manager every 8 msec.

The playback button 2| works the same way as the Reproduce Control
Log-Start 1-Cycle command.

Stop Step

When reproducing the current control log motion this will stop such motion.
The control log motion stop button 22| works the same way as the Reproduce
Control Log-Stop Step command.

10.4.8 Graph Control Log

Graphically displays the data recorded in the control log.
The graph button &4 works the same way as the Graph Control Log command.
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10.5 Tools Menu (Log Manager)

The Tools menu has these commands.

Tools Help

i Optionz...

Analyze by Control Log

Sermvo Joint Graph

Fig. 10-26 Tools Menu

10.5.1 Options

Selecting Options command in the Tools menu and the Options dialog box
appears. Clicking on the table displays the respective option items.

Note: Items that can be edited vary depending on the user level. For
restrictions by user level, refer to “1.3 Security”. For the method of
changing the access level, refer to “4.3.3 Re-Log In”.

10.5.1.1 Monitor

JF Options |
.« | Editn:url Fﬂel Error Detecﬁnnl Displaj:.rl

~Dptions

Timer Intervals: '_,Jl ________ 2000| ms

0] Cancel

Fig. 10-27 Monitor (Options) Dialog Box

e Timer intervals: Sets the data input intervals for monitoring. Initial status is
2000 msec.
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10.5.1.2 Editor

IF Options
Monitor E DTI File | Error Detection | Displa‘yl
—Faont Tah
EUmNﬂmBISystem v| ( Tab Intervals] 3
gizelm vl
—Color
EuregroundlEﬂack v|
Eackgruunlehite 'l
Ik | Cancel

Fig. 10-28 Editor (Options) Dialog Box

e Font name: Specifies font to be used in the document. Clicking on j arrow
opens the list of selection items.

e Size: Specifies the font size to be used in the document. Clicking on j arrow
opens the list of selection items.

e Foreground: Specifies the color of foreground to be used in the document.
Clicking on | arrow opens the list of selection items.

e Background: Specifies the color of background to be used in the document.
Clicking on j arrow opens the list of selection items.

e Tab intervals: Specifies the number of half size spaces for one tab interval.

10.5.1.3 File

-Iil- Options

Monitorl Editori le i| Error Detecﬁ0n| Displayl

~Preload

" Load Log Data from File at Startup

QK | Cancel

Fig. 10-29 File (Options) Dialog Box

¢ Load log data from the file at start: Specifies whether to read past data saved
in the log file when the Log Manager is started.

Note: Reading takes some length of time. The Log Manager automatically
starts when WINCAPSII is started.
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10.5.1.4 Error Detection

Click the Error Detection tab to specify the processing performed upon
generation of an error.

The detection condition of errors displayed in ERROR DETECTION in the main
Log Manager window, conforms to the setting in ERROR DETECTION of the
SET dialog box.

For more information on Error Detection in the Log Manager window, refer to
“10.1.1.7 Error Detection”. For actual error detection, the Controller must be
constantly supervised. Detect errors by turning ON the MONITOR button in the
Log Manager window.

#F Options E3

Monitor | Editor | File £

—Errar Detecting Conditions
& Detect by Error Lamp (Lamp QM)

 Detect by Error Level (Ower SetWalug)  Detection |3_j

—Processing after Detection
¥ Stop Detection
Start Program: |C:‘-,WINCAPSE‘-,BIN‘-,fIaSh.exe

(0] | Cancel

Fig. 10-30 Error Detection (Set) Dialog Box

e Servo error: If checked, executes the PROCESSING AFTER DETECTION
setting when a servo error occurs.

e Control log buffer full: If checked executes the Processing after detection
setting when the control log buffer becomes full.

e Stop detection: If checked, disregards the error after the second time the
same error occurs.

o Start program: If an error is detected, specifies an application to start.
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10.5.1.5 Display (Programmer Level)

Click the Display tab to set the display options between show and Hide.
This item only displays on the programmer level.

-ﬁI- Options E |

Mnnitclrl Editclrl File | Frror Detection |

WIFile Expansion kenu
|1 Automatic refreshiAutamatic snapshof)

0] Cancel

Fig. 10-31 Display Tab (Options Dialog Box)

¢ File extension menu: Extends File menu
For details, refer to “10.1.5 Menu List."

¢ Auto Update (automatic acquisition of snapshot): If you change the window
size or scroll the screen when the Log Manager is connected or in the process
of connection to the Robot Controller, the Manager automatically monitors the

snapshot.
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10.5.2 Control Log Analysis

Performs analysis on the basis of control log data and displays the expected
load ratio, maximum load ratio and expected rotational resistance load ratio of
each respective axis.

a=Analysis Results

J1: Estimated |load ratio = 0%, Max. load ratio = 7.062957 %% (Na. 1)
J2: Estimated |load ratio = 0%, Max. load ratio = 4.048316% (Na. 1)
J3: Estimated load ratio = 0%, Max. load ratio = 21.77763%% (No. 1)
J4: Estimated load ratio = 0%, Max, load ratio = 645607634 (Mao. 1)
Jb: Estimated |load ratio = 0%, Max. load ratio = 4.71852% (Nao. 1)

J&: Estimated |load ratio = 0%, Max. load ratio = 4.71852% (No. 1)

J?: Estimated load ratio = 0%, Max. load ratio = 4.59535824 (No. 1)
J&: Estimated load ratio = 0%, Max. load ratio = 5.38311624 (No. 1)

Estimated Regenerative Resistance Load Ratio = 0%

V¥ Easte Analysis Fesults to Document

Fig. 10-32 Analysis Results Dialog Box

Paste the results of analysis in the document, check (d) and click on OK. The
analytical results of the displayed control log will then be added to the document
described in “10.1.1.1 Document”.

10.5.3 Servo Joint Graph

Graphically displays "Servo Single-Axis Data Log" received from the controller or
imported on the FILE menu.

Note: For details on how to specify the receive data axis number and item,
refer to the Robot Instruction Manual.

% Servo Joint Graph

Position Deviation Current Ratio [#4

offset <] -+ Interval
scale 0.0
[ #=0.135 [%1=6R54.132 [%Fi=nf 541 o
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10.6 Help Menu

Descriptions on how to use WINCAPSII can be viewed using the Help menu.

Help

Licenze Key

About System Manager

Fig. 10-33 Help Menu

10.6.1 About Log Manager

Displays the version information of the Log Manager.
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10.7

10.7.1

New Control Log (Ver. 1.20 or newer)

New Control Log Function

WINCAPSII version 1.20 or newer supports a new control log whose operation
status will change as illustrated below.

Error

occurrence | or ClearLog

Power ON

StartLog
—>

Recording data
(in non-buffer mode)

Recording data
(in ring buffer mode)

ClearLog

Error occurrence Buffer file full

Error recovery StopLog or StopLog

Recording stopped
due to error

Recording stopped
due to full buffer

Saving instructed from the teach Saving instructed from the
pendant or operating panel teach pendant or operating
panel

Saving into flash
memory

N

Log data deletion
instructed from the
teach pendant.

10-28

NOTE: A flash memory refers to an area which preserves data even if power
supply is cut off.

When the power is on, control log is always recording data in ring buffer mode.
The buffer size for this can be specified by the user.

Data recording will be aborted due to an error occurrence (Error 6000's Level 3
or higher) or by StartLog or StopLog.

ClearLog or removing error will start data recording. (ClearLog will be
automatically called up when data is preserved from the ring buffer to the flash
area or to WINCAPSII.) Control log can be fetched only from WINCAPSII.

If recording is aborted, data can be fetched from the ring buffer or the flash area.
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NOTE 1: If the log is switched from a recording stop (recording aborted) to the
ring buffer mode after the removal of an error, data can be fetched until the ring
buffer will stop next. If ClearLog is executed, data can be no longer fetched.

NOTE 2: If the log is switched to a recording stop due to a full buffer by user
operation, it cannot be switched back to the ring buffer mode until it gets
ClearLog.

NOTE 3: If any error occurs during data fetching from the ring buffer, the error
log will not be recorded.

10.7.2 User's Operations While Using Control Log

User's operations which the user performs related to control log are as follows:
- Setting the ring buffer for preserving data. (Subsection 10.7.3)

- StartLog (Subsection 10.7.4)

- StopLog (Subsection 10.7.5)

- ClearLog (Subsection 10.7.6)

- Saving or deleting control log to/from the flash area. (Subsection 10.7.7)

- Fetching control log (Subsection 10.7.8)

- Saving control log to floppy disks (Subsection 10.7.9)
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10.7.3 Setting the Ring Buffer for Preserving Data

You may change the ring buffer settings from the teach pendant or in WNCAPSII.
The ring buffer settings include two types of parameters--control log record
mode and control log sampling interval. The new settings you made will take
effect when power supply is turned on next time.

In Ver. 2.7 or later, it is not necessary to turn on and off the power after the
parameters are changed.

Control log record mode

Any of integers 1 through 24. This parameter specifies the memory space to
reserve for the control log, which is expressed as an integral multiple of
1250 sampling times (logging 10 seconds at 8-ms intervals). Entering 2, for
example, specifies 2500 sampling times.

In Ver. 2.7 or later, modes are expanded to 1 to 24.

NOTE: Depending upon the mode, memory sometimes cannot be secured. If
this happens, an error occurs at the time of project loading. Downgrade the
mode and restart the controller.

Control log sampling interval

Any of 8, 16, 24, and 32. The unit is millisecond.

NOTE: If you specify a value other than the above four integers, the entered
value will be automatically raised to the nearest higher value. (e.g., if you specify
12, the sampling interval will be set to 16.)

Defaults

Control log record mode: 1
Control log sampling interval: 8
The sampling time is 10 seconds.
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Parameter setting procedure from the teach pendant
Access: Top screen —[F2 Arm]-[F6 Aux.]-[F7 Config.]

g o § Us-D Joint WOTO|[ 1

User Preferences [No. of parameters: 66l

20: Encoder pulse count for positioning allow 20

21: Operation end time-out (ms) 5600

22: Control log mode 1

23: Control log sampling time 8

24: Efficiency of gravity effect n

Cancel | 0K
F5: Change the selection, OK: Exit with saving AR} 1/0)

L .&‘ Back | Next | Jurp To | | Change. | |

Setting the Ring Buffer that Preserves Data

Modify the Control log mode and Control log sampling time parameters.

Parameter setting procedure in WINCAPSII
=]

Momitor Cnngl Trajeu:tur:;.rl Servnl Tu:u:ull ‘-.‘-{-’nrkl ﬁreal Displaj;.rl

3 Options

Froperty setvalue
Encoder pulse countfar positianing allowsane 20
Encoder pulse count far positioning allowant 20
Operation end time-out (ms) hBO0
Contral log mode 1
Control log sampling time i
Efficiency of grawvity effect 0
cutlmt function cancellation switch a
Fesered 0

0] Cancel

Setting the Ring Buffer that Preserves Data

Enter into WINCAPSII by 1-Programmer level. Open Arm Manager and select
[Tool] [Options] [Config.]. Set the control log record mode and control log
sampling interval parameters, then send those settings to the controller.
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10.7.4 StartLog

After execution of StartLog, if the

T
ring buffer becomes full, the me Startl.og command
process will be stopped. o

c
That is, the log of process from §</_ .
StartLog to the full buffer state Log s recorded here.
can be fetched.

10.7.5 Stoplog

The current ring buffer can be
stoped at the same time as
StopLog.

10.7.6 ClearLog

Restarts the ring buffer.

Restarts the sampling process which has been stopped with StartLog or
StoplLog.

10.7.7 Saving or Deleting Control Log to/from the Flash Area

If the control log cannot be immediately read in WINCAPSII, then use this
function to take a backup.

Control log preserved in the flash memory is secured even after the power
supply of the controller is cut off.

You may save control log from the teach pendant or operating panel. Deletion
of control log is possible only from the teach pendant.

NOTE: There may be changes of failure in save process due to insufficient flash
memory.

NOTE: If you save control log again after saving it, the log data will be
overwritten.
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Log saving/deleting procedure from the teach pendant
Access: Top screen —[F2 Arm]-[F6 Aux.]-[F11 Log]

Qo § K-D Joint uetTe|[ 1

Control Log Menu

Strtlog  Stoplog ClrLog
[F1] [F2] [Fel
< <
Savelog. DelLog.
[F# [F12]
Cancel: Close this window iR} 1/0)
® A | Strtlog| StopLog ClrLog

Control Log Menu

[F7 SaveLog.] Saves the control log into the flash memory.
[F12 DelLog.]  Deletes the control log from the flash memory.

10.7.8 Fetching Control Log

Receive the control log from LogManager.
& Receive Table |

— Transfer Table

[ | <Error Log» < Receive
| 1 <Operation Log?
<Contral Lo 0>

Cancel

| | <Communication Log?
] <"ersions Select All

.................................

.................................

Fetching Control Log in WINCAPSII

To fetch the control log from the flash memory, you need to check the flash
memory beforehand.

NOTE: Checking the flash memory is possible only with control log. It has no
effect on sending/receiving other data.
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10.7.9 Saving Control Log to Floppy Disks

If you fetch log data with the FDD function, the control log will also be saved onto
the floppy disk. For details, refer to the SETTING-UP MANUAL.

To fetch the control log from the flash memory, press [F6 Set]—[F3 USB.]—[F12
AUX.]—[F11 CtrlLog.] and select "Enable" option, making the Saving of control
log possible.

M9 o § - Joint WOTO|[ 1

Control log save setting

@ Save control log from flash area

(" Disable

(@ Enable

Cancel | 0K |

[F11]

Disable : default Enahle: from flash area @ @

o o | ]

Enabling Control Log Saving

NOTE: When the controller starts, the parameter for saving the control log in the
flash area is set to Disable.
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The purpose of this manual is to provide accurate information in the handling and operating of the
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